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Chapter 1 System Overview

System Overview for the DXM150-B1

Banner's DXM Logic Controller integrates Banner's wireless radio, cellular connectivity, and local I/O to provide a platform for
the Industrial Internet of Things (lloT). Various combinations of /0 and connectivity are available based on the different mod-
els.

Inputs and Outputs Connectivity Logic Controller User Interface

Universal inputs Cellular Action rules LCD screen

Discrete outputs Sure Cross radios Programming language LED indicators

Courtesy power Ethernet Scheduler
RS-485 client and server Push to the cloud

RS-232 or CAN

Isolated inputs

Relay outputs Data logging

Connectivity
The DXM's wired and wireless connectivity options make it

Inputs and Outputs
On-board universal and programmable 1/O ports connect to lo-

cal sensors, indicators, and control equipment.

Universal inputs, discrete outputs, courtesy power and
switched power outputs, isolated inputs, relay outputs

Battery backup, solar controller

easy to share data between local and remote equipment. The
cellular modem option eliminates the need for IT infrastruc-
tures to connect remote equipment for sensing and control.
The integrated Sure Cross® wireless radio enables Modbus
connectivity to remote sensors, indicators, and control equip-

ment.

Wired Connectivity -- Ethernet: Modbus/TCP or Ethernet/
IP and Field Bus: Modbus RS-485 Client/Server

Wireless Connectivity -- Sure Cross® Wireless Radio: DX80
900 MHz, DX80 2.4 GHz, MultiHop 900 MHz, or MultiHop 2.4
GHz and Cellular modem: LTE-M (United States) or LTE-M/
NB-IoT (outside the United States)

Controller Area Network (CAN)

Logic Controlle—Program the DXM's logic controller using action rules and/or the ScriptBasic language, which can execute
concurrently. The control functions allow freedom when creating custom sensing and control sequences. The logic controller
supports the Modbus protocol standards for data management, ensuring seamless integration with existing automation sys-
tems. File and LCD password protection is an option.
Register Mapping

Cyclical Read rules from wireless devices or local wired Mod-

bus devices that include optional scaling, error conditions, and
the ability to activate a read rule

Cyclical or Change of State Write rules to wireless devices or
local wired Modbus devices with scaling

Modbus/TCP Client Read or Write rules for external devices
on the network

Action Rules
Thresholds (IF/THEN/ELSE) with timers, minimum on/off time,
and logging options

Math/Logic Rules (arithmetic and bitwise operators)
Control Logic (logical operators and SR/T/D/JK flip flops)
Trending (multiple averaging filters)

Tracking (counts, on/off times)

Push data on conditions
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Scheduler Optional Text Programming

Time/calendar-based events ScriptBasic to create variables, arrays, functions, loops, IF/
THEN/ELSE, logical and arithmetic operators, APl commands,
i ) register access, string functions and operators, and time com-
Dynamic scheduler updating mands

Holiday skips; one-time events

Astronomical clock Data Logging
Cyclic data/event logging

User Interface—A simple user interface consists of an LCD screen and four LED indicators. Use the LCD to access system
status and setup, view user-selectable events or data, and to bind and perform site surveys for Sure Cross radios. Configure
the user-programmable LEDs to indicate the status of the DXM, processes, or equipment.

User-Programmable LCD Viewing the system's status
Binding Sure Cross Radios User-Defined LED Indicators
Conducting a Site Survey Four multicolored LEDs: green, amber, and red
Viewing sensor information Programmable behavior

System Overview for the DXM150-B2

Banner's DXM Logic Controller integrates Banner's wireless radio, cellular connectivity, and local I/O to provide a platform for
the Industrial Internet of Things (lloT).

Inputs and Outputs Connectivity Logic Controller User Interface
Universal inputs Cellular Action rules LCD screen
PNP/NPN outputs Sure Cross radios Programming language LED indicators
Analog outputs Ethernet Scheduler
Isolated power RS-485 client and server Push to the cloud
Courtesy power outputs RS-232 or CAN Data logging
Inputs and Outputs Connectivity
On-board universal and programmable /O ports connect to lo- The DXM's wired and wireless connectivity options make it
cal sensors, indicators, and control equipment. easy to share data _betwe_er_1 local and remote eqqipment. The
Universal inputs, analog outputs, PNP/NPN outputs, isolated cellular modem option eliminates the need for IT infrastruc-
inputs tures_ to connect remote eqmpment for sensing and control.
The integrated Sure Cross® wireless radio enables Modbus
Courtesy power output, battery backup, solar controller connectivity to remote sensors, indicators, and control equip-

ment.

Wired Connectivity -- Ethernet: Modbus/TCP or Ethernet/IP
and Field Bus: Modbus RS-485 Client/Server

Wireless Connectivity -- Sure Cross® Wireless Radio: DX80
900 MHz, DX80 2.4 GHz, MultiHop 900 MHz, or MultiHop 2.4
GHz and Cellular modem: LTE-M (United States) or LTE-M/
NB-loT (outside the United States)

Logic Controller—Program the DXM's logic controller using action rules and/or ScriptBasic language, which can execute con-
currently. The control functions allow freedom when creating custom sensing and control sequences. The logic controller sup-
ports the Modbus protocol standards for data management, ensuring seamless integration with existing automation systems.

File and LCD password protection is an option.

Register Mapping Action Rules
Cyclical Read rules from wireless devices or local wired Mod- Thresholds (IF/THEN/ELSE) with timers, minimum on/off time,
bus devices that include optional scaling, error conditions, and and logging options

the ability to activate a read rule

Cyclical or Change of State Write rules to wireless devices or : : :
local wired Modbus devices with scaling Control Logic (logical operators and SR/T/D/JK flip flops)

Modbus/TCP Client Read or Write rules for external devices Trending (multiple averaging filters)
on the network Tracking (counts, on/off times)

Push data on conditions

Math/Logic Rules (arithmetic and bitwise operators)

© Banner Engineering Corp. June 05, 2023
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Scheduler Optional Text Programming Language

Time/calendar-based events ScriptBasic to create variables, arrays, functions, loops, IF/
THEN/ELSE, logical and arithmetic operators, APl commands,
i ) register access, string functions and operators, and time com-
Dynamic scheduler updating mands

Holiday skips; one-time events

Astronomical clock Data Logging
Cyclic data/event logging

User Interface—A simple user interface consists of an LCD screen and four LED indicators. Use the LCD to access system
status and setup, view user-selectable events or data, and to bind and perform site surveys for Sure Cross radios. Configure
the user-programmable LEDs to indicate the status of the DXM, processes, or equipment.

User-Programmable LCD Viewing the system's status
Binding Sure Cross radios User-Defined LED indicators
Conducting a Site Survey Four multicolored LEDs: green, amber, and red
Viewing sensor information Programmable behavior

System Overview for the DXM1500-B1

Banner's DXM Logic Controller integrates Banner's wireless radio, cellular connectivity, and local I/O to provide a platform for
the Industrial Internet of Things (lloT).

Inputs and Outputs Connectivity Logic Controller User Interface
Universal inputs Cellular Action rules LCD screen
Discrete outputs Sure Cross radios Programming language LED indicators
Courtesy power output Ethernet Scheduler
Isolated inputs USB Push to the cloud
Relay outputs RS-485 client/server Data logging
RS-232

Modbus registers for internal local registers (Modbus ID 199)

Local Registers Type Description
1-845 32-bit integer Local data registers
846-849 32-bit integer Reset, Constant, Timer
851-900 32-bit non-volatile integer Data flash, non-volatile
901-1000 Reserved for internal use
1001-5000 Floating point Floating point registers, local data registers
5001-7000 32-bit integer Local data registers
7001-8000 32-bit non-volatile integer Data flash, non-volatile
> 10000 Read-only virtual registers, system-level data
Inputs and Outputs Connectivity
On-board universal and programmable /O ports connect to lo- The DXM's wired and wireless connectivity options make it
cal sensors, indicators, and control equipment. easy to share data between local and remote equipment. The

Universal inputs, discrete outputs, courtesy power outputs cellular modem option eliminates the need for IT infrastruc-
’ ’ tures to connect remote equipment for sensing and control.

Battery backup, solar controller The integrated Sure Cross® wireless radio enables Modbus
connectivity to remote sensors, indicators, and control equip-
ment.

Wired Connectivity -- Ethernet: Modbus TCP, Ethernet/IP, or
Profinet; Field Bus: Modbus RS-485 Client/Server

June 05, 2023 © Banner Engineering Corp.
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GHz; Cellular modem: LTE-M (United States) or LTE-M/NB-

Wireless Connectivity -- Sure Cross Wireless Radio: DX80
loT (outside the United States)

900 MHz, DX80 2.4 GHz, MultiHop 900 MHz, or MultiHop 2.4

Logic Controlle—Program the DXM's logic controller using action rules and/or ScriptBasic language, which can execute con-
currently. The control functions allow freedom when creating custom sensing and control sequences. The logic controller sup-
ports the Modbus protocol standards for data management, ensuring seamless integration with existing automation systems.

File and LCD password protection is an option.

Register Mapping Scheduler

Cyclical Read rules from wireless devices or local wired Mod- Time/calendar-based events
bus devices that include optional scaling, error conditions, and Holiday skips

the ability to activate a read rule

Cyclical or Change of State Write rules to wireless devices or
local wired Modbus devices with scaling

Modbus/TCP Client Read or Write rules for external devices

One-time events
Dynamic scheduler updating
Astronomical clock

on the network

Action Rules
Thresholds (IF/THEN/ELSE) with timers, minimum on/off time,
and logging options

Math/Logic Rules (arithmetic and bitwise operators)
Control Logic (logical operators and SR/T/D/JK flip flops)
Trending (multiple averaging filters)

Tracking (counts, on/off times)

Push data on conditions

Optional Text Programming Language
ScriptBasic to create variables, arrays, functions, loops, IF/
THEN/ELSE, logical and arithmetic operators, APl commands,
register access, string functions and operators, time com-
mands

Data Logging
Cyclic data/event logging

User Interface—A simple user interface consists of an LCD screen and four LED indicators. Use the LCD to access system
status and setup, view user-selectable events or data, and to bind and perform site surveys for Sure Cross radios. Configure
the user-programmable LEDs to indicate the status of the DXM, processes, or equipment.

Viewing the system's status
User-Defined LED Indicators

Four multicolor LEDs: green, amber, and red

Programmable behavior

User-Programmable LCD
Binding Sure Cross radios
Conducting a Site Survey
Viewing sensor information

System Overview for the DXM1500-B2

Banner's DXM Logic Controller integrates Banner's wireless radio, cellular connectivity, and local I/O to provide a platform for
the Industrial Internet of Things (lloT).

Inputs and Outputs Connectivity Logic Controller User Interface

Universal inputs Cellular Action rules LCD screen

Sure Cross radios LED indicators

PNP/NPN outputs Programming language

Analog outputs Ethernet Scheduler
Isolated inputs USB Push to the cloud
Courtesy power output RS-485 client/server Data logging
Modbus registers for internal local registers (Modbus ID 199)
Local Registers Type Description
1-845 32-bit integer Local data registers
846-849 32-bit integer Reset, Constant, Timer
851-900 32-bit non-volatile integer Data flash, non-volatile
901-1000 Reserved for internal use
1001-5000 Floating point Floating point registers, local data registers
5001-7000 32-bit integer Local data registers

Continued on page 9
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Continued from page 8

Local Registers Type Description
7001-8000 32-bit non-volatile integer Data flash, non-volatile
> 10000 Read-only virtual registers, system-level data
Inputs and Outputs Connectivity
On-board universal and programmable /O ports connect to lo- The DXM's wired and wireless connectivity options make it
cal sensors, indicators, and control equipment. easy to share data between local and remote equipment. The

cellular modem option eliminates the need for IT infrastruc-
tures to connect remote equipment for sensing and control.
Battery backup, solar controller The integrated Sure Cross® wireless radio enables Modbus
connectivity to remote sensors, indicators, and control equip-
ment.

Wired Connectivity--Ethernet: Modbus TCP, Ethernet/IP, or
Profinet and Field Bus: Modbus RS-485 Client/Server

Wireless Connectivity--Sure Cross Wireless Radio: DX80 900
MHz, DX80 2.4 GHz, MultiHop 900 MHz, or MultiHop 2.4 GHz
and Cellular modem: LTE-M (United States) or LTE-M/NB-loT
(outside the United States)

Universal inputs, discrete outputs, courtesy power output

Logic Controlle—Program the DXM's logic controller using action rules and/or ScriptBasic language, which can execute con-
currently. The control functions allow freedom when creating custom sensing and control sequences. The logic controller sup-
ports the Modbus protocol standards for data management, ensuring seamless integration with existing automation systems.

File and LCD password protection is an option.

Register Mapping Scheduler
CyclicaI.Read rulgas from wirgless dev.ices or local wirgd Mod- Time/calendar-based events
bus dgylces thag include optional scaling, error conditions, and Holiday skips
the ability to activate a read rule
One-time events

Cyclical or Change of State Write rules to wireless devices or } .
local wired Modbus devices with scaling Dynamic scheduler updating

Modbus/TCP Client Read or Write rules for external devices Astronomical clock

on the network Optional Text Programming Language

Action Rules ScriptBasic to create variables, arrays, functions, loops, IF/
Thresholds (IF/THEN/ELSE) with timers, minimum on/off time, THEN/ELSE, logical and arithmetic operators, APl commands,
and logging options register access, string functions and operators, time com-
Math/Logic Rules (arithmetic and bitwise operators) mands
Control Logic (logical operators and SR/T/D/JK flip flops) Data Logging

Trending (multiple averaging filters) Cyclic data/event logging

Tracking (counts, on/off times)
Push data on conditions

User Interface—A simple user interface consists of an LCD screen and four LED indicators. Use the LCD to access system
status and setup, view user-selectable events or data, and bind and perform site surveys for Sure Cross radios. Configure
the user-programmable LEDs to indicate the status of the DXM, processes, or equipment.

User-Programmable LCD Viewing the system's status
Binding Sure Cross radios User-Defined LED Indicators
Conducting a Site Survey Four multicolored LEDs: green, amber, and red
Viewing sensor information Programmable behavior
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Hardware Overview

The DXM can have several different configurations. The DXM has a model number label on the housing. Use the model num-
ber and model table to identify which boards are included in the your controller.

Base Radio Configuration
DXM150-| B1 R1
| | . .
B1 =Modbus controller designed for applications with Blank = None
high 1/0 count, isolated inputs or integrated relays R1 =900 MHz, 1 W PE5 Performance Radio (North America)
Power: 12-30 V DC/solar/battery R2 =900 MHz, 1W HE5 MultiHop Data Radio (North America)
Comms: RS-485, RS-232 or CAN, secondary RS-485 R3 = 2.4 GHz, 65 mW PE5 Performance Radio (Worldwide)
Inputs: Two isolated discrete, eight universal R4 = 2.4 GHz, 65 mW HE5 MultiHop Data Radio (Worldwide)
Outputs: Two relay, four NMOS, two analog R5 =900 MHz, 65 mW HES5L MultiHop Data Radio (Used for M-GAGE networks)
Power Out: Two jumper selectable between 2.7 V or battery, R8 = 900 MHz, Performance Radios approved for Australia/New Zealand
4.2 V or incoming power R9 =900 MHz, MultiHop Radio approved for Australia/New Zealand
Base Radio Configuration
DXM150-| B2 R1
T 1 T 1
B2 =Modbus controller for high I/O count applications Blank = None

Power: 12-30 V DC/solar/battery R1 =900 MHz, 1 W PE5 Performance Radio (North America)

Comms: RS-485, CAN or RS-232 w/flow control, secondary RS-485 R2 =900 MHz, 1W HE5 MultiHop Data Radio (North America)

Inputs: Two isolated discrete, eight universal R3 = 2.4 GHz, 65 mW PE5 Performance Radio (Worldwide)

Outputs: Eight PNP/NPN selectable, two analog R4 = 2.4 GHz, 65 mW HES5 MultiHop Data Radio (Worldwide)

Power Out: Two courtesy power out; two jumper selectable R5 =900 MHz, 65 mW HE5L MultiHop Data Radio (Used for M-GAGE networks)

between 2.7 V or battery, 4.2 V or incoming power R8 =900 MHz, Performance Radios approved for Australia/New Zealand

R9 =900 MHz, MultiHop Radio approved for Australia/New Zealand

Radio
Base Configuration
DXM1500- | B1 R1
r 1 r 1
B1 =Modbus controller for data aggregation of sensors Blank = None

and wireless networks R1 =900 MHz, 1 W PE5 Performance Radio (North America)
Power: 12-30 V DC / Solar / Battery R2 =900 MHz, 1 W HE5 MultiHop Data Radio (North America)
Comms: RS-485 Client/Server R3 = 2.4 GHz, 65 mW PES5 Performance Radio (Worldwide)
Inputs: Eight universal, two isolated discrete R4 = 2.4 GHz, 65 mW HES5 MultiHop Data Radio (Worldwide)
Outputs: Four NMOS, two analog (0-10 V or 4-20 mA), two relay R5 =900 MHz, 65 mW HES5L MultiHop Data Radio (Used for M-GAGE networks)
One 5 V courtesy power R8 =900 MHz, Performance Radios approved for Australia/New Zealand

R9 = 900 MHz, MultiHop Radio approved for Australia/New Zealand
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Base Radio Configuration

DXM1500- [R1]

T B T
B2 =Modbus controller for high 1/0O count applications Blank = None

Power: 12-30 V DC / Solar / Battery R1 =900 MHz, 1 W PE5 Performance Radio (North America)

Comms: RS-485 and RS-232 w/flow control or secondary RS-485 R2 =900 MHz, 1 W HE5 MultiHop Data Radio (North America)

Inputs: Eight universal, two isolated discrete R3 = 2.4 GHz, 65 mW PE5 Performance Radio (Worldwide)

Outputs: Eight PNP/NPN selectable, two analog R4 = 2.4 GHz, 65 mW HE5 MultiHop Data Radio (Worldwide)

Power Out: Two courtesy power out, two jumper selectable R5 =900 MHz, 65 mW HES5L MultiHop Data Radio (Used for M-GAGE networks)
between 2.7 V or battery, 4.2 V or incoming power R8 =900 MHz, Performance Radios approved for Australia/New Zealand

R9 =900 MHz, MultiHop Radio approved for Australia/New Zealand

Not all combinations of base boards and radios are supported.

IMPORTANT:
« Electrostatic discharge (ESD) sensitive device
» ESD can damage the device. Damage from inappropriate handling is not covered by warranty.
» Use proper handling procedures to prevent ESD damage. Proper handling procedures include
leaving devices in their anti-static packaging until ready for use; wearing anti-static wrist straps;
and assembling units on a grounded, static-dissipative surface.

Exploded view of the DXM hardware

Cellular Radio Board

Processor Board

MultiHop or Gateway
Radio Board

DXM150 I/0
Base Board

1/0 Base Board—The DXM 1/O base board provides connections for all inputs, outputs and power. The 1/0O base board con-
tains a 12 V solar controller that accepts connections to a solar panel and sealed lead acid (SLA) battery. The battery con-
nection can also be used with line power to provide a battery backup in case of line power outages.
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ISM Radio—The ISM radio, either a MultiHop or DX80 Gateway, fits on the I/O base board in the parallel sockets. Install the
ISM radio so the U.FL antenna connection is to the side with the SMA antenna connectors. Connect the U.FL cable from the
ISM radio U.FL to the right side U.FL connector. The ISM radio boards are available with either a 900 MHz radio (North Amer-
ica) or a 2.4 GHz radio (world-wide).

Processor—The processor board plugs into the base board using the two 20 pin socket connectors. The board sits above the
ISM radio socket and held by the base board standoffs. Position the processor board so the USB and RJ45 Ethernet connec-
tion is to the front, away from the SMA antenna connections.

Cellular Modem (Optional)—The optional cellular modem (purchased separately) board plugs into the processor board with
the U.FL antenna connection to the left. Attach the antenna cable from the cellular modem to the left U.FL connection on the
base board.

In some DXM models, the cellular modem may be replaced with an ISM radio. In this configuration, position the top ISM radio
antenna connection to the left of the SMA antenna connector.

LCD (Display) Board—The top housing contains the LCD board. The display board is connected to the base board using a
ribbon cable with a 20 pin connector.

DXM Configuration Software

Download the latest version of all configuration software from http://www.bannerengineering.com. For more information on
using the DXM Configuration Software, refer to the instruction manual (p/n 209933).

Overview of the configuration software features

DXM Configuration Software

Local Registers

Register Mapping

Action Rules

Scheduler

ScriptBasic

System Register
Settings View Utility

USB
D m—

XML Config File

Ethernet

The configuration software configures the DXM by creating an XML file that is transferred to the DXM using a USB or Ether-
net connection. The DXM can also receive the XML configuration file from a Web server using a cellular or Ethernet connec-
tion.

This configuration file governs all aspects of the DXM operation.

The wireless network devices are a separate configurable system. Use the DX80 User Configuration Software to configure
the internal DX80 wireless Gateway and the attached wireless Nodes. Use the MultiHop Configuration Software if the internal
radio is a MultiHop device.

All tools can be connected to the DXM using a USB cable or an Ethernet connection.

DXM Automation Protocols

The DXM supports the following automation protocols.
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Modbus RTU Modbus TCP/IP
The DXM manages two separate physical ports running the A host system acting as a Modbus client can access the DXM
Modbus RTU protocol. The DXM is the Modbus client when using the Modbus TCP/IP protocol over Ethernet. Standard
operating the Modbus client RTU port. The DXM uses the Modbus port 502 is used by the DXM for all Modbus TCP/IP
client Modbus RTU bus to communicate with locally connect- requests.

ed Modbus devices or uses the Banner wireless radio to com-
municate with remote Modbus devices.

The other Modbus RTU port is used by a host system to ac- . . ) .
cess the DXM as a server device. The server Modbus RTU By default, Modbus TCP/IP is active. Configure the DXM us

. : - ing Modbus TCP rules in the configuration software.
port allows access all the internal registers concurrently with
the client RTU port. Set the Modbus ID using the LCD EtherNet/IP™
menu: SYSTEM CONFIG > DXM Modbus ID. The Ethernet port is actively running EtherNet/IP. From the
By default, the Modbus RTU ports are active. Configure the factory, the DXM is configured to read and write registers on

port parameters using the configuration software. DX80 wireless devices 1 through 16. Custom configurations
can be set using the configuration software.

By default, EtherNet/IP is active.

All internal registers are available to the host system concur-
rently with Modbus RTU.

DXM Modbus Overview

The DXM uses internal 32-bit registers to store information. The processor's internal Local Registers serve as the main global
pool of registers and are used as the common data exchange mechanism. External Modbus device registers can be read into
the Local Registers or written from the local data registers.

The DXM, as a Modbus client or server, exchanges data using the Local Registers. Modbus over Ethernet (Modbus/TCP) us-
es the Local Registers as the accessible register data.

Using Action, Read/Write, and Threshold Rules allows you to manipulate the processor's Local Registers. The ScriptBasic
programming capabilities extends the use of Local Registers with variables to create a flexible programming solution for more
complex applications.

The processor's Local Registers are divided into three different types: integer, floating point, and non-volatile. When using Lo-
cal Registers internally, the user can store 32-bit numbers. Using Local Registers with external Modbus devices follows the
Modbus standard of a 16-bit holding register. Local Registers are accessible as Modbus ID 199.

Accessing the I/O base board and the LCD follows the same communication as an external Modbus device. Each device has
an ID number to uniquely identify itself. The 1/0 base board is Modbus ID 200 and the LCD is Modbus ID 201.

Overview of the DXM Modbus processor

DXM Processor

Local Registers
(Modbus ID 199)

Local Registers Gateway or MultiHop
0

Local Registers
Float

Local Registers I/O Base Board )
Non-Volatile (ID 200)

LCD
Modbus Data (ID 201)
Traffic Control

Action Rules
Read/Write Rules
<+— ScriptBasic
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Device Setup

Apply Power to the Controller

Follow these instructions to apply 12—-30 V DC power to the controller using a wall plug.

Equipment used:
* DXM Wireless Controller
« MQDMC-401 0.3 m (1 ft) cordset with a 4-pin M12/Euro-style quick disconnect fitting
* PSW-24-1 Wall plug power supply; 24 V DC, 1 A

IMPORTANT:
* Never operate a 1 Watt radio without connecting an antenna
» Operating 1 Watt radios without an antenna connected will damage the radio circuitry.
» To avoid damaging the radio circuitry, never apply power to a Sure Cross® Performance or Sure
Cross MultiHop (1 Watt) radio without an antenna connected.

1. Connect the brown wire from the MQDMC-401 cordset to the DXM's PW (+ power) terminal.
2. Connect the blue wire from the MQDMC-401 cordset to the DXM's GD (- ground) terminal.
3. Connect the PSW-24-1 power supply to the MQDMC-401 cordset.

4. Plug in the PSW-24-1 wall plug power supply.

Binding and Conducting a Site Survey with the ISM Radio
Before the ISM radio can communicate, the ISM radio within the DXM must be bound to the other radios in the wireless net-
work.

Use the DXM LCD menu to bind external radios to the internal ISM radio.

If you are having difficulty running binding or site surveys, it may be because of the speed of the XML configuration file or
script running on the DXM. To resolve this issue, try one of the following options:

» Disable the XML and script by setting DIP switch 4 on the processor board to ON and cycling the power to the DXM.
After binding the devices, turn DIP switch 4 back OFF and cycle power again to return to normal operation of the XML
and script.

» Adjust the XML or script to slow down the RTU read or write rules.

» Upload a blank XML, bind all devices, then upload the configured XML file.

Bind a DX80 Node to a DXM and Assign the Node Address

Binding Nodes to a Gateway ensures the Nodes only exchange data with the Gateway they are bound to. After a Gateway
enters binding mode, the Gateway automatically generates and transmits a unique extended addressing (XADR), or binding,
code to all Nodes within range that are also in binding mode. The extended addressing (binding) code defines the network,
and all radios within a network must use the same code.

1. Apply power to all the devices.
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Separate radios by two meters when running the binding procedure. Put only one DXM Gateway into binding mode at
a time to prevent binding to the wrong Gateway.

. Enter binding mode on the DXM radio:

a. Use the arrow keys to select the ISM Radio menu on the LCD and press ENTER.
b. Highlight the Binding menu and press ENTER.

. Assign the Node address to the Node.

o For Nodes without rotary dials: Use the DXM arrow keys to select the Node address to assign to the DX80
Node about to enter binding mode. The DXM assigns this Node address to the next Node that enters binding
mode. Only bind one Node at a time.

o For Nodes with rotary dials: Use the Node's rotary dials to assign a valid decimal Node Address (between 01
and 47). The left rotary dial represents the tens digit (0 through 4) and the right dial represents the ones digit
(0 through 9) of the Node Address. You can leave the DXM "Bind to" address set to 1 because the Node's ro-
tary dials will override that setting.

. Start binding mode on the DXM radio by pressing ENTER on the DXM radio.
. Enter binding mode on the DX80 Node.

o For housed radios, triple-click button 2.
o For board-level radios, triple-click the button.
o For Nodes without buttons, refer to the Node's datasheet for instructions on entering binding mode.

The left and right LEDs flash alternately and the Node searches for a Gateway in binding mode. After the Node
binds, the LEDs stay solid momentarily, then they flash together four times. The Node automatically exits binding
mode and reboots.

. Label the Node with the assigned address number for future reference.

. Press BACK on the DXM to exit binding mode for that specific Node address.
The Node LEDs continue to flash red until the DXM exits binding mode with that Node address.

Repeat these steps for as many DX80 Nodes as are needed for your network.
. When you are finished binding, press BACK on the DXM until you return to the main menu.

a MultiHop Radio to a DXM and Assign the Device ID

Before beginning the binding procedure, apply power to all the devices. Separate radios by two (2) meters when running the
binding procedure. Put only one DXM MultiHop client radio into binding mode at a time to prevent binding the server or re-
peater radios to the wrong client radio.

Binding MultiHop radios ensures all MultiHop radios within a network communicate only with other radios within the same
network. The MultiHop client radio automatically generates a unique binding code when it enters binding mode. This code is
transmitted to all radios within range that are also in binding mode. After a repeater/server radio is bound, the repeater/server
radio accepts data only from the client radio to which it is bound. The binding code defines the network, and all radios within
a network must use the same binding code.

1.

2

Enter binding mode on the DXM radio:
a. Use the arrow keys select the ISM Radio menu on the LCD and press ENTER.

b. Highlight the Binding menu and press ENTER.

. Assign the device address to the repeater or server radios. Valid device IDs are 11 through 60.

o For MultiHop radios without rotary dials: Use the DXM arrow keys to select the device ID to assign to the Mul-
tiHop radio about to enter binding mode. The DXM assigns this device ID to the next radio that enters binding
mode. Only bind one server radio at a time.

o For MultiHop radios with rotary dials: Use the MultiHop radio's rotary dials to assign a device ID . The left ro-
tary dial represents the tens digit (1 through 6) and the right dial represents the ones digit (0 through 9) of the
device ID. You can leave the DXM "Bind to" address set to 1 because the MultiHop's rotary dials will override
that setting.

3. Start binding mode on the DXM radio by pressing ENTER on the DXM radio.
4. After entering binding mode on the DXM, put the MultiHop repeater or server radio into binding mode.

o For housed radios, triple-click button 2.
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o For board-level radios, triple-click the button.
o For radios without buttons, refer to the radio's datasheet for instructions on entering binding mode.
After binding is completed, the MultiHop radio automatically exits binding mode and begins operation.

5. Press BACK on the DXM to exit binding mode for that specific device address.
The MultiHop radio's LEDs continue to flash red until the DXM exits binding mode with that MultiHop radio.

6. Label the MultiHop radio with the assigned address number for future reference.
Repeat these steps, changing the device address, for as many MultiHop radios as are needed for your network.

8. When you are finished binding, press BACK on the DXM until you return to the main menu.
All radio devices begin to form the network after the client data radio exits binding mode.

N

Conduct a Site Survey from the DXM

Conduct a Site Survey to verify the wireless communication between the radios within your wireless network. Conduct the
site survey when the Nodes and DXM Controller are at the proposed installation sites to determine each radio's signal
strength with the DXM.

For a DX80 network, the Gateway controls the site survey and the results display on the LCD. Running a site survey on a
DX80 network does not affect the throughput of the DX80 network. The DX80 Gateway-Node system can run a site survey
analysis while the network is operational. For a MulitHop network, the client device passes the site survey request to the in-
tended Modbus server device. The Site Survey runs and the results display on the LCD. Running a site survey on a MultiHop
network stops all network traffic to that device.

1. On the DXM: Use the arrow buttons to select the ISM Radio menu and press ENTER.

2. Select the Site Survey menu and press ENTER.

3. Use the Up or Down arrows to select the device ID number and press ENTER to run the site survey with that radio.
The site survey results display as green, yellow, red, and missed packets. Green indicates the highest signal strength,
then yellow, and red. Missed packets were not received.

4. When you are finished running the Site Survey, press Back twice to return to the main menu and exit site survey
mode.

If the Site Survey fails (100 missed packets), verify the radios are at least 10 feet from the DXM and/or rerun the binding pro-
cedure. If you find poor signal quality, common solutions include moving the DXM to a more central location relative to the
Nodes or using higher-gain antennas on the DXM. Contact your local Banner Engineering representative for assistance.

Set a Static IP Address
Change the IP address of the DXM to connect to a local area network, Modbus TCP/IP host controller, or EtherNet/IP host
controller.

There are two ways to set the IP address: using the DXM's LCD menu or using the configuration software to change the XML
file. IP addresses entered into the LCD menu system override the IP addresses in the XML configuration files. To use the IP
addresses set in the XML configuration file, clear the IP addresses from the menu system.

System Config menu options

System Config—> Ethernet ——> DHCP ——>~ Update DHCP Mode
IP: —> Update IP Address G 0 to change the value

SN: —> Update SN @ to accept
After making changes to the GW: > Update GW Address
Ethernet settings, restart the DXM. Reset —> Resets Ethernet parameters @ to return to the previous menu

to xml defaults.

. On the DXM, use the arrows and move to the System Config menu. Press ENTER.

. Use the arrow keys to select the Ethernet menu. Press ENTER.

. Highlight the DHCP selection and press ENTER. Set DHCP to OFF.

. The system will request a restart, press ENTER to confirm.

. Follow steps 1 and 2 to reenter the Ethernet menu. Use the arrow keys to select IP. Press ENTER.
The IP address displays (for example, 192.168.0.1).

a b~ ON -

6. Use the up and down arrows to change the IP address. Press ENTER to move to the next octet.
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7. Press ENTER on the final octet to accept the changes.

8. Cycle power to the DXM.
The changes are saved on the DXM and the new IP address will be used.

Use this same procedure to set the subnet mask (SN) and default gateway (GW) to match your network requirements. Your
IT department can provide these settings if needed.

Configuration Instructions

Configuring the Controller

Configure the DXM using the configuration software. The DXM Configuration Software allows the user to define parameters
for the DXM, then saves the configuration in an XML file on the PC. To configure the DXM, connect the DXM's USB or Ether-
net port to a computer.

After the configuration file is saved, upload the XML configuration file to the DXM for operation.

This quick start guide outlines the basic operations to set up a DXM using the configuration software. For a more comprehen-
sive explanation of features, refer to the DXM Configuration Software Instruction Manual (p/n 209933).

DXM Configuration Software

DXM Configuration Software

Local Registers

System Register
SEe View Utility

USB
[y

XML Config File

Ethernet

Introduction to Traditional Setup Mode

This section will walk you through the traditional method of setting up the DXM Configuration Software and communicating
with a connected DXM device. Version 4 of the configuration software supports multiple DXM device models, each of which
incorporates different features.

As of DXM Configuration Software v4.10.28, the Simple Setup procedure is only available with
the DXM100, DXM700, DXM1000, DXM1200, and DXM1500 models.

As soon as a DXM model is connected to your computer, the software automatically detects the correct model and loads the
appropriate screens. You may also manually select which model of DXM you are configuring if you intend to create a configu-
ration file without connecting a device. This ensures that the interface and the configuration file use the correct features.

Not all screens are available for all models. To change to another model of DXM, go to the Connect to DXM screen and use
the drop-down list to select another model. If the active configuration is incompatible with the selected model, you will be
prompted to either proceed and wipe out the active configuration or cancel the model change and preserve the configuration.
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Traditional Setup opening screen

Connect fo DXM
Mode: :Tragtional Setup =

Local Registers

Register Mapping Connectto DXM using: (= Seral () TCPAP

Comm Port |COM3 | & Connect

Settings

Tools

Select DXM Model: |DXMT00 I=J

Connect via USB or Ethernet. If connecting via Ethernet, set network parameters through the DXM LCD menu in the System
Cfg » Ethernet menu. Network parameters can also be set within the configuration software. Setting parameters on the LCD

menu overrides the parameters stored in the configuration file. To use the network parameters in the configuration file, reset
the network parameters on the DXM LCD menu.

Since the DXM-R90x connects only via TCP, its Connect to DXM screen differs from the other DXM models. When the Select
DXM Model drop-down is set to DXM-R90x, a new network discovery table is displayed. Click Scan Network for DXMs to de-
tect DXM devices on the host computer's network. Discovered DXMs are listed in the network discovery table. Double-click
any row entry to connect to that DXM. If the DXM's IP address is already known, the standard TCP connection option is avail-
able below the network discovery table.

Banner recommends disconnecting the COMM port through the Device menu before turning off power or disconnecting the
USB cable. Use Device > Reboot to restart the DXM if needed; the tool automatically disconnects the COMM port, then re-
connect it again.

TIP: If connection attempts are failing (Application Status Icon in the footer of the tool is Red), close the
configuration software and disconnect the USB cable from the computer. Reconnect the cable, launch the
software, and attempt connecting again.

If you cannot connect to your DXM Controller, refer to "Troubleshooting" on page 91 for more information.

IMPORTANT: Any model of DXM may connect to the configuration software regardless of which device
model is selected in the tool. Compatibility is checked before configuration files are uploaded to the de-
vice.

Configuration Example: Reading Registers on a Modbus Server Device
The local registers are the main global pool of registers that are defined by the user to store data within the DXM. The local
registers are listed on the Local Registers » Local Registers in Use screen.

The bottom status bar displays the communications status, application status, and the DXM Configuration Software version.

In this short example, we will configure the DXM to read six registers on an external Modbus server device and save the data
into the local registers.

The software only loads a file to the DXM. Internal parameter settings that are changed in the tool but not saved to the file will
not be sent to the device.

Modify Multiple Registers
Modify a range of registers from the Local Registers » Local Registers in Use » Modify Multiple Registers screen.

Select which parameter fields to modify. Most parameters have three selections.
< Unchanged—no changes
« Default—change to default settings
« Set—modify the parameter. Other selections will appear based on the parameter.
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A ODN -

5.

Modify Multiple Registers screen

Edit Register ~ Modify Multiple Registers

Starting Register 1= Ending Regiter 1= | Moddy Registers | | ResetFom |
Modify Properties

Mame Unchanged | = Counter  |Unchanged | = LCD permissicns |Unchanged | =

Register group |Unchanged | = Scaling  |Unchanged | = | S0 card logging |Unchanged | = |

Units Unchanged | = Sign type |Unchanged | = Cloud settings Set |z (Fea

Protocol conversion  |Unchanged | =

. Enter the Starting register and Ending register.

. Select the value to change using the drop-down list next to each value.
. Enter the new value in the field provided.

. To push register values to the web server, set Cloud Settings to Read.

If the Cloud Settings are set to Read, the web server only views data from the device and cannot write data to the de-
vice. If the permissions are set to Write, the web server only writes to the device and cannot read the data. If the per-
missions are set to Read/Write, the web server can read the data from the device and write to the device from the
web.

Click Modify Registers to save and apply the changes.

Define an RTU Read Rule
Follow these steps to create a new read rule.

This example screen shows a read rule created to read six registers (address 1 through 6), from Modbus ID 4. The results
are stored in the Local Registers 1 through 6.

~NoO OO~ ON =

Read Rules - Configuration Example

RTU Read
| AddRead Ruie| | Clone Selected Rule| | Delete Selected Rule | !‘1‘; ||
@ [Hone FromsiavelD  4[5] read  6[F] registers starting at 1] though 6 to local registers starting at | 1= through &
Remote type Holding register | =
VibrationReg1
Frequency 00:00:05.000 @ hh:mm:ss VibrationReg2
VibrationReg3
Scale value |0.000000%]  Scale offset o VibrationReg4
Scaling — VibrationRegs
[] Apply offset before scale value VibrationRegh
Error condition Apply value | 12345 [Z] after 3[2] read failures
Floating point [ swap words
On register 0=

. From the Register Mapping » RTU » RTU Read screen, click Add Read Rule.

. Click the arrow next to the name to display the parameters.

. Name your rule.

. Select the device ID.

. Select how many registers to read, and the beginning register.

. Define the register type, how often to read the register, and any other appropriate parameters.

. If necessary, select the error condition. For this example, if the read function fails after three attempts, the read rule

writes 12345 to the DXM local registers. Notice the list of local register names this read rule is using.
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Set the Time
Use the Settings » System screen to define the time zone and daylight saving option. The time zone and DST options are
saved into the configuration file.

Settings > System > Device Time

Current device time ===

| Synch PC time with device

Get time from device

Device timezone (UTC) {UTE (UTCs0000) J-:J

Device observes DST [

1. Go to the Settings » System screen.

2. If you connect the DXM to a computer, click Sync PC Time with Device to set the time on the DXM to match the time
of the computer.

3. Set your time zone and select whether or not your device observes daylight saving time (DST).

Save and Upload the Configuration File
After making any changes to the configuration, you must save the configuration files to your computer, then upload it to the
device.

Changes to the XML file are not automatically saved. Save your configuration file before exiting the tool and before sending
the XML file to the device to avoid losing data. If you select DXM » Send XML Configuration to DXM before saving the con-
figuration file, the software will prompt you to choose between saving the file or continuing without saving the file.

1. Save the XML configuration file to your hard drive by going to the File » Save As menu.
2. Go to the DXM » Send XML Configuration to DXM menu.

Status indicator bar

(Connected 192.168.0.1 VibelQ_DXRS80_V2 xmi Application Status

Connected 192.168.0.1 VibelQ_DXR90_V2 xmi Application Status @

Not Connected VibelQ_DXR90_V2.xml Application Status

o If the Application Status indicator is red, close and restart the DXM Configuration Tool, unplug and re-plug in
the cable and reconnect the DXM to the software.

o If the Application Status indicator is green, the file upload is complete.
o |If the Application Status indicator is gray and the green status bar is in motion, the file transfer is in progress.
After the file transfer is complete, the device reboots and begins running the new configuration.

Banner Engineering Corp Limited Warranty

Banner Engineering Corp. warrants its products to be free from defects in material and workmanship for one year following
the date of shipment. Banner Engineering Corp. will repair or replace, free of charge, any product of its manufacture which, at
the time it is returned to the factory, is found to have been defective during the warranty period. This warranty does not cover
damage or liability for misuse, abuse, or the improper application or installation of the Banner product.

THIS LIMITED WARRANTY IS EXCLUSIVE AND IN LIEU OF ALL OTHER WARRANTIES WHETHER EXPRESS OR IM-
PLIED (INCLUDING, WITHOUT LIMITATION, ANY WARRANTY OF MERCHANTABILITY OR FITNESS FOR A PARTICU-
LAR PURPOSE), AND WHETHER ARISING UNDER COURSE OF PERFORMANCE, COURSE OF DEALING OR TRADE
USAGE.

This Warranty is exclusive and limited to repair or, at the discretion of Banner Engineering Corp., replacement. IN NO
EVENT SHALL BANNER ENGINEERING CORP. BE LIABLE TO BUYER OR ANY OTHER PERSON OR ENTITY FOR ANY
EXTRA COSTS, EXPENSES, LOSSES, LOSS OF PROFITS, ORANY INCIDENTAL, CONSEQUENTIAL OR SPECIAL
DAMAGES RESULTING FROM ANY PRODUCT DEFECT OR FROM THE USE OR INABILITY TO USE THE PRODUCT,
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WHETHER ARISING IN CONTRACT OR WARRANTY, STATUTE, TORT, STRICT LIABILITY, NEGLIGENCE, OR OTHER-
WISE.

Banner Engineering Corp. reserves the right to change, modify or improve the design of the product without assuming any
obligations or liabilities relating to any product previously manufactured by Banner Engineering Corp. Any misuse, abuse, or
improper application or installation of this product or use of the product for personal protection applications when the product
is identified as not intended for such purposes will void the product warranty. Any modifications to this product without prior
express approval by Banner Engineering Corp will void the product warranties. All specifications published in this document
are subject to change; Banner reserves the right to modify product specifications or update documentation at any time. Spec-
ifications and product information in English supersede that which is provided in any other language. For the most recent ver-
sion of any documentation, refer to: www.bannerengineering.com.

For patent information, see www.bannerengineering.com/patents.

Document title: DXM Controller Quick Start Guide
Part number: 191247

Revision: F

© Banner Engineering Corp. All rights reserved.
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Chapter 3 ISM Radio Board (Slave ID 1)

Plug the ISM radio into the I/O base board with the U.FL antenna connector closest to the SMA connectors. Typically, users
will not need to adjust the DIP switch settings on the physical radio modules.

For the DXM1200 models, set the radio options using the LCD menu.

ISM radio board

B O

= Antenna

F B
RN |E
| |

- o P
C e e d h
—— LEED - i ] .
s oI~
DIP Switch DIP Switch Button
Bank 1 Bank 2
Button Operation LED Operation
For DXM models without a LCD display, use the button to bind The LED located on the ISM radio module indicates power
the ISM radio. For models with a LCD display, use the ISM and communications traffic. ISM board LED operations also
menu to bind the radio. display on the LED on the right side of the I/O base board.

+ Solid green DX80 ISM radio LED indicates power.

+ Flashing green MultiHop ISM radio LED indicates op-
eration.

* Red and green combined: Communications traffic
and binding.

MultiHop Radio DIP Switches

MultiHop ISM radio devices are defined with R2, R4, and R5 in the model number.
*  DXMxxx-xxR2 - MultiHop 900 MHz
* DXMxxx-xxR4 - MultiHop 2.4 GHz
*  DXMxxx-xxR5 - MultiHop 900 MHz, 100 mW
*  DXMxxx-xxR9 - MultiHop 900 MHz, (Australia)

Making changes to the baud or parity settings requires that you make the same settings to the Modbus Client Communica-
tions section within the DXM Configuration Software (Settings » General.
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Disabling the serial port disables the ISM radio in the DXM. Selecting Transparent mode causes radio communications to be

slower and denies access to device I/O register data.

DIP switch settings

Device Settings 1

Serial line baud rate 19200 OR User defined receiver
slots

OFF*
Serial line baud rate 38400 OR 32 receiver slots OFF
Serial line baud rate 9600 OR 128 receiver slots ON
Serial line baud rate Custom OR 4 receiver slots ON
Parity: None
Parity: Even
Parity: Odd

Disable serial (low power mode) and enable the receiver
slots select for switches 1-2

Transmit power
900 MHz radios: 1.00 Watt (30 dBm)
2.4 GHz radios: 0.065 Watts (18 dBm) and 60 ms
frame

Transmit power
900 MHz radios: 0.25 Watts (24 dBm)
2.4 GHz radios: 0.065 Watts (18 dBm) and 40 ms
frame

Application mode: Modbus

Application mode: Transparent

D1 Switches
2 3

OFF*

ON

OFF

ON
OFF*
OFF

ON

ON

D2 Switches
4 1 2 3

OFF*
ON
OFF

ON

OFF

ON *

OFF*

ON

MultiHop radio setting: Repeater OFF OFF
MultiHop radio setting: Client OFF ON
MultiHop radio setting: Server ON OFF

MultiHop radio setting: DXM LCD Menu Control ON * ON *

* Default configuration. The default settings for D2 DIP switches 1, 3, and 4 are ON. This allows for forcing the device into
client mode and DXM menu control for the radio power settings.

Application Mode

The MultiHop radio operates in either Modbus mode or transparent mode. Use the internal DIP switches to select the mode
of operation. All MultiHop radios within a wireless network must be in the same mode.

Modbus mode uses the Modbus protocol for routing packets. In Modbus mode, a routing table is stored in each parent device
to optimize the radio traffic. This allows for point-to-point communication in a multiple data radio network and acknowledg-
ment/retry of radio packets. To access a radio's 1/0O, the radios must be running in Modbus mode.

In transparent application mode, all incoming packets are stored, then broadcast to all connected data radios. The data com-
munication is packet-based and not specific to any protocol. The application layer is responsible for data integrity. For one-to-
one data radios it is possible to enable broadcast acknowledgment of the data packets to provide better throughput. In trans-
parent mode, there is no access to the radio's 1/0.

Baud Rate and Parity

The baud rate (bits per second) is the data transmission rate between the device and whatever it is physically wired to. Set
the parity to match the parity of the device you are wired to.
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Disable Serial

Disable an unused local serial connection to reduce the power consumption of a data radio powered from the solar assembly
or from batteries. All radio communications remain operational.

Transmit Power Levels/Frame Size
The 900 MHz data radios can be operated at 1 watt (30 dBm) or 0.250 watt (24 dBm). For most models, the default transmit

power is 1 watt.
For 2.4 GHz radios, the transmit power is fixed at 0.065 watt (18 dBm) and DIP switch 5 is used to set the frame timing. The

default position (OFF) sets the frame timing to 60 milliseconds. To increase throughput, set the frame timing to 40 millisec-
onds. For battery-powered devices, increasing the throughput decreases battery life.

IMPORTANT: Prior to date code 15341 and radio firmware version 3.6, the frame timing was 40 ms (OFF)
or 20 ms (ON).

DIP Switch Settings for the Performance Gateway Radio Mod-
ule

The 900 MHz radios transmit at 1 Watt (30 dBm) or 250 mW (24 dBm). The 250 mW mode reduces the radio's range but im-
proves the battery life in short range applications. For 2.4 GHz models, this DIP switch is disabled. The transmit power for 2.4

GHz is fixed at about 65 mW EIRP (18 dBm).

DX80 Performance Gateway ISM radio devices are defined with R1, R3, and R8 in the model number.

*  DXMxxx-xxR1 - DX80 Performance 900MHz
*  DXMxxx-xxR3 - DX80 Performance 2.4GHz
*  DXMxxx-xxR8 - DX80 Performance 900MHz (Australia)

IMPORTANT: To adjust the transmit power on the Gateway radio, Banner recommends using the LCD
menu (System Conf > ISM Radio » RF CNTRL).

DIP switch bank 1 and bank 2

-~
= Antenna

g
= = =
= e |
- ] o~ q !

DIP Switch DIP Switch Button

e
[N
oo[] o

Bank 1 Bank 2
DIP switch settings for bank 1
DIP Switch 1
OFF 1 Watt (30 dBm, 900 MHz models only) (default configuration)
ON 250 mW (24 dBm, 900 MHz models only), DX80 compatibility mode
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Chapter 4 Processor Boards

Processor Board for the DXM1x0 Models

Processor board for the DXM

O
O
o

00000000 00000000000000
A

> 000000000000N0N0n0n0na

=
°
0oannnnn

IR

Processor board features

Callout Description Function

Cellular modem con- Install the cellular modem onto the processor board with the cellular modem's U.FL connector on the left. The
A . antenna cable will go between the cellular U.FL connector and the left /O base board U.FL connector. Always
nection . . ) . )
disconnect the power to the device before installing or removing a cellular modem.

Use the processor board button to force a cloud push. To force a push to the cloud, press and hold this button for

B Button five (5) seconds to send an immediate push message from the device (if properly configured).
C Boot load jumpers

D DIP switches

E Micro SD card

F LED 1 Heartbeat, indicates the processor is running

Indicates the cellular modem power cutoff is active; if the incoming power is less than 11.2 V, the cellular modem

G LED2 is powered down

Continued on page 28
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Continued from page 27

Callout Description Function

XML configuration file was rejected; or file load in process; or the second phase of boot loading is in process

H LED3 (flashing)

ScriptBasic program failed to load; or the beginning phase of boot loading is in process (flashing = in process, on

! LED 4 = complete)

DIP Switch Settings for the Processor Board

After making changes to the DIP switch settings, cycle power to the device.

DIP switches for the DXM processor board

DIP Switches
Settings
1 2 3 4
OFF *
Disable Ethernet Port
ON
OFF *
Disable LCD Display
ON
Not used OFF *
OFF *
Bypass XML
ON
Bypass XML Disable Ethernet Port

Turn on to have the XML file ignored at boot time. This is use- Set to on to power down the Ethernet interface. Disabling the

ful for ignoring a corrupt or questionable XML configuration unused Ethernet port reduces power consumption.

file. After the device is running, a new XML file can be loaded The factory default position is OFF.

using the DXM configuration tool.

Turn on to stop the processor from executing defined configu- Disable LCD Display _ _

ration. This is useful if the loaded configuration is using all the Set to on to disable the LCD. This DIP switch should be on

processing time and not allowing DXM Configuration Tool op- when the LCD display board is not connected.

erations. The factory default position is OFF.

The factory default position is OFF.

Ethernet

Before applying power to the DXM, verify the Ethernet cable is connected.

The number of times the processor attempts to connect to the Ethernet network is configured in the DXM Configuration Soft-
ware (Settings » Network Ethernet Connection Acquisition). The default setting is two retries one minute after the device
boots up another retry two minutes later.

The Ethernet connection supports the DXM Configuration Software, Modbus/TCP, and EtherNet/IP. ScriptBasic also has ac-
cess to Ethernet for custom programming. Use the software or LCD menu system to configure the characteristics of the Eth-
ernet connection, including the IP address. Any parameters not changeable from the menu system are configurable from the
configuration software.

Ethernet parameter changes entered through the LCD menu override the XML configuration parameters. To return to using
the network settings in the XML configuration file, remove the Ethernet parameters defined by the LCD menu using the Sys-
tem Config » Ethernet » Reset menu.

USB

The USB port is used with the DXM Configuration Software to program the DXM Controller. The USB port is also used as the
console output for the processor and ScriptBasic.
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Turn on debug messages to the serial console by selecting Print push debug messages to serial console in the DXM Config-
uration Software Settings » Cloud Services screen.
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Chapter 5 |O Base Boards

Board Connections for the DXM150-B1 and DXM1500-B1

DXM150-B1 and DXM1500-B1 Board Connections

= B
G1 G2
J o/
ifilis;
K
F
:
=]
1 24
DXM150-B1 and DXM1500-B1 pins
1 NC 17 Isolated discrete input 2B 33 Analog Output 1 (0-20 mA or 0-10 V)
2 12 to 30 V DC or solar power in (+) 18 Ground 34 Ground
3 Ground 19 Output 1 Normally Open 35 PWR Out 2 - E Jumper Selectable
Battery in (< 15V DC) (must be a
4 sealed lead acid battery) 20 Output 1 Common 36 Ground
5 Ground 21 Output 1 Normally Closed 37 Universal Input 8

Continued on page 32
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Continued from page 31

6 Primary RS-485 — 22 Output 3 Normally Open 38 Universal Input 7

7 Primary RS-485 + 23 Output 3 Common 39 Universal Input 6

8 Ground 24 Output 3 Normally Closed 40 Universal Input 5

9 RS-232 Tx / CAN * 25 NMOS Output 5 41 Ground

10 RS-232 Rx / CAN * 26 No connection 42 Universal Input 4
Secondary RS-485 — or RS-232 .

1 RXRDY 27 NMOS Output 6 43 Universal Input 3
Secondary RS-485 + or RS-232

12 TXRDY 28 NMOS Output 7 44 Ground

13 Ground 29 No connection 45 PWR Out 1 - E Jumper Selectable

14 Isolated discrete input 1A 30 NMOS Output 8 46 Universal Input 2

15 Isolated discrete input 1B 31 Ground 47 Universal Input 1

16 Isolated discrete input 2A 32 C?alog Output2 (0-20 mA0r0-10 ¢ Ground

DXM150-B1 and DXM1500-B1 I/O base board components

Analog output characteristics jumpers
A Base board LED E PWR Out jumpers G3 (jumper 1 sets analog out 1, jumper 2 sets
analog out 2)

B Cellular or secondary antenna F Radio binding button H ISM radio connection
C  Radio LED g1 RS-48S/RXRDY, pin 11, 12 selection Modbus ID DIP switches
jumper
D Radio module antenna G2 .RS—232/CAN »Pin 9, 10 selection K Rotary dials
jumper
L Processor board connection

* Controller Area Network (CAN) only available with DXM150 models.
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Board Connections for the DXM150-B2 and DXM1500-B2

DXM150-B2 and DXM1500-B2 board connections

= [
]

(o]
eEs B
Gl G2 |

DXM150-B2 and DXM1500-B2 pins

1 NC 17 Isolated discrete input 2B 33 Analog Output 1 (0-20 mA or 0-10 V)
2 12 to 30 V DC or solar power in (+) 18 Ground 34 Ground

3 Ground 19 Output 1 PNP/NPN 35 PWR Out 2 - E Jumper Selectable
4 Baveryin (<15 dvbgtctzefy")“g @ 20 Output2 PNPINPN 36  Ground

5 Ground 21 Output 3 PNP/NPN 37 Universal Input 8

6 Primary RS-485 — 22 Output 4 PNP/NPN 38 Universal Input 7

7 Primary RS-485 + 23 PWR Out OR 39 Universal Input 6

8 Ground 24 Ground 40 Universal Input 5

9 RS-232 Tx/ CAN * 25 Ground 41 Ground

10 RS-232 Rx / CAN * 26 PWR OUT OR 42 Universal Input 4

11 E;T;’Siary RS-485 - or RS-232 27 Output 8 PNP/NPN 43 Universal Input 3

12 ?;g’gsary RS-485 + or RS-232 28 Output 7 PNP/NPN 44 Ground

13 Ground 29 Output 6 PNP/NPN 45 PWR Out 1 - E Jumper Selectable
14 Isolated discrete input 1A 30 Output 5 PNP/NPN 46 Universal Input 2

15 Isolated discrete input 1B 31 Ground 47 Universal Input 1

16 Isolated discrete input 2A 32 Analog Output 2 (0-20 mA or 0-10 V) 48 Ground
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DXM150-B2 and DXM1500-B2 I/O base board components

Analog output characteristics jumpers (jumper

A Base board LED E PWR Out jumpers G3 1 sets analog out 1, jumper 2 sets analog out
2)

B Cellular or secondary antenna F Radio binding button H ISM radio connection

C  Radio LED RS-485/RXRDY. pin 11, 12 selection J Modbus ID DIP switches

jumper
D Radio module antenna G2 RS-232/CAN*, pin 9, 10 selection jumper K Rotary dials

L Processor board connection

* Controller Area Network (CAN) only available with DXM150 models.

DIP Switches for the 1O Board

The DXM Controller I/O board DIP switches are set from the factory to Modbus 1D 200.

Setting the Modbus ID on the I/O Base Board

Only DXM150-Sx and SxR2 Modbus Server models require that the Modbus ID to be adjusted on the I/O base board. The
DXMs use DIP switch J and rotary dial K to set the Modbus ID. The device can use a Modbus register 6804 in the 1/O board
to access the full range of Modbus IDs.

DIP Switch location J defines the course group of Modbus IDs. DIP Switch 4 must be set to ON for DXM1xx-Sx and
DXM1xx-SxR2 models. Use rotary dial K to select the lower digit of the Modbus ID.

Location J DIP Switches

Location J DIP Switches

Settings

1 2 3 4
Modbus ID set to 11 through 19 OFF OFF
Modbus ID set to 20 through 29 ON OFF
Modbus ID set to 30 through 39 OFF ON
Modbus ID set to 40 through 49 ON ON
Not Used -
Modbus Server Configuration (S1 model only) (1) ON

I12C Processor Communication OFF

Use rotary dial location K and DIP switch location J to set the Modbus IDs.

Location K Rotary Dials — Position 0 through 9

DIP Switches J Location K Rotary Dials — Position 0 through 9

1 2 0 1 2 3 4 5 6 7 8 9
OFF OFF x @ 1 12 13 14 15 16 17 18 19
ON OFF 20 21 22 23 24 25 26 27 28 29
OFF ON 30 31 32 33 34 35 36 37 38 39
ON ON 40 41 42 43 44 45 46 a7 48 49

() Must be in the ON position for the -S1 model)
@) yses value in Modbus register 6804.
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Example to Set the DXM Modbus ID using DIP Switches
To set the DXM to a Modbus ID of 25, set the following:

Location J DIP switches set to: 1= ON, 2=0OFF

Rotary dial setto 5

The DIP switch sets the upper digit of the server ID to 2 while the rotary dial sets the lower digit to 5.

Example to Set the DXM 1/O Board Modbus ID using Modbus Registers
Write to the I/O board's Modbus register 6804 to set the Modbus ID to any valid Modbus ID (1 through 245).
« Rotary dial K should be in the zero position to use the Modbus register server ID.

I/O Board Jumpers

Hardware jumpers on the DXM 1/O board allow the user to select alternative pin operations. Turn the power off to the device
before changing jumper positions.

/O board jumpers

Jumper Function Positions

Courtesy power outputs provide continuous power and cannot be turned on or off. Jumper
2 is the power jumper for pin 45. Jumper 1 is the power jumper for pin 35.
» The pin 45 jumper selects 2.7 VV when in the "a" position and 12 V battery in the
E Courtesy power output "b" position.
* The pin 35 jumper selects 4.2 VV when in the "a" position and device power on pin
2 in the "b" position.

Defines the operation of pins 11 and 12. Set the jumpers to use pins 11 and 12 as a sec-
RS-485 Modbus Serve or ondary Modbus RS-485 server port or flow control pins for the RS-232 port. Both jumpers
RS-232 Flow Control must be set to the same operation, RS-485 Modbus Server or Flow control.

The default setting is RS-485.

G1

Defines the operation of pins 9 and 10. Set the jumpers to use pins 9 and 10 as a CAN se-
Generic RS-232 Serial Port or rial port or a generic RS-232 serial port. Both jumpers must be set to the same operation,
G2 CAN Serial Port CAN or RS232.
The default setting is CAN serial port. Controller Area Network (CAN) is only available with
DXM150 models.

Defines current (0—20 mA) or voltage (0—10 V) for analog output 1 and 2.
By default, current (0-20 mA) is selected using jumpers 1 and 2 and registers 4008 and

4028 contain a value of 2.
Analog output characteristics

G3 for AO2 (pin 32) and AO1 (pin  To select voltage (0—10 V) for output Aout1, set jumper 1 in the voltage position (V) and
33) set Modbus register 4008 on the 1/0 board (SID 200) to 3.

To select voltage (0-10 V) for output Aout2, set jumper 2 in the voltage position (V) and
set Modbus register 4028 on the 1/0 board (SID 200) to 3.

Applying Power to the B1 Models

Apply power using either 12 to 30 V DC or a 12 V DC solar panel and 12 V sealed lead acid battery.
Power pins for the BT models

Pin Description

Pin 1 No connection

Continued on page 36
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Continued from page 35
Pin Description
Pin 2 12 to 30 V DC input (+) or solar panel connection (+)

Pins 3, 5, 8, 13, 18, 31, 34,

36, 41, 44, 48 Main logic ground for the DXM

Solar or backup battery positive input. Battery voltage must be less than 15 V DC. Use only a sealed lead acid (SLA) bat-

Pin 4
tery.

Applying Power to the B2 or S2 Models

Apply power using either 12 to 30 V DC or a 12 V DC solar panel and 12 V sealed lead acid battery.
Power pins for the B2 and S2 models

Pin Description
Pin 1 No connection
Pin 2 12 to 30 V DC input (+) or solar panel connection (+)

Pins 3, 5, 8, 13, 18, 31, 34,

36, 41, 44, and 48 Main logic ground for the DXM

Solar or backup battery positive input. Battery voltage must be less than 15 V DC. Use only a sealed lead acid (SLA) bat-

Pin 4
tery.

Pin 23, 26, 35, and 45 Courtesy power output, configuration based on jumper block E (see "I/O Board Jumpers " on page 35)

Connecting a Battery

When attaching a battery to the DXM as a backup battery or as a solar battery, verify the charging algorithm is set properly.
The factory default setting for the battery charging algorithm assumes you are using 12 to 30 V DC to recharge the battery.

The charging algorithm is designed to work only with a sealed lead acid (SLA) battery.
* When using 12 to 30 V DC, connect the 12 to 30 V DC + to pin 2 and connect the ground to pin 3.
* When using main dc power with a backup battery (default configuration), connect the incoming main power pin 2 (+)
and to pin 3 (-). Connect the 12 V sealed lead acid battery to pin 4 (+) and pin 5 (-). The incoming main power must
be 15 to 30 V DC to charge the battery.

Supplying Power from a Solar Panel

To power the DXM Controller from a 12 V DC solar panel, connect the solar panel to power pins 2(+) and 3(-). Connect a 12
V DC sealed lead acid (SLA) rechargeable battery to pins 4(+) and 5(-).

The factory default setting for the battery charging configuration assumes you are using 12 to 30 V DC power to recharge the
battery. If the incoming power is from a solar panel, you must change the charging configuration.

The battery charging configuration defaults to a battery backup configuration. To change the charging configuration from the
menu system:

1. From the DXM LCD menu, navigate to System Config > I/O Board » Charger.

2. Select Solar for solar panel configurations or DC for battery backup configurations.

To change the charging configuration by writing to Modbus register 6071 on the 1/0 base board (ID 200):
1. Write a 0 to select the solar power charging configuration.

Connecting the Communication Pins

The base board communications connections to the device are RS-485 (primary), RS-485 (secondary) or RS-232.
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RS-485—The primary RS-485 bus is a common bus shared with the radio board (Modbus ID 1). The DXM is defined as the
Modbus Client on this bus. Other internal Modbus servers include the local processor registers (Modbus ID 199), the base I/
O controller (Modbus ID 200), and the display board (Modbus ID 201). When assigning Modbus Server IDs to externally con-
nected devices, only use IDs 2 through 198.

RS-232—The RS-232 bus is not currently defined.

Communication pins
Pin Parameter Description
Pin 6 Primary RS-485 — Use this bus to connect to other Modbus Server devices. The DXM is a Modbus Client device on
Pin 7 Primary RS-485 + this RS-485 port. The Modbus protocol baud rate is user configurable but is set to 19.2k by default.
Pin 9 RS-232 Tx Serial RS-232 connection. This bus must use a ground connection between devices to operate
Pin 10 RS-232 Rx correctly.
Pin 11 Secondary RS-485 — Select using the RS-485 and RS-232 Selection Jumpers (see "DXM150-B1 and DXM1500-B1
or RS-232 RXDY Board Connections" on page 31).
+ In position "a" these pins are a secondary RS-485 bus. The DXM is a Modbus server on
this bus.
Pin 12 Secondary RS-485 + * In position "b" these pins are the flow control signals for the RS-232 signal on pins 9 and
or RS-232 TXRDY 10.

Modbus RTU Master and Slave Ports

The DXM can be a Modbus RTU client device to other server devices and can be a Modbus server device to another Modbus
RTU client. The DXM uses the primary RS-485 port (M+/M-) as a Modbus RTU client to control external server devices. All
wired devices connected to the client RS-485 port must be server devices.

» As a Modbus RTU client device, the DXM controls the external server connected to the primary RS-485 port, the local
ISM radio, the local I/0 base board, and the local display board.

» As a Modbus RTU server device, the DXM local registers can be read from or written to by another Modbus RTU
client device.

The secondary port (S+/S-) is the Modbus RTU server connection. The secondary (server) Modbus RS-485 port (S+/S-) is
controlled by another Modbus client device, not the DXM. The server port is used by an external Modbus client device that
will access the DXM as a Modbus server device.

Use the configuration software to define operational settings for both the Modbus RTU client port and the Modbus RTU serv-
er port.

Use the DXM's LCD menu to set the Modbus ID for the secondary RS-485 port.
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Set the Client and Server Port Parameters

The basic communications parameters for the RS-485 ports are set in the DXM Configuration Software and are saved in the
XML configuration file.

Settings > General screen

[3] Show advanced settings

Device Time
Curent device time -
Get time from device | Sync PC time with device
Device {UTC) |UTC (UTC+00:00) 9|

Device observes DST []

Device Location / GPS

Acquire using | Default Latlon |~ External GPS address

Acquire GPS data 000015 Defautt latitude &
every (hh:mm:ss) 00.00:00 =

Send location to cloud O Default longitude 0%

HTTP ! Data Logs

Clear HTTF / Data logs |Daily at midnight UTC | =

Erase HTTP / Data logs

Slave Port Settings S+/S-

Master Port Settings M+/M-

Baud rate | 19200 - Parity [None | =)

Delay between
00:00.05.0008]  messages
(hh:mm:ss_fif)

Timeout

(hh:mm:ss. M) 000000050@

Baud rate | 19200 | =) Parity [None Lx]
Wireless Backbone (None x3

Automatic Radio Poling |None -

DXM700 comms.
Baud rate | 19200 |*| Party [None -

e ey Gone N
Timeout (hhmm:ss. 1M 00.00:05.000 /]
Delay between

messages 00:00:00.050 /8]
{(hh:mm:ss. M)

1. In the DXM Configuration Software, go to the Settings » General screen.
2. To set the parameters for the Modbus Client, change the settings in the Client Port Settings M+/M- section.
3. To set the parameters for the Modbus Servers, change the settings in the Server Port Settings S+/S- section.

Baud Rate

Timeout

Defined for both the Modbus client and server
Settings include: 19200 (default), 1200, 2400, 9600, 38400,
57600, and 115200.
Delay between messages
Applies to the Modbus client port

Sets the minimum wait time from the end of a Modbus trans-

action to the beginning of the next Modbus transaction.

Parity

Defined for both the Modbus client and server
Settings include: None (default), odd, even, space, and mark

Set the DXM Modbus Server Port ID

Set the DXM Modbus server port ID using the LCD menu system.
1. On the LCD, use the down arrow to highlight System Config and click the Enter button.
2. Highlight DXM Modbus ID and click Enter.
3. Use the up and down arrow buttons to change the DXM Modbus Server Port ID.
4. Press Enter to accept the ID change.

5. Use the configuration software to cycle power to the device.

Applies to the Modbus client port

Covers the expected time for messages to be sent throughout
the wireless network. For the DXM, the Timeout parameter is

the maximum amount of time the DXM should wait after a re-

quest is sent until the response message is received from the
Modbus server device.

Wireless Modbus Backbone

Applies to the Modbus server port

Define when there is an ISM radio plugged into the processor
board. When this is done, the Modbus server port uses the
MultiHop radio as the server port instead of the terminal block
connection on the 1/0 base board. Settings include: None (de-
fault), Modbus, or Ethernet

After cycling power to the device, the updated DXM Modbus ID is listed under the System Config menu.

Inputs and Outputs

The 1/0O base board is a Modbus server device (ID 200) that communicates to the processor board using Modbus commands.
Use the DXM Configuration Software to create a configuration using read/write maps that will access inputs or outputs on the

I/0 board.

© Banner Engineering Corp.
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Communication with the 1/0 board runs at a maximum rate of 10 ms per transaction. The parameter setting for the bus with
the 1/0 board and the processor board are fixed. External Modbus communication runs at a maximum rate of 50 ms per
transaction. The parameter settings for the external RS-485 buses are controlled by the DXM Configuration Software.

Refer to "Modbus Register Summary " on page 72 for more descriptions of each Modbus register on the DXM Controller.

Universal Inputs

The universal inputs can be programmed to accept different types of inputs: discrete NPN/PNP, 0 to 20 mA analog, 0 to 10 V
analog, 10k thermistor, potentiometer sense, bridge, and NPN raw fast. Use the DXM Configuration Software tool to write to
the appropriate Modbus registers in the 1/0 board to configure the input type.

The universal inputs are treated as analog inputs. When the universal inputs are defined as mA, V, or temperature, use Mod-
bus registers to configure the operational characteristics of the inputs. These parameters are temperature conversion type,
enable full scale, threshold and hysteresis. See "Modbus Register Summary " on page 72 for the parameter definitions.

When a universal input is configured as an NPN or PNP input type, it can be enabled to be a synchronous counter. Enable
the counter function by setting Modbus register 'Enable Rising' or 'Enable Falling' to 1. See "Modbus Register Summary " on
page 72 for the universal input register definitions.

Universal input pins

Pin Univ. Input Description
Pin 47 Universal Input 1 Program the universal inputs to accept input types NPN, PNP, 10k thermistor, 0 to 10 V, 0 to 20
mA, or potentiometer. The default setting is 8: NPN raw fast. To set the input type, write the fol-

Pin 46 Universal Input 2 ’ :
lowing values to the Input Type Modbus registers.

Pin 43 Universal Input 3 0=NPN
) . 1=PNP
Pin 42 Universal Input 4 2=01t020 mA

3=0t0o10V DC

Pin 40 Universal Input 5
4 = 10k Thermistor

Pin 39 Universal Input 6 5 = Potentiometer Sense (DXM150 only)
. . 6 = Not used
Pin 38 Universal Input 7 7 = Bridge

Pin 37 Universal Input 8 8 = NPN Raw Fast (default)

Bridge Input Thermistor Input
The bridge input is not implemented yet. A thermistor input must use a 10k thermistor between ground
and the universal input. The thermistor must be a 10k NTC
NPN vs NPN Raw Fast . (Banner model number BWA-THERMISTOR-002) or equiva-
The difference between NPN and NPN Raw Fast is the lent. Select the temperature conversion of degrees C (default)
amount of settling time given to the input. Switch the input or degrees F by writing to the Modbus registers defined in Key
type to NPN if the input is not detecting a transition. definition for "{keyrefName}" not found in the DITA map..

Potentiometer Sense (DXM150 only)
A potentiometer input is created from two inputs: a voltage
source (pin 45) that supplies a voltage to the potentiometer
and an input sense (Potentiometer Sense) to read the resis-
tance. See Using Universal Inputs to Read a Potentiome-
ter (p/n b_4462775) for more information.

Example: Configure Input 1 as a Synchronous Counter
1. Connect the DXM to the PC.
2. Launch the DXM Configuration Software software.

3. Connect to the DXM by selecting the Device » Connection Settings menu option. You may connect using either USB
or Ethernet.

. Select a COMM port from the drop-down list and click Connect.

. Click on the Register View tab on the left part of the page.

. Change the Source Register selection to I/O Board Registers.

. In the Write Registers area, write Modbus register 4908 to 1 to enable counting on the rising edge of the input signal.
. Read Modbus registers 4910 and 4911 to get the 32-bit value of the count.

o NOoO ObN
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Example: Change Universal Input 2 to a 0 to 10 V DC Input

1.
2.
3.

© 0o N O O b

Connect the DXM to the PC.
Launch the DXM Configuration Software software.

Connect to the DXM by selecting the Device » Connection Settings menu option. You may connect using either USB
or Ethernet.

. Select a COMM port from the drop-down list and click Connect.

. Click on the Register View tab on the left part of the page.

. Change the Source Register selection to I/O Board Registers.

. Write a 3 to Modbus register 3326 on Modbus ID 200 (I/O board).

. Cycle power to the device.

. Using the Register View tab, read register 3326 to verify it is set to 3.

Example: Change Analog Output 1 to a 0 to 10 V DC Output

1.
2.
3.

N o oM

© o

Connect the DXM to the PC.
Launch the DXM Configuration Software software.

Connect to the DXM by selecting the Device » Connection Settings menu option. You may connect using either USB
or Ethernet.

. Select a COMM port from the drop-down list and click Connect.

. Click on the Register View tab on the left part of the page.

. Change the Source Register selection to /0O Board Registers.

. Set jumper 1 on the 1/O base board to the 0 to 10 V position. Refer to the base board image for the analog output

jumper position.

. Write a 3 to Modbus register 4008 on Modbus ID 200 (I/O board).
. Cycle power to the device.
. Using the Register View tab, read register 4008 to verify it is set to 3.

Example: Change Universal Input 8 to Read a Potentiometer Input

—_

Default jumper position

Power pin 45
27V @ @O 42V

pin45 |©] (@] pin35 Pot sense Ui8 —

Vbatt @ (@] Pwrin
Ground

. Launch the DXM Configuration Software tool.
. Click on the Register View tab on the left part of the page.
. In the upper right part of the window select Modbus Registers using Modbus ID radio button and enter Modbus

ID 200.

. To set universal input 8 as the sense, write Modbus register 3446 with 5 (Potentiometer Sense).
. Verify the jumpers are still set to their default position. One jumper should be on pins 1 and 3 to get a 2.7 V source

voltage out pin 45. The default position of the other jumper is on pins 4 and 6.

. Connect one potentiometer side to power output (pin 45), connect the tap point of the pot to universal input 8 (pin 37),

and connect the other end of the pot to ground (pin 36).

Isolated Discrete Inputs

The DXM has two (2) optically isolated inputs. The inputs signals are electrically isolated forming a barrier to protect the
DXM from different ground potentials of the input signals.

Input 1 uses terminals 1A and 1B and the second input uses 2A and 2B. An input voltage should be applied between the ter-
minals between 0 and 30 V DC, the on/off transition threshold is approximately 2.6 V.
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Isolated discrete input pins

Pin LD Rl Input Description
ter
Pin 14 501 Input 1A
Pin 15 Input 1B I?\l XA
Pin 16 503 Input 2A . . .
Optically isolated AC input type, 0 to 12 to 30 V DC Y A I

Input to output isolation of 2.5 kV

Pin 17 Input 2B IN xB

Synchronous Counters—An isolated input can be programmed to count the input signal transitions. When an input is en-
abled as a counter, the counter value is stored into two 16-bit Modbus registers for a total count of 32-bits (unsigned). To pro-
gram an input to capture the edge transition counts, follow " Example: Configure Input 1 as a Synchronous Counter " on page
39.

The counters are synchronous because the inputs are sampled at a 10 ms clock rate. The input logic does not detect rising
or falling edges, it samples the input every 10 ms to find level changes. The input signals must be high or low for more than
10 ms or the input will not detect transitions. Because most signals are not perfect, a realistic limit for the synchronous
counter would be 30 to 40 Hz.

Universal inputs can also be configured as a synchronous counter. See "Modbus Register Summary " on page 72 for all the
register definitions. The procedure for creating a synchronous counter is the same as a isolated input with the addition of
changing the input type to PNP or NPN.

Relay Outputs for the DXM150-B1, 1500-B1, and 150-S1

Relay output pins
Pin Qutput Description Wiring
Pin 19 Output 1: Normally Open

Normally open

Pin 20 Output 1: Common
Pin 21 Output 1: Normally Closed
SPDT (Form C) relay, 250 V AC, 16 A Common
Pin 22 Output 3: Normally Open
Pin 23 Output 3: Common Normally closed

Pin 24 Output 3: Normally Closed

NMOS Outputs
Pins for the NMOS outputs for the DXM150-B1, DXM1500-B1, and DXM150-S1 models

Modbus Regis-

Pin - Output Description Wiring

Pin 25 505
Output

Pin 27 506 4‘

. Less than 1 A maximum current at 30 V DC
Pin 28 507 ON-State Saturation: Less than 0.7 V at 20

NMOS Discrete Outputs mA
ON Condition: Less than 0.7 V

. OFF Condition: Open

Pin 30 508
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The DXM150-B2, DXM1500-B2, and DXM150-S2 models do not have NMOS outputs.

PNP and NPN Outputs for the B2 and S2 Models

Pins for the PNP/NPN outputs for the DXM150-B2, DXM1500-B2, and DXM150-S2 models

Pi

n

19
20
21
22
30
29
28
27

The DXM150-B1, DXM1500-B1, and DXM150-S1 models do not have PNP/NPN outputs.

Output Modit;l::rReg-
1 501
2 502
3 503
4 504
5 505
6 506
7 507
8 508

Description

PNP/NPN Output 1
PNP/NPN Output 2
PNP/NPN Output 3
PNP/NPN Output 4
PNP/NPN Output 5
PNP/NPN Output 6
PNP/NPN Output 7

PNP/NPN Output 8

Analog Outputs (DAC)

The following characteristics are configurable for each of the analog outputs.

Pins for the analog (DAC) outputs

Pin

Pin 33

Pin 32

Output

Analog Output 1

Analog Output 2

PNP OUT Wiring

PWR 10-30 V DC

Discrete OUT- N

GND

DC common

Description

NPN OUT Wiring

pwR 10-30 V DC

Discrete OUT

(GND
DC common

0to 20 mAor 0 to 10 V DC output (selectable using the Analog Output Characteristics Jumpers)
Accuracy: 0.1% of full scale +0.01% per °C
Resolution: 12-bit

© Banner Engineering Corp.
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Chapter Contents
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Cellular Power Requirements .......
Using the DXM Cellular Modem....
Activating a Cellular Modem

Chapter 6 Cellular Modem Boards

Cellular Modem Board

The LTE-M (United States) or LTE-M/NB-loT (outside the United States) cellular modem is an optional accessory that is in-
stalled on the processor board on the two 12-pin sockets.

Cellular modem board

8¢

A - U.FL antenna connection

The U.FL connector should be to the left, with the antenna cable going to the left antenna U.FL connector. The SIM card
slides into the socket on the back of this board.

Cellular Power Requirements

If the incoming voltage drops below 11.2 V DC, the cellular modem does not turn on and will not turn on until the voltage is
above 11.8 V DC. A text file (CmVMon.txt) on the internal micro SD card saves the periodic sampling of the incoming voltage.
If cellular operation stops because of voltage, it is logged in this file.
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Using the DXM Cellular Modem

The DXM cellular modem provides a remote network connectivity solution for the DXM.

To use the cellular modem:

1. Verify the cellular modem is installed and the correct antenna is connected to the cellular antenna port.
2. Activate the cellular service.

3. Configure the DXM to use the cellular network as the network interface.

Activating a Cellular Modem

Follow these basic steps, as detailed in this document, to activate the cellular capabilities of your DXM Controller.

1. Purchase a cellular modem kit from Banner Engineering Corp.
2. Install the cellular modem, connect the antenna cable, and connect the cellular antenna.
3. Activate a cellular plan to the SIM card, then insert the SIM card into the cellular modem.
4. Configure the DXM to use the cellular modem.

Purchase one of these cellular modem kit models

Cellular Kit Model

SXI-CATM1VZW-001

SXI-CATM1ATT-001

Kit Description

Verizon CAT M1 cellular modem using Telit
ME910 modem kit (Verizon part number
SXIM1V). Includes a cellular modem, SIM card,
internal adhesive antenna, external SMA anten-
na, and antenna cable. The SIM card is specific
to the LTE-M technology and cannot be used in
other cellular modems. Requires a LTE Verizon
cellular wireless plan attached to the ICCID
(SIM card) number and IMEI (International Mo-
bile Equipment Identity) number.

Cellular plans can be purchased

through celldata.bannercds.com.

AT&T CAT M1 cellular modem using Telit

ME910 modem kit (AT&T part number SXIM1A).

Includes a cellular modem, SIM card, internal
adhesive antenna, external SMA antenna, and
antenna cable. The SIM card is specific to the
LTE-M technology and cannot be used in other
cellular modems. Requires a LTE AT&T cellular
wireless plan attached to the ICCID (SIM card)
number and IMEI (International Mobile Equip-
ment ldentity) number.

Cellular plans can be purchased

through celldata.bannercds.com.

Continued on page 45

© Banner Engineering Corp.

Important Notes

This cellular modem kit is for use in applica-
tions that require monthly data usage ap-
proaching 50 MB or 250 MB with push inter-
vals no more frequent than every 10 minutes.
This modem is only for use in the contiguous
United States region.

Please visit our support site for more details
on coverage areas and cellular plan pricing.

This cellular modem kit is for use in applica-
tions that require monthly data usage ap-
proaching 50 MB or 250 MB with push inter-
vals no more frequent than every 10 minutes.
This modem is only for use in the North
American region.

Please visit our support site for more details
on coverage areas and cellular plan pricing.
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Continued from page 44

Cellular Kit Model Kit Description Important Notes
Worldwide CAT M1 cellular modem using Telit
ME910 model kit. Includes a cellular modem, This cellular modem kit is for use in applica-
SIM card, internal adhesive antenna, external tions that require monthly data usage ap-

SMA antenna, and antenna cable. The SIM card proaching 50 MB or 250 MB with push inter-
is specific to the LTE-M/NB-IoT technology and  vals no more frequent than every 10 minutes.

cannot be used in other cellular modems. Re- This modem is only for use in the Euro-
SXI-CATM1WW-001 quires an LTE cellular plan attached to the IC- pean region within those countries that are

CID (SIM card) number and IMEI (International members of the EU/EEA and adopt RED/CE

Mobile Equipment Identity) number. compliant products.

Cellular plans can be purchased Please visit our support site for more details

through celldata.bannercds.com or a local roam- on coverage areas and cellular plan pricing.
ing SIM provider.

For additional information, refer to the Banner Cloud Data Services support center (support.bannercds.com). The support
center includes video tutorials, product documentation, technical notes, and links to download configuration software.

IMPORTANT: Only the DXM100 and DXM150 models in conjunction with an SXI-LTE-001 (obsolete) cel-
lular modem can offer SMS/text messaging capabilities directly from the device. Contact a support spe-
cialist at Banner Engineering for configuration instructions, or SMS/text messaging can be delivered using
the Banner CDS web service from any DXM model.

Install the Cellular Modem (DXM100, 150, 700, and 1000 Models)

Follow these steps to install the cellular modem and antenna cable.

IMPORTANT:
» Electrostatic discharge (ESD) sensitive device
» ESD can damage the device. Damage from inappropriate handling is not covered by warranty.
» Use proper handling procedures to prevent ESD damage. Proper handling procedures include
leaving devices in their anti-static packaging until ready for use; wearing anti-static wrist straps;
and assembling units on a grounded, static-dissipative surface.

Installing the cellular modem

S{Telif

[¢) Jﬂ>§; O
4o

Ol 13

1. SIM cards come in a credit card sized carrier. Carefully snap it out of the carrier.

2. Make note of the IMEI number of the cellular modem and the ICCID number of the SIM card.
The numbers can be found on the cellular modem and the SIM card or SIM card carrier. You will need the SIM num-
ber to associate a wireless plan to this SIM card.

3. Insert the SIM card into the socket on the underside of the cellular modem while ensuring the conductive pads on the
SIM card are interfacing with the terminals of the modem.
There is a matching notch in the socket and SIM card that will only allow the SIM to be inserted with one orientation.
Do not force the SIM card into the socket.

4. Orient the cellular modem according to the pin layout.

June 05, 2023 © Banner Engineering Corp.


http://celldata.bannercds.com
http://support.bannercds.com/home/pricing/how-to-choose-a-cellular-service-plan/
http://support.bannercds.com

DXM150-Bx And 1500-Bx Wireless Controller Instruction Manual

DXM100, 150, and 1000 DXM700

SIM card*
1 location

*SIM card is located on the underside of installed modem *SIM card is located on the underside of installed modem

o For the DXM100, DXM150, and DXM1000 models—Install the cellular modem board onto the processor
board as shown. Use the diagram to verify the orientation is correct.

o For the DXM700 models—Install the cellular modem board onto the base board as shown. Use the diagram to
verify the orientation is correct.

a. Verify the pins are properly aligned.
b. Verify the hole in the cell modem aligns with the hole on the DXM board.
c. Firmly press the modem into the 24-pin socket.

5. Attach the antenna cable between the cellular modem board to the base board as shown.
6. Install the external cellular antenna on the DXM's SMA connector located next to the antenna cable.

Install the Cellular Modem (DXM1200 Models)

Follow these steps to install the cellular modem and antenna cable.

IMPORTANT:
 Electrostatic discharge (ESD) sensitive device
» ESD can damage the device. Damage from inappropriate handling is not covered by warranty.
» Use proper handling procedures to prevent ESD damage. Proper handling procedures include
leaving devices in their anti-static packaging until ready for use; wearing anti-static wrist straps;
and assembling units on a grounded, static-dissipative surface.

Installing the cellular modem

g ° 3
=

—

o

1. SIM cards come in a credit card sized carrier. Carefully snap it out of the carrier.

2. Make note of the IMEI number of the cellular modem and the ICCID number of the SIM card.
The numbers can be found on the cellular modem and the SIM card or SIM card carrier. You will need the SIM num-
ber to associate a wireless plan to this SIM card.

3. Insert the SIM card into the socket on the underside of the cellular modem while ensuring that the conductive pads on
the SIM card are interfacing with the terminals of the modem.
There is a matching notch in the socket and SIM card that will only allow the SIM to be inserted with one orientation.
Do not force the SIM card into the socket.
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4. Apply the internal antenna as shown paying attention to the antenna cable position.

a. Pull back the adhesive protective paper from the middle of the antenna, only exposing the middle portion. An-
tenna application is easier if just a small middle portion of the adhesive is uncovered.

b. Center the antenna on the side wall. Use the exposed adhesive in the middle of the antenna to hold the anten-
na in place while aligning the antenna to the full length of the housing.

c. Slowly peel off the paper backing exposing the adhesive and stick to the plastic housing. The antenna should
run below the rim of the housing.

d. Press firmly.

5. Orient the cellular modem according to the diagram below.
The cellular modem is inserted into the main board with the antenna cable from the applied internal antenna attached
to the cellular modem PCB.

Internal view of a DXM1200

1= SIM card*
_) location

*SIM card is located on the underside of installed modem
a. Verify the pins are properly aligned.
b. Verify the hole in the cell modem aligns with the hole on the DXM board.

c. Firmly press the modem into the 24-pin socket.

6. Attach the antenna cable between the cellular modem board to the base board. The antenna cable uses the top an-
tenna connection.

Activate a 4G LTE CAT M1 Cellular Plan

Activate a cellular plan for your DXM using the Banner Cloud Data Services website.

1. Go to celldata.bannercds.com to purchase cellular data plans.
2. If you have previously created an account, click Login and enter your username and password to continue.
3. If you are creating a login for the first time:

a. Select the region in which the device will operate.

b. Select the cellular subscription plan. Please use the calculator and regional coverage information to determine
the plan needed for your device (https://www.bannerengineering.com/us/en/products/wireless-sensor-net-
works/iot-cloud-cellular-data-services/cellular-data-plans/Service-Plan-Calculator.html).

c. Create a username and password (use an email address for the username).
d. Enter your payment information, mailing address, agree to the terms and conditions.

4. Go to the My Services and Equipment section.

5. Enter the SIM Number (ICCID) and the Module Number (IMEI).
The ICCID is the 20-digit number of the SIM, the bottom barcode number on the SIM card carrier. If the carrier card is
not available, the ICCID is also printed on the SIM card, but must be removed from its socket to be read. The IMEl is
the 15-digit number on top of the 4G LTE device.

6. Click Activate.
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Enter the ICCID and IMEI numbers then click Activate
IMEI number

HOTE: Your activation is usually complete within 2-5 minutes.

Click Activate

Although new activations are typically functional in 20 minutes or less, it may take up to 24 hours for the cellular plan
to become active on the wireless network.

Activate a Worldwide 4G LTE MNB-IOT Cellular Plan (RED-CE)

The Worldwide 4G LTE-M/NB-IOT cellular modem is operational in those European countries that are members of the EU/
EEA and adopt RED/CE-compliant products.

An international roaming SIM is provided with the Worldwide module and may be activated following the steps listed in "Acti-
vate a 4G LTE CAT M1 Cellular Plan " on page 47. However, there may be regions that are not covered by the provided SIM
card. In this case, a local SIM card must be activated and operated with this device to acquire connectivity services.

1. Work with the local Banner technical support person to identify and purchase machine-to-machine (M2M) (data plan
only) SIM cards in 3FF 'micro' form factor.
Typical monthly data use will be 20-50 MB per month. When choosing a plan, pay close attention to data rates.

2. When activating the SIM, note the Access Point Name (APN) that the SIM provider states to use with their SIM.
The IMEI is the 15-digit number on top of the cell module PCB, below the words Telit MES10G1-WW and above the
barcode. The ICCID is the 20-digit number printed on the SIM card itself.

Configure the DXM Controller for a Cellular Modem
Use the DXM Configuration Software to create a configuration using a cellular connection.

IMPORTANT: Only the DXM100 and DXM150 models in conjunction with an SXI-LTE-001 (obsolete) cel-
lular modem can offer SMS/text messaging capabilities directly from the device. Contact a support spe-
cialist at Banner Engineering for configuration instructions, or SMS/text messaging can be delivered using
the Banner CDS web service from any DXM model.

1. Go to the Settings » Cloud Services screen.

2. Set the Push Interface to Cell
All push data will be sent using the cellular modem.

3. Go to the Settings » Cellular screen. Under the Cell Configuration section, select the Cell module from the drop-down
list.

> For the United States (contiguous)—For Verizon LTE/CATM modems, select SXI-LTE-001 or SXI-
CATM1VZW-001 and set the APN to vzwinternet.

o For North America—For ATT LTE/CATM modems, select SXI-CATM1ATT-001 and set
the APN to iot0119.com.attz. Requires a SIM module to be purchased from a wireless carrier based on the
IMEI number of the cellular modem. The wireless carrier will provide the APN parameters. Not all parameters
may be required.

> For regions outside of North America—Select SXI-CATM1WW-001 and set the APN to m2m.tele2.com when
using the SIM card provided with the kit from Banner Engineering. When using a local roaming SIM, please
use the APN as suggested by your cellular connectivity (SIM) provider.

4. To send data to the webserver, complete the parameters on the Settings » Cloud Services screen. Set the Cloud push
interval and the Web Server settings. (For more information, refer to the DXM Configuration Software Instruction Man-
ual (p/n 201127).
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The Settings » Cloud Services screen

File Traffic DXM Help

connecttoDxw JSystem |EEEEIP] Coliular | Etheret | Notifications | Logging | Scripting | Administration
[%] Snhow advanced settings
Local Regssers [t e T
posh mathog | & HITP Cloud Fusn Servername (1P [push. bannercds.com J| | AwsThing Endpoint  aws. com
ush methos _
- () AWS IoT Core Page | fpush.aspx
Register Mapping D
Push interface (Cell - ostheager [ ]
. Gateway IDis (GUID - Port 88835
Settings Cloud Push
Clear| 00000000-0000-0000-0000-000000000000 Print debug messages 1o serial console
Cloud pushiinterval |5 minutes - = 2
Push packe fomat (Defaut >
> | Custom HTTP Headers |
[1 Apply scale and ofiset o push data e Ghtos Cerificate File: [select
Rhloetr 1f 13 Inch : XML GUID in frst push
[x] Include in first pust Private Key File: Select
Push port s3] [¥] Include serial number in pushes
Root CAFile: Select
Etnemet refries per push interval 5 IOl ST L e
Include cell connection quality in pushes
[] Print push debug messages to serial console a s
[ omit push failures in logs
STT—— ‘Web Server Authentication
[ Require Authentication
Cartificate CN
Usemame
Password
‘Send Authentication

IMPORTANT: Banner Engineering offers several prepackaged solutions that report to the Banner Cloud
Data Services web-based software platform via cellular connectivity. Many of these solutions execute the
data push using a ScriptBasic file instead of the XML configuration file. If you are using a Banner prepack-
aged solution (ex. SOLUTIONSKIT9-VIBE), then you do not need to set the Cloud Push Interval on

the Settings » Cloud Services screen. You still need to set the Push Interface to Cell and select the ap-
propriate Cell Module and APN.

When the DXM is configured to use the cellular modem, the information on the cellular modem is found on the LCD menu un-
der System Info » Cell. The menu does not display values until a transaction with the wireless cell tower is complete.

The Settings > Cellular screen

System ] Cloud Services |e=IITEN

Notifications | Logging | Scripting | Administration

i [%] Show advanced settings
H cenl configuration Cell Software Firewall
| Cell module (SXI-LTE-001 1=J [ Enable software firewall
i *If there are no valid entri tion, the firewall
i| APN |vawinternet ‘ Reset s left open for that catego es
? Add | [ Remove |

| PN Usemame ‘ | lVF'hcne Number “ || ‘
i Open to all SMSs
|| APN Password ‘ | | IP Address || Add ‘!Remo\fe‘
: Spen to all IPs
{ Cell Connection Acquisition |Ema:m.aures; ||““d: | Remove
i Open to all Emails
;| Connection retry 5@
| Connection retry wait 00:00:10.000 [

Primary cell DNS IP address [0.0.00

Secondary cell DNS IP address \E)_O_l}_ﬂ

If there are no webserver parameters defined, the user must force a push to retrieve the data from the cellular network. On
the LCD menu, select Push > Trigger Data Push.

Obtaining LTE service outside of the Banner Cellular Data Plans—Customers have the option of securing a data plan for
the Verizon network themselves without using the Banner cellular data portal (celldata.bannercds.com). Suitable plans would
include those available from Verizon directly or from a Mobile Virtual Network Operator (MVNO) licensed to resell Verizon
network data plans. (The SXI-LTE-001 or SXI-CATM1VZW-001 will not function on AT&T, T-Mobile, or Sprint networks.)
When purchasing a data plan, it is important to refer to the modem by its official Verizon network name (for example, SEN-
SX002) and give the IMEI number (found on the cellular modem) to the plan provider. To use the SIM card that comes with
the cellular modem kit, give the SIM card number to the provider. The required SIM card form factor is 3FF - Micro.
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Chapter 7 LCD and Menu System

The LCD has four user-defined LED indicators, four control buttons, and an LCD. The four buttons control the menu system
on the LCD menu.

Top-level menu

Banner Eng 08:25:45
— Registers

a —Push S —0825:15 wll @
—ISM Radio

—1/O Board
— System Config
— System Info

The top-level menu always displays the time in a 24-hour format.
* The up and down arrows scroll through display items.
» The ENTER button selects the highlighted items on the display
» The BACK button returns to a previous menu option.

The left display column shows an arrow at the beginning of the line if the menu has submenus. The right column shows a
vertical line with an arrow at the bottom if the user can scroll down to see more menu items.

The DXM can be configured to require a passcode be entered before the LCD and Menu system will operate. The passcode
configuration is defined in the DXM Configuration Software.

Registers

The Registers submenu displays the processor's local registers that can be configured using the DXM Configuration Soft-
ware.

Registers menu
Registers—> List of Local Register

Values and the Register Name 6 0 to change the value
@ to accept
@ to return to the previous menu

To configure these local registers, launch the DXM Configuration Software. Go to Local Registers and expand the view for a
local register by clicking on the down arrow next to the register number. In the LCD Permissions field, select None, Read,
Write, or Read/Write.
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Read allows the register to be displayed and Write or Read/Write allows the register value to be changed using the LCD. The
Units and Scaling parameters are optional and affect the LCD.

Push

The Push menu displays information about the last data sent to the Webserver.

Push menu

Push —> Trigger Data Push——> Trigger Data Push

Status e
Time (hh:mm:ss)

to change the value

& to accept

to return to the previous menu

The user can force an immediate push to the webserver using Trigger Push. If a current push is in process it may take sever-
al minutes to complete over cellular.

* The Trigger Push submenu forces an immediate push to the web server.

» The status and time fields indicate the success or failure of the last attempted push and the time of the last attempted

push.

ISM Radio

The ISM Radio menu allows the user to view the Modbus ID of the internal ISM radio, enter binding mode, or run a site sur-
vey. This top-level ISM Radio menu is different from the System Config > ISM Radio submenu.

ISM Radio menu
ISM Radio—> MultiHop/DX80 ID

* a 0 to change the value

Binding —> Bindto>1
¢ a to accept
Site Survey —> Node/Modbus ID > 1 @ to return to the previous menu
Please Wait...

{

Site Survey results OR Failed to start Site Survey

The first option under the ISM Radio menu only displays the type of radio in the DXM (MultiHop or DX80 Star) and the Mod-
bus ID of the radio. To change the ISM Radio Modbus ID refer to the System menu.

Select Binding to enter binding mode or select Site Survey to run a site survey.

Binding— All ISM radio devices must be bound to the internal Gateway/client device before the DXM can access wireless de-
vices. The first submenu under binding allows the user to set the wireless address of the device to bind with. This is required
to bind with wireless devices that do not have rotary dials (for example M-GAGEs, ultrasonic sensors, and Q45 devices).

See "Binding and Conducting a Site Survey with the ISM Radio " on page 15. For more information on binding a particular
device, refer to the individual datasheet.

Site Survey—After creating a wireless network using the binding process, run a site survey on each device to see the link
quality. See "Conduct a Site Survey from the DXM" on page 17.
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IO Board

Use the I/0 Board menu to view input values, output values, input counters values, and the charger status on the DXM 1/O
board. To change the configuration parameters, use the System Config menu.

/0O Board menu

I/0 Board —> Inputs —> Input 1
Input 2
Input 3

Input 4

Outputs —> Output 1
Output 2
Output 3
Output 4
Output 5
Output 6

Counters—> Counter 1
Counter 2
Counter 3
Counter 4

Charger —> Supply (V)
Battery (V)

Charging (A)
Charge (%)

The I/O Board menu includes the following submenus.

Inputs
Lists the inputs. Depending upon the input type, the value and
unit's information will also be displayed.

Outputs

The DXM base configuration can include discrete, current, or
voltage outputs. The output values will be displayed based on
their configuration settings.

June 05, 2023

to change the value

8 to accept

to return to the previous menu

Counters

Counters on the DXM base board are associated to inputs but
the count value is stored in different register. Adjust or view
the count registers using the LCD menu.

Charger

The on-board solar/battery charger of the DXM stores infor-
mation about the charging circuit in Modbus registers. Use the
LCD menu to view information about the incoming voltage,
charging current, battery voltage, and battery charge percent-
age.
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System Config

Use the System Config menu to set DXM system parameters.

System Config menu

System Config—>ISM Radio —> DX80 ID: x —> New ISM Modbus ID: x
Auto Detect Radio ——> Radio Detected Type: DX80
ID: 1

Advanced Options ——> Ref Type: DX80
Ref Modbus ID: x
Max Node Count: xx —> New ISM Max Nodes: xx
Binding #: xxxxxx ~ —> New ISM Binding Code: xxxxxx
RF Ctrl: Dip 1.00W
I/O Board ——>~ Inputs —> Inputx —> InType:
Cnt Rise:
Cnt Fall:
Outputs —> Output x —> Default:
Type:
Voltage:
Counters
Charger —> Charger: DC

Ethernet ——> DHCP —> Update DHCP Mode  After making changes to the

P: —> Update IP Address Ethernet settings, restart the DXM.
SN: —> Update SN
GW: —> Update GW Address

Reset —> Resets Ethernet parameters
to xml defaults.

Provision Cell 0 o to change the value
DXM Modbus ID: xxx o

LCD Contrast: xx @ to accept

Restart
@ to return to the previous menu

ISM Radio

DX80/MultiHop ID—The ISM radio is set at the factory to be Modbus device address 1 (Modbus ID 1). For some applications,
you may need to change the Modbus ID. Adjust the Modbus device address using the LCD menu system. Any other method
may cause issues with the DXM not knowing which Modbus device address is assigned to the radio, which causes issues
with running Binding or Site Survey from the LCD menu.

Set the radio Modbus ID to a valid number (1 through 247) that is not being used by the DXM system. Processor Local Reg-
isters allocate ID 199, the 1/O board is set to ID 200, and the display board is set to ID 201. With a DX80 Gateway (star net-
work), it's easy to choose a new ID. With a MultiHop network, remember that the client MultiHop radio allocates a range of
Modbus IDs for wireless devices, typically 11 through 110.

When setting the new ISM Modbus ID, the system changes the Modbus ID on the internal radio and changes the reference to
it on the DXM. The reference Modbus ID is what the DXM uses to access the internal radio when running Binding or Site Sur-
vey.

Auto Detect Radio—If the internal Modbus ID of the radio was changed or the internal radio was changed, but not recorded,
use Auto Detect Radio to determine the radio ID and radio type. The auto-detect routine broadcasts discovery messages and
waits for a response. If other devices are connected to the external RS-485 ports, they may need to be disconnected for this
process to work properly.

Advanced Options—The Advanced Options menu is typically not used unless the Modbus ID is changed without the DXM be-
ing involved, such as when you write directly to the radio Modbus registers.

» Reference Type selects the radio type between DX80 star architecture radios and a MultiHop radio. The DXM uses
this reference to determine how to communicate to the internal radio. If set incorrectly, the DXM may not be able to
run Site Survey from the LCD menu. Unless you are changing or adding the internal radio device, there should no
reason to change the radio type.

» Reference Modbus ID defines the Modbus ID the DXM uses when communicating with the internal radio. If this is set
incorrectly, the DXM will not be able to run Binding or Site Survey through the LCD menu.

Max Node Count—Defines the maximum number of devices for the DX80 wireless network.
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Binding #—This parameter allows the user to define the Binding code within the ISM radio. Typically, you will not have to ad-
just this number unless you are replacing an existing Gateway or client radio.

RF Ctri—Displays the status of the ISM radio DIP switch 1 (off or on). The menu doesn't allow the user to change the DIP
switch setting through the display.

IO Board

Use the System Config » I/O Board submenu to change the configuration parameters for the inputs, outputs, counters, and
charger.

Use the Inputs menu to change the input type. The universal inputs on the DXM are defined from the factory as sinking in-
puts. To change the input type:

1. Go to the System Config » I/O Board > Inputs menu.

2. Select which input to change.

3. Select the input type. The available parameters include the Input Type and the Counter Edge Detect.

Input parameters
Input Type Description
Sinking Discrete input, low active, 0 = ON, 1 = OFF
Sourcing Discrete input, high active, 1 = ON, 0 = OFF
Current Analog input, 0-20 mA
Voltage Analog input, 0-10 V DC
Thermistor 2* Thermistor input, 10k - J (r-t curve), beta(K) 3890
Thermistor 1* Thermistor input, 10k - G (r-t curve), beta(K) 3575
Counter Description
In Type Sinking or sourcing
Cnt Rise Increment the count when the input transitions from 0 -> 1
Cnt Fall Increment the count when the input transitions from 1 -> 0

Use the Output menu to change the default condition, output type, and switched power voltage.

Output parameters
Output Type Description
Force output registers to a default condition if the /0O board has not been communicated with for a user-defined
Default . . L ) .
time period. The communications timeout parameter must be set to use the Default condition.
Type Select the output type: NMOS Sinking, Switch Power (Swch Pwr), Analog.
Voltage Outputs defined as switched power can adjust the voltage: 5V or 16 V

Use the Charger menu to change the charging algorithm for the battery. This parameter can also be set by writing Modbus
register 6071 of the 1/0O board. See "Supplying Power from a Solar Panel" on page 36.

Charger parameters
Charger Parameters Description
DC Used when 12-24 V DC power supplies connected to the DXM power pins and the attached batteries are used as
backup batteries. This limits the current during the battery charging process. (factory default setting)
Solar Select Solar when a solar panel is connected to the power pins of the DXM. Solar panels are current limited by

their design and therefore can charge the battery without managing the input power.
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Ethernet

Use the Ethernet submenu to sets the IP Address, Gateway Address, and Subnet mask of the DXM's Ethernet interface. You
may change these settings either from the LCD menu (System Config » Ethernet) or from the XML configuration file created
by the DXM Configuration Software.

The network address settings from the LCD menu have the highest priority and override settings in the XML configuration file.
To use the parameter settings from the XML configuration file or use DHCP, execute the Reset under System Config » Ether-
net or use the LCD display to set the IP Address, Gateway Address, and Subnet Mask to 255.255.255.255. Reboot

the DXM after changing the Ethernet parameters.

The Ethernet cable should be attached before powering up the DXM.

Provision Cell

If the DXM has a cellular modem installed, the modem must be provisioned on the network. This menu provisions the cellular
modem on the network. For step by step directions, see "Using the DXM Cellular Modem" on page 44.

DXM Modbus ID

Use the secondary Modbus RS-485 port when the DXM is connected to a Modbus RTU network as a Modbus server device.
Set the Modbus ID for the secondary RS-485 port using the LCD display menu System Config » DXM Modbus ID.

LCD Contrast

Use the LCD Contrast option to adjust the LCD contrast. Adjust the starting number lower to decrease the display contrast.
The factory default is 28. Do not set a number less than 15 or the display may not be bright enough to see to change back.

Reset

Use the Restart menu to force the main processor to restart. This does not affect the other boards in the system.

© Banner Engineering Corp. June 05, 2023



System Info

DXM150-Bx And 1500-Bx Wireless Controller Instruction Manual

Various DXM system settings are shown in this menu. The Push, Ethernet, and Cell parameters are helpful for debugging

network connections. This is a read only menu.

Controller

System Info

Push ——

ISM Radio —

10 Board —

Ethernet —

Cell ——

System Info menu

Date:
Firmware:
Build:
Model:
Serial:

Method:
Interval: hh:mm
URL:

Page:

Https: on/off
Site ID:

Serial:
Model:
Date:

RF FW Pt:
RF FW Ver:
RF EE Pt:
RF EE Ver:

Serial:
Model:
Date:

RF FW Pt:
RF FW Ver:
RF EE Pt:
RF EE Ver:

DHCP:
IP:
Subnet:
Gate:
Mac:
DNS1:
DNS2:

Signal:
Phn#:
Dev#:
SIM:
CellVer:
CellMdI:
CellFw:
CellMask:

to change the value

to accept

to return to the previous menu

IP:
Mode:
AP:
Stat:
Path:
Baud:
Code:

Serial:
Model:
Date:

RF FW Pt:
RF FW Ver:
RF EE Pt:
RF EE Ver:

LCD Board —

Cell

Shows the cellular MEID number (Mobil Equipment Identifier),
MDN (Mobil Device Number), version, signal, firewall setting,
and firewall mask. Some of these parameters are not visible

ISM Radio

Displays the serial number, model, date, firmware part num-
bers, and version numbers.

LCD Board

until the cellular network is accessed. 4 ) .
Displays the serial number, model, date, firmware part num-

Controller bers, and version numbers.
Displays the date, build, model, and serial number.
Push
Ethernet Shows the current parameters loaded from the XML configu-

Displays the IP address, MAC address, DHCP, Gateway ad-
dress, and DNS settings.
1/0 Board

Displays the serial number, model, date, firmware part num-
bers, and version numbers.

ration that applies to pushing data to a webserver, including
method (Ethernet or cellular), interval, URL, page, HTTPS,
and site ID.

Sript
Displays the name of the ScriptBasic file running.

Wifi
Displays the Wifi IP address and other settings.
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Display Lock

Display Lock protects the DXM LCD menu system from being used until the proper pass code is entered.

Display Lock menu

Display Lock — Enter password

o e

to change the value

3 to accept

to return to the previous menu

The display lock feature uses the configuration software to set a passcode within the DXM. A valid passcode is 1 to 9 digits
long and uses numbers 0 through 9. For example, 1234 or 209384754.
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Chapter 8 Configuration Instructions

DXM Configuration Software

Download the latest version of all configuration software from http://www.bannerengineering.com. For more information on
using the DXM Configuration Software, refer to the instruction manual (p/n 209933).

Overview of the configuration software features

DXM Configuration Software

Local Registers

Register Mapping

Action Rules

Scheduler

ScriptBasic

System Register
Settings View Utility
USB
=
XML Config File
Ethernet

The configuration software configures the DXM by creating an XML file that is transferred to the DXM using a USB or Ether-
net connection. The DXM can also receive the XML configuration file from a Web server using a cellular or Ethernet connec-
tion.

This configuration file governs all aspects of the DXM operation.

The wireless network devices are a separate configurable system. Use the DX80 User Configuration Software to configure
the internal DX80 wireless Gateway and the attached wireless Nodes. Use the MultiHop Configuration Software if the internal
radio is a MultiHop device.

All tools can be connected to the DXM using a USB cable or an Ethernet connection.
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Register Flow and Configuration

The DXM register data flow goes through the Local Registers, which are data storage elements that reside within the proces-
sor. Using the DXM Configuration Software, the controller can be programmed to move register data from the Local Register
pool to remote devices, the internal radio, the 1/0 base (if applicable), or the display.

Register flow

Processor

A

A

Local
Registers

Ethernet/USB/Cellular

SN
= - =

Basic Approach to Configuration
When programming an application in the DXM, first plan the overall data structure of the Local Registers. The Local Regis-
ters are the main storage elements in the DXM. Everything goes into or out of the Local Registers.

Remote Devices

1. In the DXM Configuration Software, name the Local Registers to provide the beginning structure of the application.

2. Configure the read/write rules to move the data. The Read/Write rules are simple rules that move data between de-
vices (Nodes, Modbus servers, sensors, etc) and the Local Registers.

3. Most applications require the ability to manipulate the Local Register data, not just move data around. Use the Action
rules to make decisions or transform the data after the data is in the Local Registers. Action rules can apply many dif-
ferent functions to the Local Register data, including conditional statements, math operations, copy operations, or
trending.

4. To perform scheduled events in Local Registers, go to the Scheduler screen in the DXM Configuration Software.
These rules provide the ability to create register events by days of the week. The scheduler can also create events
based on sunrise or sunset.

Troubleshooting a Configuration

View Local Registers using the Local Registers » Local Registers in Use screen of the DXM Configuration Software.

When a configuration is running on the DXM, viewing the Local Registers can help you to understand the application's opera-
tion. This utility can also access data from remote devices.

To configure the Local Register data to display on the LCD menu, go to the Local Registers screen, set the LCD permis-
sions to read or read/write.

Saving and Loading Configuration Files
The DXM Configuration Software saves its configuration information in a XML file. Use the File menu to Save or Load config-
uration files.

Save the configuration file before attempting to upload the configuration to the DXM. The DXM Configuration Software up-
loads the configuration file saved on the PC to the DXM; it will not send the configuration loaded in the tool.
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Uploading or Downloading Configuration Files

The DXM requires a XML configuration file to become operational. To upload or download configuration files, connect a com-
puter to the DXM using the USB port or Ethernet port. Then use the Upload Configuration to Device or Download Configura-
tion from Device under the Device menu.

Scheduler

Use the Scheduler screens to create a calendar schedule for local register changes, including defining the days of the week,
start time, stop time, and register values.

Schedules are stored in the XML configuration file, which is loaded to the DXM. Reboot the DXM to activate a new sched-
ule.

If power is cycled to the DXM in the middle of a schedule, the DXM looks at all events scheduled that day and processes the
last event before the current time.

For screens that contain tables with rows, click on any row to select it. Then click Clone or Delete to copy/paste or remove
that row.

Create a Weekly Event

Use the Scheduler » Weekly Events screen to define weekly events.

Scheduler > Weekly Events screen

| Add Weekly Event| | Clone Last Event| | Delete Last Event|

o Rogster [EEIES Nove actve s (] @M EBEN  san 1 =t 220000
Attive Holidays Available Holidays
Stant Value 118] startat: (Specific Time | ~ | | 22:00 ] 24 hour format e
[] Endvae | 075 Endat (Specific Time | = | | 00.01 5] 24 hour format Remove

(~) [waekly Event 2 Ragister| 20| None Active days @@@@B Start 0 at 02:00:00

Holidays
Active Holidays Available Holidays
Start Value 0f8] startat: (Specific Time | ~ | | 02:00 [ 24 hour format Add
(=
[JiEndvawe| 075 Endat (Speciic Time | = | [ 00:01 5] 24 hour format Remove

1. Click Add Weekly Event.
A new schedule rule is created.

2. Click on the arrow to the left of the new rule to expand the parameters into view.
The user-defined parameters are displayed.

. Name your new rule.

. Enter the local register.

. Select the days of the week this rule applies to.

. Enter the starting value for the local register.

. Use the drop-down list to select the type of Start at time: a specific time or a relative time.
. Enter the starting time.

. Enter the end time and end value for the local register.

© o N O~ W

Register updates can be changed up to two times per day for each rule. Each rule can be set for any number of days in the
week by clicking the buttons M, T, W, Th, F, S, or Su.

If two register changes are defined for a day, define the start time to be before the end time. Select End Value to enable the
second event in a 24 hour period. To span across two days (crossing the midnight boundary), set the start value in the first
day, without selecting End Value. Use the next day to create the final register state.

Start and end times can be specified relative to sunrise and sunset, or set to a specific time within a 24 hour period. When
using sunrise or sunset times, set the GPS coordinates on the device so it can calculate sunrise and sunset.

June 05, 2023 © Banner Engineering Corp.



DXM150-Bx And 1500-Bx Wireless Controller Instruction Manual

Create a One-Time Event

Define one-time events to update registers at any time within a calendar year.

Similar to Weekly events, the times can be specific or relative to sunrise or sunset. Define one-time events using the Sched-
uler > One Time Events screen.

Scheduler > One Time Events screen

| Add One-Time Event| | Clone Last Event] | Delete Last Event

| (=) [Specaisale | | Register Number | 21[2] None Start 1 at 02/19/2019 DAWN-G0 End 0 at 0211972019 DUSK+720
Star Value 1@ Statat |Relative Time | = Tuesday, February 19, 20\9@:5 o DO@ HH:mm |Before | = | |Sunrise | =
[¥] End Value 0 E End at ﬁmalwe anna_; Tuesday, February 19, 2019 @ v: 12:00 % HHmm (Afler |~ \S_unsel_ =)

1. Click on Add One Time Event.
A new one-time event is created.

2. Click on the arrow to expand the parameters into view.
The user-defined parameters are displayed.

. Name your one-time event by clicking on the name link and entering a name.
. Enter the local register.

. Enter the starting time, date, and starting value for the local register.

. Enter the ending time, date, and ending value for the local register.

(o200 6) I SN

Create a Holiday Event
Use the Scheduler > Holidays screen to create date and/or time ranges that interrupt weekly events.

Scheduler > Holidays screen

| Add Holiday | | Clone Selected Holiday | | Delete Selected Holiday |

New Holiday Tuesday, February 19, 2019, 00: E)OEZ Tuesday, February 19, 2019, 00:01 @?|

1. Click on Add Holiday.
A new rule is created.

2. Enter a name your new holiday rule.
3. Select the start date and time for the new holiday.
4. Select the stop date and time for the new holiday.

Authentication Setup

The DXM has three different areas that can be configured to require a login and password authentication.
* Webserver/ Cloud Services Authentication
* Mail Server Authentication
» DXM Configuration Authentication

The webserver and mail server authentication depends upon the service provider.

Set the Controller to use Authentication
The DXM can be configured to send login and password credentials for every HTTP packet sent to the webserver. This pro-
vides another layer of security for the webserver data.

Configuration requires both the webserver and the DXM to be given the same credentials for the login and password. The
webserver authentication username and password are not stored in the XML configuration file and must be stored in
the DXM.

1. From within the DXM Configuration Software, go to the Settings » Cloud Services screen.
2. In the upper right, select Show advanced settings.
3. Define the username and password in the Web Server Authentication section of the screen.
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Web Server Authentication screen

Webserver Authentication
e

Usemame: | |

Password: | |

Send Authentication

The first time you select Require Authentication, a pop-up box appears with additional instructions. Since the data is
not stored in the XML configuration file, it is hidden from view of the DXM Configuration Software.

4. Click on Send Authentication.
The controller must be connected to the PC for this operation to succeed.
The data transmits directly to the DXM's non-volatile memory. If successful, a pop-up window appears, asking to re-
boot the device.

5. Select Yes to reboot the device.

Controller Configuration Authentication
The DXM can be programmed to allow changes to the configuration files only with proper authentication by setting up a pass-
word on the Settings > Administration screen in the DXM Configuration Software.

With the DXM connected to the PC, click Get Device Status. The DXM status displays next to the button.

Settings > Administration screen
[ File Protection User Notes.

s | Unknown
Current admin password
Action |SetiChange admin password | ~

New admin password

Verify new password

LCD passcode 15

Characters remaining: 4096

Use the DXM Configuration Software to:
» Set the Admin Password
» Change the Admin Password
* Remove the Admin Password

To change or remove an admin password, the current password must be supplied. The DXM must be connected to the PC to
change the administration password.

The DXM can be unlocked without knowing the administration password, but doing this erases the configuration program,
logging files, and any ScriptBasic program on the device. For instructions on how to do this, see the "Additional Information "
on page 69 section.

EtherNetIP Configuration

The DXM is defined from the factory to send/receive register data from the Gateway and the first 16 Nodes with an EtherNet/
IP™ host.

To expand the number devices going to Ethernet/IP, change the Devices in system parameter in the DX80 Gateway (default
setting is 8) to 32. To change this value:

1. Launch the the DX80 Configuration Software.
2. In the menu bar, go to Device » Connection Settings and select Serial or Ethernet DXM.

() EttherNet/IP is a trademark of Rockwell Automation.
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3. In the Configuration » Device Configuration screen, click on the arrow next to the Gateway to expand and display the
Gateway's parameters.
4. In the System section, use the Devices in system drop-down list to make your selection.

This allows the user to maximize the use of the EtherNet/IP buffer to 28 devices.

EDS (Electronic Data Sheet) files allow users of the EtherNet/IP protocol to easily add a Banner DXM device to the PLC.
Download the EDS files from the Banner website.
« DXM EDS Configuration File (for PLCs) (p/n b_4205242)
« DXM EIP Config File for DXM Controller with Internal Gateway (Models: DXM1xx-BxR1, DXM1xx-BxR3, and
DXM1xx-BxCxR1) (p/n 194730)

Download an Existing Configuration from the DXM
If you have an existing configuration file, save the XML file locally as a backup on your computer.

1. Apply power to the DXM.

2. Connect an ethernet or USB cable between your computer and the DXM.

3. Launch the DXM Configuration Software v4 and select your DXM model.

4. On the Device » Connection Settings menu, select one of the following:
o Select TCP/IP as the connection type and enter the IP Address of the DXM Controller; or
o Select Serial as the connection type and select the appropriate Comm port

5. On the menu bar, select Device » Get XML configuration from DXM to download the XML configuration file.
6. Save the XML file locally on your computer.

Configuring the Controller

Use the configuration software to define the Protocol conversion for each local register to be EIP Originator » DXM or EIP
DXM > Originator from the Edit Register or Modify Multiple Register screens.

Define a DXM local register as EIP Originator » DXM when the host PLC (Originator) will send data to the DXM local register
(DXM).

Define a DXM local register as EIP DXM > Originator when that register data will be sent from the DXM (DXM) to the host
PLC (Originator).

Data from an EIP controller in assembly instance 112 is data destined for the DXM local registers. The PLC is normally con-
figured for INT or UINT data transfer. This allows for a seamless transfer of data.

EIP Assembly Instance 112 (16-bit) DXM Local Registers
Adrs Data Adrs Data
0 1122 1 1122
1 3344 2 3344
2 5566 3 5566
3 7788 4 7788
4 9900 5 9900

Data from the DXM local registers is sent to the EIP controller using assembly instance 100. Each local register in

the DXM defined as EIP DXM > Originator is collected in numerical order and placed into the data buffer destined for assem-
bly instance 100. DXM local registers are capable of 32-bits, but only the lower 2-bytes (16-bits) for each local register are
transferred.
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EIP Assembly Instance 100 (16-bit) DXM Local Registers
Adrs Data Adrs Data
0 1122 11 1122
1 3344 12 3344
2 5566 13 5566
3 7788 14 7788
4 9900 15 9900

Configure Local Registers to Export Data to a PLC

1. On the DXM Configuration Software: Go to the Local Registers screen.

2. Select the register(s) that will be exported to a Host PLC.
A maximum of 228 registers can be read or written with Ethernet/IP.

3. In the Storage/Connectivity section, select EIP DXM -> Originator from the Protocol conversion drop-down list.
To change a block of continuous local registers, use the Modify Multiple Registers screen.

Configure Local Registers to Import Data from a PLC

1. On the DXM Configuration Software: Go to the Local Registers screen.

2. Select the register(s) that will be imported from a Host PLC.
A maximum of 228 registers can be read or written with Ethernet/IP.

3. In the Storage/Connectivity section, select EIP Originator -> DXM from the Protocol conversion drop-down list.
To change a block of continuous local registers, use the Modify Multiple Registers screen.

To view the EIP Input and Output registers, go to the Tools > Protocol Conversion screen. You may also export the register
map to a CSV file.

Save and Upload the Configuration File
After making any changes to the configuration, you must save the configuration files to your computer, then upload it to the
device.

Changes to the XML file are not automatically saved. Save your configuration file before exiting the tool and before sending
the XML file to the device to avoid losing data. If you select DXM > Send XML Configuration to DXM before saving the con-
figuration file, the software will prompt you to choose between saving the file or continuing without saving the file.

1. Save the XML configuration file to your hard drive by going to the File > Save As menu.
2. Go to the DXM » Send XML Configuration to DXM menu.

Status indicator bar

Connected 192.168.0.1 VibelQ_DXR0_V2.xml Application Status

Connected 192.168.0.1 VibelQ_DXR90_V2.xm| Application Status @

Not Connected VibelQ_DXR90_V2.xmil Application Status

o If the Application Status indicator is red, close and restart the DXM Configuration Tool, unplug and re-plug in
the cable and reconnect the DXM to the software.

o If the Application Status indicator is green, the file upload is complete.
o If the Application Status indicator is gray and the green status bar is in motion, the file transfer is in progress.
After the file transfer is complete, the device reboots and begins running the new configuration.

Configuring the Host PLC

On the host PLC, install the DXM using an EDS file or by using the following parameters:
» Assembly1: Originator to DXM = Instance 112, 456 bytes (228 words)
» Assembly2: DXM to Originator = Instance 100, 456 bytes (228 words)

The Originator is the host PLC system, and the DXM is the DXM. The host system sees the DXM as a generic device with
the product name of Banner DXM (ProdType: 43 - Generic Device, ProdName: Banner DXM, Integer Type - INT).
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IMPORTANT: Do not set the Requested Packet Interval (RPI) any faster than 150 ms.

Document title: Configuring the DXM for EitherNet/IP Quick Start Guide
Part number: b_5915056

Revision: B

© Banner Engineering Corp. All rights reserved.

Define the Network Interface Settings

On the Cloud Services screen (shown with Show advanced settings selected), define the network connection settings by se-
lecting Ethernet or Cell from the Network Interface drop-down list. This determines how the DXM sends data.

If you don't require pushing data to a web server, set the Cloud Push interval to zero.

Cloud Services screen

(5] Show advanced settng:

m _ — VS loT Core

@ HTTP Clond Push Server name /1P | push bannencds. com JOVE Thing Enod
Puih metnod
|Cawsureme | Page Toush asen
Push ivertace |Exeenst | =) bl
I _ [ommmion g0 ) pon [ ss11E]

i e i omn B |Clom| | DOODG0- 000 D00 D00 DONON000000 Pt diobesg mustsnes 1o enal comai
Puth packet format | Detauat -
[0 Appiy scaie and oftset 10 push data

Sampls count 14

L= | Cutom HTTP Hesders

-Push Optioens.

(] inciuge XML GUID in frst puth.

Puthport @] =] inchude serial rumbe in puthes
L A Fie | Sawect

Etmemat retnes per push interval S[5] | || D tnckse medel rmter i pushes =]

[l inciuce cull connacson qualty In pushas

(] Print pussh debrug mas1a08s 82 serial console
L ||| []0ma push tadures inlogs
HITPS

Qiweiarse
Carticas O [Elsaie slmaticator

| Sena Autherseason

Configure your Ethernet Connection
When selecting Ethernet, go to the Settings » Ethernet screen.

1. To define the Ethernet IP address, give the DXM a static IP address. In most cases you may select the device to use
DHCP and have the IP address automatically assigned.

2. DNS settings are not typically required. The DXM uses a public service to resolve Domain names, but if the network
connection does not have Internet access, the DNS settings may be required.

Settings > Ethernet screen

System || Cloud Services JiSuEnE4el Notifications | Logging | Scripting | Administration

[%] Show advanced settings
IP Address 0.0.0.0 DHCP -
Subnet 0.0.0.0
IP address 0.0.0.0
Gateway address 0.0.0.0
Device MAC 00:00:00:00:00:00 | | Subnet TR
|Gel Settings from Devloe‘ Gateway address 0000
UDP Console Ethemet DNS
] Enable UDP console Primary DNS IP address |0.0.0.0
Secondary DNS IP address [0.0.00 |
[] Enable Profinet
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Configure your Cellular Connection

To use a cellular connection, select Cell as the network connection on the Settings » Cloud Services screen (see "Configure
the DXM Controller for a Cellular Modem " on page 48). The Cellular screen does not display unless the Network interface is
set to Cell.

Using a 4G LTE cell module requires a cellular plan; follow the instructions on p/n 205026 to activate a cell modem.

1. On the Settings » Cellular screen, select your cellular modem from the drop-down list.
2. Set the APN.
o If you are using a Banner 4G LTE-M Verizon Module (ME910C1), set the APN to vzwinternet.
o If you are using a Banner 4G LTE AT&T Module (ME910C1), set the APN to 1i0t0119.com.attz.
o If you are using a Banner 4G LTE-M/NB-loT Worldwide Module (ME910G1), set
the APN to m2m. tele2.com.
o If you are using a third-party SIM card, the APN, APN Username, and Password must be provided by the cel-
lular service provider.

Ethernet and Cellular Push Retries

The DXM can be configured to send register data packets to a webserver. When the Ethernet or cell communications path is
not operating, the DXM retries the send procedure. The communications retry process is outlined below for each configura-
tion.

Regardless of the communications type (Ethernet or cellular), a failed attempt results in the register data packet being saved
on the local micro SD card". The number of retries will depend upon the network connection type.

When there is bad cellular signal strength or there is no Ethernet connection, the transmission attempts are not counted as
failed attempts to send data. Only when there is a good network connection and there are 10 failed attempts will the con-
troller archive the data on the SD card. Data archived on the SD card must be manually retrieved.

Ethernet Push Retries

With an Ethernet-based network connection, the DXM retries a message five times. The five retry attempts immediately fol-
low each other. After all attempts are exhausted, the register data packet is saved on the micro SD card.

At the next scheduled time, the DXM attempts to send the saved packet as well as the newly created register data packet. If
it cannot send the new register data packet, the new register data packet is appended to the saved file on the micro SD card
to be sent later. After 10 rounds of retries, the data set is archived on the micro SD card under folder _sxi. No additional at-
tempts to resend the data are made; the data file must be manually retrieved.

Using SSL on Ethernet will have no retries, but will save each failed attempt to the micro SD card until 10 failed rounds. At
this time, the register data packet is archived.

Cellular Push Retries

In a cellular-connected system there are no retries. Failed transmissions are saved on the micro SD card.

After 10 successive failed attempts, the data is archived in the _sxi folder. Send attempts with a low signal quality are not
counted against the 10-count limit. For example, if the cellular antenna is disconnected for period that the DXM controller
would have sent 20 messages under normal circumstances, all 20 messages would be saved and will be retried when the
antenna is reconnected. If the signal quality was good, but the cellular network was not responding, the DXM archives the
register data packets after 10 failed attempts.

Event/Action Rule or Log File Push Retries

Event-based pushes caused by Action rules follow the same process when failures occur, based on the network connection.
The failed Event-based messages are resent with the next cyclical schedule or the next event message that triggers a push
message.

() Enable HTTP logging to save data on the SD card; this is the factory default. See SETTINGS -> LOGGING in the DXM Configuration Tool.
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Chapter 9 Additional Information

Working with Modbus Devices

The DXM has two physical RS-485 connections using Modbus RTU protocol.

The DXM can be a Modbus RTU client device to other server devices and can be a Modbus server device to another Modbus
RTU client. The DXM uses the primary RS-485 port (M+/M-) as a Modbus RTU client to control external server devices. All
wired devices connected to the client RS-485 port must be server devices.

* As a Modbus RTU client device, the DXM controls the external server connected to the primary RS-485 port, the local
ISM radio, the local I/O base board, and the local display board.

* As a Modbus RTU server device, the DXM local registers can be read from or written to by another Modbus RTU
client device.

The secondary port (S+/S-) is the Modbus RTU server connection. The secondary (server) Modbus RS-485 port (S+/S-) is
controlled by another Modbus client device, not the DXM. The server port is used by an external Modbus client device that
will access the DXM as a Modbus server device.

Processor Modbus system overview

Ethernet &——1>
Processor Modbus

Modbus RS-485 «——————| Control/Data
(server port)

7} 4 Modbus RS-485
i (client port) External
P Modbus
il Servers (2-10)
chal ISM Displa I/O Ba
Registers Radio play Board
\_ J

The DXM has dual Modbus roles: a Modbus server device and a Modbus client device. These run as separate processes.

The Modbus server port can only access the DXM local registers. To operate as a Modbus server device, the DXM needs to
be assigned a unique Modbus ID as it pertains to the host Modbus network. This ID is separate from the internal Modbus IDs
the DXM uses for its own Modbus network. The DXM Modbus ID is defined through the LCD menu. Other Modbus server
port parameters are defined by using the configuration software.

The DXM operates the Modbus client port. Each device on the client port must be assigned a unique Modbus ID. There are
Modbus IDs that are reserved for internal devices in the DXM.
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DXM Internal Modbus IDs (factory default)

Modbus ID Device
1 DX80 Performance Gateway or MultilHop ISM Radio—MultiHop wireless devices connected to the internal MultiHop radio
should be assigned Modbus IDs starting at 11.
199 Local Registers—Internal storage registers of the DXM
200 1/0 Base Board—All data and parameters for each input or output of the DXM.
201 LCD Display—The user has access to the LED indicators on the DXM.

Assigning Modbus IDs

Assign the DXM Modbus ID only if a Modbus client device is reading or writing the DXM Local Register data through the
Modbus RS-485 server port (S+, S-).

Set the DXM ID from the LCD menu under System > DXM Server ID. The DXM can have any unique ID between 1 and 246,
depending upon the host Modbus network. Other RS-485 server port parameters are set in the configuration software under
the Settings » General tab.

DXM Client Configuration—When the DXM operates as a Modbus client device, use the configuration software to configure
read or write operations of the DXM Modbus network. The DXM communicates with all internal and external peripheral de-
vices using the external Modbus bus RS-485 (M+, M-)

There are four internal Modbus server devices that are configured from the factory with Modbus IDs. Assign IDs 2 through 10
to Modbus server devices that are physically wired to the DXM. Assign IDs 11 through 60 to wireless server within the Multi-
Hop network.

Do not assign an ID of greater than 10 to Modbus server devices that are physically wired using the RS-485 port if there is an
internal MultiHop ISM radio in the DXM. The MultiHop ISM radio attempts to send any Modbus data intended for IDs 11
through 60 across the radio network, which conflicts with wired server devices if the IDs overlap. The MultiHop client radio
can be changed from the factory default of 11 through 60 Modbus IDs if more hardwired servers are required.

Wireless and Wired Devices

Wireless DX80 Gateway—The DX80 Gateway architecture is a star architecture in which all Nodes in the system send their
data back to the Gateway. The host can access the entire network data from the Gateway, which is Modbus ID 1. Because
the DXM will not be sending any Modbus messages across the wireless link, the timeout parameter can be set low (less than
1 second) and the device is treated like a directly connected device.

MultiHop Client—The MultiHop client radio forms a wireless tree network using repeaters and servers. Each device in a Multi-
Hop network must be assigned a unique Modbus ID and is accessed as a separate device. For the DXM to talk with a Multi-
Hop device in the wireless network, the client MultiHop device interrogates every message on the RS-485 bus. If they are
within the wireless devices range (IDs 11 though 60), the message is sent across the wireless network. To change this range,
the user must adjust the offset and range setting in the MultiHop client radio (Modbus ID 1). Modbus register 6502 holds the
Modbus offset, default 11. Modbus register 6503 holds the number of Modbus server allowed (maximum of 100).

Modbus IDs for wireless and wired devices

Modbus ID Description
1 Allocated for the internal ISM radio device, either a DX80 Gateway or MultiHop client radio
2-10 Server addresses available for directly connected Modbus server devices to the client RS485 port (M+ , M-)
11-60 Allocated for wireless MultiHop radio network devices. If there is not an internal MultiHop in the DXM, these server addresses are

available to use for directly connected devices.

Available to users for direct connected Modbus server devices or the expansion of the wireless network server IDs to go past 50

61-198 wireless devices.

199 Allocated for internal Local Register

200 Allocated for the I/O base board; will be different for special DXM server-only models.
201 Allocated for the LCD display board, the user can read/write LEDs.
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Modbus Communication Timeouts

A Modbus timeout is the amount of time a Modbus server is given to return an acknowledgment of a message sent by the
Modbus client. If the Modbus client waits for the timeout period and no response is seen, the Modbus client considers it a lost
message and continues on to the next operation.

The timeout parameter is simple to set for Modbus devices directly connected to the DXM, if there are no MultiHop wireless
devices. Special considerations need to be made to set the timeout parameter when a MultiHop network uses the DXM as
the client radio.

Configure controllers operating wireless networks to allow for enough time for hardware transmission retries. Set the Commu-
nications Timeout parameter to cover the expected time for messages to be sent throughout the wireless network. For

the DXM, the Communications Timeout parameter is the maximum amount of time the DXM should wait after a request is
sent until the response message is received from the Modbus server device. Use the DXM Configuration Software to set the
timeout parameter on the Settings » System screen (select Show advanced settings).

The default setting for the timeout parameter is 5 seconds.

MultiHop Networks vs DX80 Star Networks

The DX80 star Gateway collects all the data from the Nodes, which allows the host system to directly read the data from the
Gateway without sending messages across the wireless network. This allows for DX80 Gateway to be treated like any other
wired Modbus device.

In a MultiHop network, the data resides at each device, forcing the controller to send messages across the wireless network
to access the data. For this reason, carefully consider the value of the wireless timeout parameter.

Calculating the Communications Timeout for Battery-Powered MultiHop Radios

Battery-powered MultiHop radios are configured to run efficiently to maximize battery life. By optimizing battery life, the al-
lowed communications window to receive messages is slow (once per 1.3 seconds) and sending message rates are standard
(once per 0.04 seconds).

A MultiHop device is set from the factory with the retry parameter of 8. This means that under worst-case conditions, a mes-
sage is sent from the DXM to an end device a total of nine times (one initial message and eight retry messages). The end de-
vice sends the acknowledgment message back to the DXM a maximum of nine times (one initial message and eight retries).
A single Modbus transaction may send up to two messages + 16 retry messages before the transaction is complete. In addi-
tion, the radios randomly wait up to one time period before retransmitting a retry message. So to allow for the random wait
time, add one extra time period for each in-between time of retries.

To calculate the communication timeout parameter for a client to a server radio (no repeaters):

Client to Server Send time = (9 x 1.3 sec) + (8 retry wait x 1.3 sec) = 22 seconds

Server to Client Send time = (9 x 0.04 sec) + (8 retry wait x 0.04 sec) = 1 second

Total Send/Receive time = 23 seconds

Minimum Timeout period = 23 seconds
If the link quality of the network is poor, the maximum transfer times may happen. Set the timeout parameter to accommodate
the maximum number of retries that may happen in your application.

When MultiHop repeaters are added to the wireless network, each additional level of hierarchical network increases the re-
quired timeout period. Since MultiHop repeaters are running at the highest communications rate, the overall effect is not as
great.

Client to Repeater Send time = (9 x 0.04 sec) + (8 retry wait x 0.04 sec) = 1 second

Repeater to Client Send time = (9 x 0.04 sec) + (8 retry wait x 0.04 sec) = 1 second

Additional Timeout period for a repeater = 2 seconds
Using the timeout calculation above of 23 seconds, if a repeater is added to the network the timeout should be set to 25 sec-
onds. For each additional MultiHop repeater device creating another level of network hierarchy, add an additional two sec-
onds to the timeout period.

Calculating the Communication Timeout for 10-30 VDC MultiHop Radios
Line-powered (10-30 V DC) MultiHop devices operate at the maximum communication rate, resulting in a much lower time-
out parameter setting. For each repeater added to the network, increase the timeout parameter 2 seconds.

For a client radio to a 10-30 V DC powered server radio (no repeaters):
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Client to Server Send time = (9 x 0.04 sec) + (8 retry wait x 0.04 sec) = 1 second
Server to Client Send time = (9 x* 0.04 sec) + (8 retry wait x 0.04 sec) = 1 second
Total send/receive time = 2 seconds

Minimum timeout period = 2 seconds

Adjusting the Receive Slots and Retry Count Parameters
The number of receive slots governs how often a MultiHop device can communicate on the wireless network.

Battery-powered devices typically have DIP switches that allow the user to set the number of receive slots, which directly af-
fects the battery life of the radio. Adjusting the receive slots changes how often a message can be received. By default, the
receive slots are set to 4 (every 1.3 seconds). When the receive slots are set to 32, the radio listens for an incoming message
every 0.16 seconds.

Users may also leave the retry mechanism to the application that is accessing the wireless network, in this case the DXM.
Adjust the number of retries in the MultiHop devices by writing the number of retries desired to Modbus register 6012. The
factory default setting is 8.

Calculating the Communication Timeout for a DX80 Star Network
In the DX80 network, all Node data is automatically collected at the Gateway to be read. The DXM does not use the wireless
network to access the data, which allows for much faster messaging and much lower timeout values.

For a DXM with an internal DX80 Gateway, set the timeout value 0.5 seconds. If other Modbus devices are connected to the
RS-485 lines, the timeout parameter governs all communication transactions and must be set to accommodate all devices on
the bus.

Modbus TCP Client

The DXM can operate as a Modbus TCP client on Ethernet. Users may define up to five socket connections for Modbus TCP
server devices to read Modbus register data over Ethernet. Use the DXM Configuration Software to define and configure
Modbus TCP client communications with other Modbus TCP servers.

Modbus Register Summary
DXM Modbus Registers

The DXM may have up to four internal Modbus server devices.

All Modbus registers are defined as 16-bit Modbus Holding Registers. When connecting external Modbus server devices, on-
ly use Modbus IDs 2 through 198. The local registers, the I/O base, and the LCD IDs are fixed, but the internal radio ID can
be changed if needed.

DXM Internal Modbus IDs (factory default)

Modbus ID Device

DX80 Performance Gateway or MultiHop ISM Radio—MultiHop wireless devices connected to the internal MultiHop radio

1 should be assigned Modbus IDs starting at 11.

199 Local Registers—Internal storage registers of the DXM
200 1/0 Base Board—All data and parameters for each input or output of the DXM.
201 LCD Display—The user has access to the LED indicators on the DXM.

Modbus Registers for the MultiHop Radio Board Module

The DX80 MultiHop client radio is a tree-based architecture device that allows for repeater radios to extend the wireless net-
work. Each device in a MultiHop network is a Modbus device with a unique Modbus ID.

Modbus registers in a MultiHop network are contained within each individual radio device. To obtain Modbus register data
from a MultiHop device, configure the DXM to access each device across the wireless network as an individual Modbus serv-
er device.
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Example MultiHop Modbus registers with generic devices.

MulitHop Device Modbus ID Modbus Registers
DXM client radio 1 none
Server radio 11 Modbus register 1-16 are inputs, 501-516 are outputs
Repeater radio 12 Modbus register 1-16 are inputs, 501-516 are outputs
Server radio 15 Modbus register 1-16 are inputs, 501-516 are outputs

Modbus Registers for the Performance Gateway Radio Module

The DX80 Performance Gateway is a star-based architecture device that contains all the Modbus registers for the wireless
network within the Gateway. To access any input or output values within the entire wireless network, read the appropriate
Modbus register from Gateway.

There are 16 Modbus registers allocated for each device in the wireless network. The first 16 registers (1-16) are allocated
for the Gateway, the next 16 (17-32) are allocated for Node 1, the next 16 (33—48) are allocated for Node 2 and so forth.
There are no inputs or outputs on the DXM embedded Gateway but the Modbus registers are still allocated for them.

Although only seven Nodes are listed in the table, the Modbus register numbering continues for as many Nodes as are in the
network. For example, the register number for Node 10, I/O point 15 , is 175. Calculate the Modbus register number for each
device using the equation:

Register Number = I/0# + (Node# x 16)

Modbus holding registers

1/0 Point Gateway Node 1 Node 2 Node 3 Node 4 Node 5 Node 6 Node 7
1 1 17 33 49 65 81 97 113
2 2 18 34 50 66 82 98 114
3 3 19 35 51 67 83 99 115
4 4 20 36 52 68 84 100 116
5 5 21 37 53 69 85 101 117
6 6 22 38 54 70 86 102 118
7 7 23 39 55 71 87 103 119
8 8 24 40 56 72 88 104 120
9 9 25 41 57 73 89 105 121
10 10 26 42 58 74 90 106 122
1 11 27 43 59 75 91 107 123
12 12 28 44 60 76 92 108 124
13 13 29 45 61 77 93 109 125
14 14 30 46 62 78 94 110 126
15 15 31 47 63 79 95 M 127
16 16 32 48 64 80 96 112 128

Access all wireless network registers by reading Modbus ID 1

DX80 Device Modbus ID Modbus Registers
DXM Gateway radio 1 Modbus registers 1-8 are inputs, 9—-16 are outputs
Node 1 - Modbus registers 17-24 are inputs, 25-32 are outputs

Continued on page 74
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Continued from page 73

DX80 Device Modbus ID Modbus Registers
Node 2 - Modbus registers 33—40 are inputs, 41-48 are outputs
Node 3 - Modbus registers 49-56 are inputs, 57—-64 are outputs

Alternative Modbus Register Organization

The Sure Cross DX80 Alternative Modbus Register Organization registers are used for reordering data registers to allow host
systems to efficiently access all inputs or outputs using a single Modbus command. The register groups include the input/out-
put registers, bit-packed registers, and analog registers. This feature is only available with the Performance models using
version 3 or newer of the LCD firmware code.

Alternative Modbus register organization

Name Modbus Register Address (Decimal)
Inputs and Outputs, in order by device 2201 through 4784
Discrete Bit Packed (Status, Discrete Inputs, Discrete Outputs) 6601 through 6753
Analog Inputs (1-8) and Analog Outputs (1-8) 6801 through 9098

Input Registers and Outputs Registers
Modbus registers 2201 through 2584 are used to organize all inputs together.

In this format, users can sequentially read all input registers using one Modbus message. Modbus registers 4401 through
4784 organize all outputs together to allow users to sequentially write to all output registers using one Modbus message.

Input and output registers

Inputs (2201—2584) Outputs (4401-4784)
Modbus Register Address (Decimal) 16-bit Register Value Modbus Register Address (Decimal) 16-bit Register Value
2201-2208 Gateway Inputs 1 through 8 4401-4408 Gateway Outputs 1 through 8
2209-2216 Node 1 Inputs 1 through 8 4409-4416 Node 1 Outputs 1 through 8
2217-2224 Node 2 Inputs 1 through 8 4417-4424 Node 2 Outputs 1 through 8
2577-2584 Node 47 Inputs 1 through 8 4777-4784 Node 47 Outputs 1 through 8

Refer to your device's datasheet for a list of the active inputs and outputs. Not all inputs or outputs listed in this table may be
active for your system.

Discrete Bit-Packed Registers
Discrete bit-packed registers include the discrete status registers, discrete inputs, and discrete outputs.

Bit packing involves using a single register, or range of contiguous registers, to represent 1/O values.

When networks use similar Nodes to gather data using the same 1/O registers for each Node, discrete data from multiple
Nodes can be bit packed into a single register on the Gateway. The bit-packed data is arranged by 1/O point starting at Mod-
bus register 6601. For example, Discrete IN 1 for all the Nodes in the network is stored in three contiguous 16-bit registers.

The most efficient way to read (or write) discrete data from a Sure Cross® DX80 Gateway is by using these bit-packed regis-
ters because users can read or write registers for all devices using one Modbus message. The following registers contain dis-
crete bit-packed I/O values for the Gateway and all Nodes. Values are stored first for the Gateway, then for each Node in or-
der of Node address.
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Discrete bit-packed register addresses and bit positions
Bit-Packed Device Status Registers

Bit Position

Register Address 15 14 13 12 11 10 9 8 7 6 D] 4 5] 2 1 0
6601 Node 15| Node 14 | Node 13| Node 12| Node 11 Node 10| Node9 | Node8 | Node7 = Node6 | Node5 Node4 Node3 | Node2 Nodel Gateway
6602 Node 31 Node 30| Node 29  Node 28 Node 27 | Node 26 Node 25  Node 24| Node 23 Node 22 | Node 21| Node 20 Node 19 | Node 18 | Node 17 Node 16
6603 Node 47| Node 46 = Node 45| Node 44| Node 43  Node 42 | Node 41 | Node 40 Node 39 | Node 38 Node 37 | Node 36 Node 35 Node 34| Node 33| Node 32
Bit-Packed Discrete Input 1
Bit Position
Register Address 15 14 13 12 11 10 9 8 7 6 5] 4 3 2 1 0
6611 Node 15 Node 14| Node 13 | Node 12 Node 11 Node 10| Node9 | Node8  Node7 | Node6 = Node5 Node4 | Node3 | Node2 Nodel | Gateway
6612 Node 31| Node 30  Node 29 | Node 28 Node 27 | Node 26 | Node 25 Node 24 | Node 23 | Node 22 Node 21 | Node 20 | Node 19 Node 18 Node 17  Node 16
6613 Node 47 ' Node 46 | Node 45  Node 44 Node 43| Node 42 Node 41 | Node 40 | Node 39 Node 38 | Node 37| Node 36 Node 35 Node 34  Node 33 Node 32
Bit-Packed Discrete Outputl
Bit Position
Register Address 15 14 13 12 11 10 9 8 7 6 5) 4 3 2 1 0
6691 Node 15 Node 14| Node 13 | Node 12| Node 11 Node 10| Node9 = Node8  Node7 | Node6 | Node5 Node4 = Node3 | Node2 Nodel | Gateway
6692 Node 31| Node 30 Node 29 | Node 28| Node 27 ' Node 26 | Node 25| Node 24  Node 23| Node 22 | Node 21 | Node 20| Node 19  Node 18 Node 17 | Node 16
6693 Node 47 | Node 46 | Node 45 | Node 44| Node 43 Node 42 | Node 41| Node 40 Node 39 | Node 38 | Node 37 | Node 36 Node 35 Node 34 Node 33| Node 32
Discrete bit-packed registers for inputs and outputs
Inputs Outputs
Modbus Register Address . Modbus Register Address -
9 Description (Inputs) g Description (Outputs)

(Decimal) (Decimal)

6601-6603 Status for all devices

6611-6613 Input 1 from all devices 6691-6693 Output 1 from all devices

6621-6623 Input 2 from all devices 6701-6703 Output 2 from all devices

6631-6633 Input 3 from all devices 6711-6713 Output 3 from all devices

6641-6643 Input 4 from all devices 6721-6723 Output 4 from all devices

6651-6653 Input 5 from all devices 6731-6733 Output 5 from all devices

6661-6663 Input 6 from all devices 6741-6743 Output 6 from all devices

6671-6673 Input 7 from all devices 6751-6753 Output 7 from all devices

6681-6683 Input 8 from all devices

Status registers (6601-6603) contain a bit-packed representation defining the devices that are operational in the wireless
system. Each bit indicates Node in Sync (1) or Node Not in Sync (0).

If the device's status register (input 8) contains a 128, a one (1) is written to the Discrete Status Register area, indicating the
device is active in the wireless system. If the device's I/0 8 contains any number other than a 128, a zero (0) is written, indi-
cating the device is not active within the wireless network. In this way, an analog value representing the device's status within
the wireless network is converted to a discrete value.

Aone (1) written to the Discrete Status Register area indicates the device is active within the wireless system. A zero (0) indi-
cates the device is not active within the wireless network.

Input registers from all devices use Modbus registers 6611 through 6683 to organize the least significant bit into a sequential
array of registers. The first register contains the least significant bit from the input values for the Gateway through Node 15.
The second register contains the input values for Node 16 through Node 31, and the third register contains the input values
for Nodes 32 through 47.

For discrete inputs, only the least significant bit is used. For analog inputs, the least significant bit indicates if the analog val-
ue is above or below the selected threshold value (when using the threshold parameter configured in the User Configuration
Software). For example, a least significant bit of one (1) indicates the analog value is above the selected threshold value. A
least significant bit of zero (0) indicates the analog value is below the threshold value.
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Output registers from all devices use Modbus registers 6691 through 6753 to organize the least significant bit into a sequen-
tial array of registers. Output 8 (I/O point 16) cannot be written using the discrete format.

Analog 16-Bit Registers (Registers 6801 through 9098)

The most efficient way to read (or write) analog data from a Gateway is by using these 16-bit analog registers. Most networks
consist of similar Nodes reporting data using the same 1/O registers for each Node. For this reason, the analog data is
arranged by I/O point using Modbus registers 6801 through 9098.

For example, Input 1 for Gateway and all Nodes is stored in the first 48 contiguous blocks of 16-bit analog registers, begin-
ning with register 6801.

In this format, users can read a 16-bit holding register for all devices or write to a register for all devices using one Modbus
message. Using these registers is the most efficient way to read all status registers, read all analog inputs, or write all analog
outputs.

The following registers contain analog 1/O values for the Gateway and all Nodes. Values are stored first for the Gateway, then
for each Node in order of Node address.

Analog input and output registers

Inputs Outputs

Modbus Register Address Modbus Register Address

Description (Inputs) Description (Outputs)

(Decimal) (Decimal)
6801 Input 1 for Gateway 8001 Output 1 for Gateway
6802 Input 1 for Node 1 8002 Output 1 for Node 1
6803 Input 1 for Node 2 8003 Output 1 for Node 2
6951 Input 2 for Gateway 8151 Output 2 for Gateway
6952 Input 2 for Node 1 8152 Output 2 for Node 1
6953 Input 2 for Node 2 8153 Output 2 for Node 2
7101 Input 3 for Gateway 8301 Output 3 for Gateway
7102 Input 3 for Node 1 8302 Output 3 for Node 1
7103 Input 3 for Node 2 8303 Output 3 for Node 2
7851 Input 8 (Status Register) for Gateway 9051 Output 8 for Gateway
7852 Input 8 (Status Register) for Node 1 9052 Output 8 for Node 1
7853 Input 8 (Status Register) for Node 2 9053 Output 8 for Node 2

For example, 6801 contains the input 1 value for the Gateway, 6802 contains the input 1 value for Node 1, and 6848 contains
the input 1 value for Node 47.

Internal Local Registers (ID 199) for the DXM100 and DXM150

The main storage elements for the DXM are its Local Registers, which can store 4-byte values that result from register map-
ping, action rules, or ScriptBasic commands.

» Local Registers 1 through 850 are standard 32-bit unsigned registers.

» Local Registers 851 through 900 are non-volatile registers that are limited to 100,000 write cycles.

* Local Registers 1001 through 1900 are floating point format numbers. Each register address stores half of a floating
point number. For example, registers 1001 and 1002 store the first full 32-bit floating point number.

* Local Registers 10001 through 19000 are system, read-only, registers that track DXM data and statistics.
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Modbus Registers for Internal Local Registers (Modbus ID 199)

Local Registers Type Description
1-845 32-bit unsigned Internal processor memory
846-849 32-bit unsigned Reset, Constant, Timer
851-900 32-bit unsigned Data flash, non-volatile
1001-1900 32-bit IEEE Floating Point Floating point registers, internal processor memory
> 10000 Read-only virtual registers

Local Registers 1-850 (Internal Processor Memory, 32-bit, Unsigned)—The Local Registers are the main global pool of regis-
ters. Local Registers are used as basic storage registers and as the common data exchange mechanism. External Modbus
device registers can be read into the Local Registers or written from the Local Registers. The DXM, as a Modbus client de-
vice or a Modbus server device, exchanges data using the Local Registers. Modbus over Ethernet (Modbus/TCP) uses the
Local Registers as the accessible register data.

Local Registers 851-900 (Data Flash, Non-volatile, 32-bit, Unsigned)— The top 50 Local Registers are special non-volatile
registers. The registers can store constants or calibration type data that must be maintained when power is turned off. This
register data is stored in a data flash component that has a limited write capability of 100,000 cycles, so these registers
should not be used as common memory registers that change frequently.

Local Registers 1001-1900 (32-bit IEEE Floating Point)— These Local Registers are paired together to store a 32-bit IEEE
floating point format number in big endian format. Registers 1001 [31:16], 1002 [15:0] store the first floating point value; regis-
ters 1003, 1004 store the second floating point number. There are a total of 500 floating point values; they are addressed as
two 16-bit pieces to accommodate the Modbus protocol. Use these registers when reading/writing external devices that re-
quire Modbus registers in floating point format. Since Modbus transactions are 16-bits, the protocol requires two registers to
form a 32-bit floating point number.

Virtual Registers— The DXM has a small pool of virtual registers that show internal variables of the main processor. Some
register values will be dependent upon the configuration settings of the DXM. Do not use Read Rules to move Virtual Local
Registers data into Local Registers. Use the Action Rule > Register Copy function to move Virtual Local Registers into Local
Registers space (1-850).

Virtual registers
Virtual Registers Definition
10001 GPS latitude direction (N, S, E, W)
10002 GPS latitude
GPS Coordinate Data if the DXM is configured to read an external GPS unit.
10003 GPS longitude direction (N, S, E, W)
10004 GPS longitude

10011-10012

10013-10014

10015-10016

10017-10018
10021

10022

10023

10024
10025-10026

10027-10028
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Resync timer

Resync timer rollover

Reboot cause (Restart Codes above)
Watchdog reset count

10 Board Battery Voltage (mV)

10 Board - Incoming Supply Voltage (mV)

Cut-off Feature

10 Board - Battery Charging Current (mA)
Http Push SSL Acquires

Http Push SSL Releases

Engineering use

Engineering use

Reboot Type

Counter to track how many resets have been caused by the Watchdog
mV

mV

0—No successful readings
1—Normal range

2—Cut-off engaged

mA

Statistical counts of connections, disconnections and forced disconnects when
the DXM creates a connection using SSL/TLS (Encrypted connections)

Continued on page 78
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Virtual Registers
10029-10030
10031-10032
10033-10034
10035-10036

10037-10038

10039-10040

10055-10056
10057-10058
10059-10060
10061-10062
10100

10101

10102

10103

10104

10105

10106

10107

10108

10109

10110

10111

10112

10113

10114

10115

10116

11000

12000

13000

14000

15000

16000

17000

18000

19000

Continued from page 77

Definition
Http Push SSL Forced Releases

Http Push Attempts

Statistical counts of connections, disconnections and forced disconnects when

Hitp Push Successes the DXM controller creates a connection using HTTP non-encrypted

Http Push Failures

Last DXM push status
0 = Initial state, no push attempt as finished yet
1 = Attempt complete
2 = Attempt aborted

Http Push Last Status

Cellular signal strength. Value range: 0-31
=-113 dBm or less
1=-111dBm
2-30 =-109 dBm through —53 dBm in 2 dBm steps
31 =-51 dBm or greater
99 = not known or not detectable; BER not used

Cellular Strength, BER

Alarms, smtp, attempts Email attempts (only available with some model configurations)

Alarms, smtp, fails Email failures (only available with some model configurations)

Alarms, sms, attempts SMS text message attempts (only available with some model configurations)
Alarms, sms, fails SMS text message failures (only available with some model configurations)

Number of read maps in default
Number of read map successes
Number of read map timeouts Read Map statistics
Number of read map errors
Read map success streak
Number of write map successes
Number of write map timeouts
Write Map statistics
Number of write map errors
Write map success streak
Number of passthrough successes
Number of passthrough timeouts
AP| message passing statistics
Number of passthrough errors
Passthrough success streak
Number of 43 buffer successes
Number of 43 buffer timeouts
DX80 Gateway automatic messaging buffer statistics
Number of 43 buffer errors
43 buffer success streak
Read map success count
Write map success count
Read map timeout count
Write map timeout count
Read map error count Read/Write maps statistics
Write map error count
Read map success streak

Write map success streak

Read map is in default
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The reset codes are in virtual register 11015 and define the condition of the last restart operation.

Reset Code

B V]

(&)}

Definition
Undefined
Unknown
General
Brownout
Watchdog
User
Software

Return from backup mode

Modbus Registers for the -B1 and -S1 Model I/0O Board
By default, the 1/0 board Modbus ID is 200.

Base board input connection

H~ W

Modbus Register

Base board output connection

501
502
503
504
505
506
507
508
509
510
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Modbus Register

Description
Isolated discrete input 1 (1A and 1B)
Isolated discrete input 2 (2A and 2B)
Universal input 1
Universal input 2
Universal input 3
Universal input 4
Universal input 5
Universal input 6
Universal input 7

Universal input 8

Description
Relay 1
Not used
Relay 2
Not used
NMOS Output 5
NMOS Output 6
NMOS Output 7
NMOS Output 8
DAC Output 1

DAC Output 2
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Modbus Registers for the -B2 and -S2 1/0 Board
By default, the 1/0 board Modbus ID is 200.

Base board input connection

Modbus Register

Base board output connection

Modbus Register

501
502
503
504
505
506
507
508
509
510
Board output settings
Register Description
3704 Enable Discrete Output 1
3724 Enable Discrete Output 2
3744 Enable Discrete Output 3
3764 Enable Discrete Output 4
3784 Enable Discrete Output 5
3804 Enable Discrete Output 6
3824 Enable Discrete Output 7
3844 Enable Discrete Output 8

For example, to change between PNP/NPN outputs, set parameter register 3704 to 0 for NPN and 1 for PNP.

Optically isolated input 1

Optically isolated input 2

Universal input 1
Universal input 2
Universal input 3
Universal input 4
Universal input 5
Universal input 6
Universal input 7

Universal input 8

PNP/NPN Output 1
PNP/NPN Output 2
PNP/NPN Output 3
PNP/NPN Output 4
PNP/NPN Output 5
PNP/NPN Output 6
PNP/NPN Output 7
PNP/NPN Output 8
DAC Output 1

DAC Output 2

Values

0=NPN; 1=PNP
0=NPN; 1=PNP
0=NPN; 1=PNP
0=NPN; 1=PNP
0=NPN; 1=PNP
0=NPN; 1=PNP
0=NPN; 1=PNP
0=NPN; 1=PNP
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Description
Description
Register
3705 Invert Output
3725 Invert Output
3745 Invert Output
3765 Invert Output
3785 Invert Output
3805 Invert Output
3825 Invert Output
3845 Invert Output
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Modbus Configuration Registers for the Discrete and Universal Inputs

Modbus configuration registers are identified below. The configuration software creates a graphical view of the I/O board pa-
rameters. This allows for easy and quick configuration of the 1/0 board parameters.

For the DXM150-Bx models, use the DXM Configuration Software to configure the registers using the Local Registers » Local
Registers in Use > Edit Registers screen.

For the DXM150-Sx models, a DXM client radio is required to access the remote Modbus server device and configure the
discrete and universal inputs. Manually write to these Modbus registers to set parameters or configure the input parameters
using the Configuration > Configure Device > Inputs screen of the MultiHop Configuration Software.

Registers for isolated discrete input 1

Register Isolated Discrete Input 1
3013 Enable rising edge counter
3014 Enable falling edge counter
3015 High register for counter
3016 Low register for counter

Registers for isolated discrete input 2

Register Isolated Discrete Input 2
3033 Enable rising edge counter
3034 Enable falling edge counter
3035 High register for counter
3036 Low register for counter

Universal input parameter Modbus registers

Universal Inputs 1 2 3 4 5 6 7 8
Enable Full Scale 3303 3323 3343 3363 3383 3403 3423 3443
Temperature °C/°F 3304 3324 3344 3364 3384 3404 3424 3444
Input Type 3306 3326 3346 3366 3386 3406 3426 3446
Threshold 3308 3328 3348 3368 3388 3408 3428 3448
Hysteresis 3309 3329 3349 3369 3389 3409 3429 3449
Enable Rising 4908 4928 4948 4968 4988 5008 5028 5048
Enable Falling 4909 4929 4949 4969 4989 5009 5029 5049
High Register for Counter 4910 4930 4950 4970 4990 5010 5030 5050
Low Register for Counter 4911 4931 4951 4971 4991 5011 5031 5051

Universal input register ranges

Register Types Unit Minimum Value Maximum Value
Discrete input/output 0 1
Universal input 0 to 10 V mV 0 10000 *
Universal input 0 to 20 mA uA 0 20000 *
Universal input temperature (—40 °C to +85 °C) C or F, signed, in tenths of a degree —400 850
Universal potentiometer unsigned 0 65535

* Setting Enable Full Scale to 1 sets the ranges to a linear scale of 0 to 65535.
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Modbus Configuration Registers for the Analog Output

The 1/0O base board has two analog outputs that are selectable as 0 to 20 mA (factory default) or 0 to 10 V. To change the
analog output characteristic, physical jumpers on the I/O board and a Modbus register parameter must both be changed.

For step-by-step instructions on changing the output characteristics see "GUID-A2BE672D-663F-44BC-
A564-3DD2E7053C49" on page 0.

Parameters for Analog Output 1 start at 4001 through 4008. Parameters for Analog Output 2 start at 4021 through 4028.

Registers for analog output (4xxxx) parameters

A”a'°‘1 QUL Analog output 2 Description Values
4001 4021 Maximum Analog Value
4002 4022 Minimum Analog Value
0 = Store readings in unit-specific data
4003 4023 Enable Register Full Scale

1 = Linear rate from 0 to 65535

0 = Disables Hold Last State and uses the Default Output State setting during an er-
4004 4024 Hold Last State Enable ror condition
1 = Sets the output to its last known value

4005 4025 Default Output State

0to 20 mAor 0to 10 V DC output (I/0O board jumper selectable)
Accuracy: 0.1% of full scale +0.01% per °C
Resolution: 12-bit
4008 4028 Analog Output Type After changing the jumper position, write the appropriate value to the Modbus regis-
ters to define your analog output to match the setting selected by the jumper.
2 =0 to 20 mA output (default)
3=0to 10 V output

Enable Default Communica- 0 = Disable

2952 tion Timeout 1 = Enable

Communication Default /0O .
2953 Timeout (100 ms/Count) Number of 100 ms periods

0 = Disable

2954 Enable Default on Power Up 1 = Sends device outputs to their default condition

Analog Output Type—The analog outputs may be configured as either 0 to 20 mA outputs (default) or 0 to 10 V outputs. To
change the analog output type change the hardware jumper position and write to the Modbus register that defines the analog
output type. For analog output 1, write to Modbus register 4008, for analog output 2 write to Modbus register 4028. Write a
value of 2 (default) to select 0 to 20 mA; write a value of 3 to select 0 to 10 V.

Default Output Conditions—Default output triggers are the conditions that drive outputs to defined states. Example default
output conditions include when radios are out of sync, when a device cycles power, or during a host communication timeout.
» 2952 Enable Default Communication Timeout— A “communication timeout" refers to the communication between any
Modbus client host and the DXM baseboard. Set this register to 1 to enable the default condition when the host has
not communicated with the DXM baseboard for the period of time defined by the Communication Default 10 Timeout.
» 2953 Communication Default /0O Timeout (100 ms/Count)—This parameter defines the host timeout period in 100-
millisecond increments. If a host does not communicate within this timeout period, the device outputs are set to the
default values.
» 2954 Enable Default on Power Up—Setting this parameter to 1 sends the device outputs to their default condition
when the DXM baseboard is powered up. Set to 0 to disable this feature.

Default Output State—The Default Output State parameter represents the default condition of the analog output. When an er-
ror condition exists, the outputs are set to this 16-bit user-defined output state. To define the error conditions for device out-
puts, refer to the MultiHop default output parameters 2950-2954.

Enable Register Full Scale—Set to 1 to enable a linear range from 0 to 65535 for the specified input range. For a 4 to 20 mA
output, a value of O represents 4 mA and 65535 represents 20 mA. Set this parameter to 0 to store readings in unit-specific
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data. For example, the register data representing a 15.53 mA reading is 15530. For units of current (0 to 20 mA outputs), val-
ues are stored as pA (micro Amps), and voltage values are stored as mV (millivolts).

Hold Last State Enable—Set the Hold Last State to 1 to set the output to its last known value before the error occurred. Set
this parameter to 0 to disable the Hold Last State and use the Default Output State setting during an error condition.

Maximum Analog Value—The Maximum Analog Value register stores the maximum allowed analog value. The specific units
of measure apply to the register value. For example, the register may contain 20000, for 20 mA, or for a voltage output the

register may contain 8000, for 8 volts.

Minimum Analog Value—The Minimum Analog Value register stores the minimum allowed analog value. The specific units of
measure apply to register value. For example, the register may contain 4000, for 4 mA, or for a voltage output the register

may contain 2000, for 2 volts.

Modbus Configuration Registers for the 10 (Definitions)

Enable Full Scale Hysteresis and Threshold

Set to 1 to enable a linear range from 0 to 65535 for specified
input range. For a 4 to 20 mA input, a value of O represents 4
mA and 65535 represents 20 mA. Set this parameter to 0 to
store input readings in unit-specific data. For example, the
register data representing a 15.53 mA reading is 15530. For
units of current (0 to 20 mA inputs), values are stored as pA
(micro Amps) and voltage values are stored as mV (milli-
volts).

Enable Rising/Falling
Use these registers to enable the universal input logic to count
on a rising transition or a falling transition. Write a one (1) to
enable; write a zero (0) to disable.

High/Low Register for Counter
The low and high registers for the counter hold the 32-bit
counter value. To erase the counter, write zeroes to both reg-
isters. To preset a counter value, write that value to the appro-
priate register.

Threshold and hysteresis work together to establish the ON
and OFF points of an analog input. The threshold defines a
trigger point or reporting threshold (ON point) for a sensor in-
put. When the input value is higher than the threshold, the in-
put is ON. Hysteresis defines how far below the threshold the
analog input is required to be before the input is considered
OFF. A typical hysteresis value is 10% to 20% of the unit’s
range.

In the example shown, the input is considered on at 15 mA. To
consider the input off at 13 mA, set the hysteresis to 2 mA.
The input will be considered off when the value is 2 mA less
than the threshold.

ON point

Threshold

Input Value

Input Type

Program the universal inputs to accept input types NPN, PNP,
10k thermistor, 0 to 10 V, 0 to 20 mA, or potentiometer. The
default setting is 8: NPN raw fast. To set the input type, write
the following values to the Input Type Modbus registers.

0=NPN

1=PNP

2=0to 20 mA

3=0to 10V DC

4 = 10k Thermistor

5 = Potentiometer Sense (DXM150 only)

6 = Not used

7 = Bridge

8 = NPN Raw Fast (default)

Temperature °C/°F

Modbus Configuration Registers for Power

Set to 1 to represent temperature units in degrees Fahrenheit,
and set to 0 (default) to represent temperature units in de-
grees Celsius.

To monitor the input power characteristics of the DXM, read the following power Modbus registers. The on-board thermistor is

not calibrated, but can be used as a non-precision temperature input.
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Configuration registers for power

Modbus Register

6071

6081

6082

6083

6084

Description

Battery backup charging algorithm.
0 = Battery is recharged from a solar panel
1 = Battery is recharged from 12 to 30 V DC (default)

Battery voltage (mV). If no battery is present, the value in this register is less than 5 V. If the value in this register is greater than
the incoming voltage register, the battery is powering the system.

Battery charging current (mA). The charging configuration charges the battery when the incoming voltage register value is
greater than the battery voltage register value. This registers shows the charging current in milliamps.

Incoming supply voltage (mV) (solar or power supply). The incoming power can be from a solar panel or from a power supply.
The battery is charging when the incoming voltage register value is greater than the battery voltage register value. The battery is
powering the system when the incoming voltage register value is less than the battery voltage register value.

On-board thermistor temperature (°C). A thermistor measures the temperature of the solar controller board and its surrounding
area and uses the temperature as part of the battery charge calculations. This register stores the thermistor reading in tenths of
degrees C. This is not a calibrated input: divide by 10 to calculate the temperature in degrees C. For calibrated temperature in-
puts, define one of the universal inputs as a temperature input.

Modbus Registers for the LCD Board (Slave ID 201)
Control the four user-defined LEDs using the display board's Modbus registers. Using write maps or ScriptBasic, write to the
Modbus registers shown.

Do not write to any other LCD Modbus registers. They are used by the LCD for menu data.

LED registers (Modbus ID 201)

1102
1103
1104
1105

Registers

1/0O Connection Parameter
LED 1 (top, green)
LED 2 (red) 0=Of
LED 3 (amber) 1=0n

LED 4 (bottom, amber)

Using the Display LEDs
Turn on the DXM LEDs by writing to the LEDs' Modbus registers.

This example shows how to configure the DXM using the configuration software to read four universal inputs and write the
state values to the display LEDs.

Local Registers In Use mmm@

1. Using the configuration software, go to the Local Registers » Local Registers in Use screen.

2. Define the local registers by assigning names to the first four registers and setting the LCD permissions parameter to
read/write. The LCD permissions show the register contents on the LCD menu under the REGISTER menu. You can
also set the value from the LCD menu.

Local Registers in Use screen

. - . Constant Cloud LCD Prolocol "
Register Name signed Tl ermissions Penmiss Conversion 109 Fiies  Cydlic Push Read Rules

Display LED1 No Read/Write None

Display LED2 | | ] Read/Write | None
Dispiay LED3 Read/Write | None
Display LED4 Read/\Write None

3. Create a Read Rule to read the four universal inputs from the 1/O board (Modbus ID 200) and write the values in local
registers 1 through 4.
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RTU Read rules
RTU Read
| Add Read Rule | | Clone Selected Rule| | Delete Selacted Rule |
(=) [Read O Inputs | Fromsiave 1D | 2005 read|  4[Z] registers starting at 3] mrough 6 tolocal registers staring st 1] tnrougn 4
Remote type Holding register | = | 1.oct Fsgkser iavmen
Display LED1
Frequency 00:00:01.000@ hh:mm:ss. fif Display LED2
Display LED3
Scaling Scalevalue | 0.000000™2]  Scale offset ofg] Display LED4
[ Apply oftset before scale valug
Efror condition Apply value 0= after 0 ?—‘ read faiures
Floating point [ swap words
On register o=

4. Create a Write Rule to write the four local register values to the DXM display registers 1102 through 1105 (Modbus ID
201). Define the Write Rule to only write the display registers when the inputs change.

RTU Write rules

[RULERREELE | RTU Write

| Add Write Rule | | Clone Selected Rule| | Delele Selected Rule |

@ [ 5 | Wite| 4[] tocal registers from 1] througn 4 tosiaveid| 201[5] starting atregister | 1102[5] through 1105
Remote type Holding register | =
Frequency [0n Change of local register data | =3 Display LED1
Write when register changes by more than o= g;:g:; =
Write no fasterthan | 00:00:00.000 =] hnimm:ss 1 Fheni LEDA
Write no slower than 00:00:00.000 =] hh:mm:ss 1
lue |0 = I
o Scale value |0.00000072]  Scale offset o]
[ Apply offset before scale value
Floating point [J Swap words

5. Save the XML configuration from the File » Save As menu.
6. Connect to the DXM using a USB cable and select Device » Connection Settings from the menu bar.

7. Upload the XML configuration file to the DXM by selecting Device » Upload Configuration to Device from the menu
bar.

After a configuration file is uploaded, the DXM reboots. The new configuration is now running.

Turning on any one of the universal inputs 1 through 4 on the 1/0O base board of the DXM now turns on an LED on the dis-
play.

On the DXM's LCD menu, the arrow on the left side of the register line indicates this local register can be written to. Try

changing the configuration to delete the Read Rule then turn on/off the LEDs by changing the register value through the LCD
display.

Using the Auxiliary Power Outputs

The DXM has two auxiliary power outputs, pin 35 and pin 45. They are controlled by hardware jumpers on the I/O base
board. Refer to the wiring board diagram for more information.

Auxiliary power output pins

Pin Description

The auxiliary power outputs are controlled by hardware jumpers (PWR Out jumper bank).
Jumper 2 is the power jumper for pin 45. Jumper 1 is the power jumper for pin 35.
» The pin 45 jumper selects 2.7 VV when in the "a" position and 12 V battery in the "b" position.
» The pin 35 jumper selects 4.2 V when in the "a" position and device power on pin 2 in the "b" position.

Pin 35, Pin 45
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Working with Solar Power

A reliable solar system requires careful planning and monitoring to size the components correctly. The recommendations pro-
vided are for the DXM system as an autonomous system.

Adding extra components increases the power requirements and likely requires increasing the solar system components. De-
pending upon the geographical location, the size of the solar panel and battery may vary.

Setting the DXM for Solar Power

By default, the DXM is set from the factory to charge a backup battery from a line power source.

For DXM models with an LCD, use the buttons and menu system to change the charging algorithm to solar power. Go to Sys-
tem Config » /0 Board » Charger. Use the up/down arrows to select Solar.

For DXM models without an LCD, use the configuration software to adjust the 1/0 board Modbus register 6071. Set the regis-
ter to 0 to select battery charging from a solar panel, and set to 1 to select battery charging from incoming 12 to 30 V DC sup-
ply.

To minimize the power consumption (may not apply to all models):
» If Ethernet is not being used, save up to 25% of the consumed power by disabling Ethernet. Set DIP switch 1 to the
ON position on the processor board then reboot.
* Instead of powering external devices all the time, take advantage of the switched power mechanisms to turn off de-
vices when possible.
* Minimize the number of cellular transactions and the amount of data pushed across the cellular modem.

Solar Components

The components of a solar system include the battery and the solar panel.

Battery

The DXM solar controller is designed to use a 12 V sealed lead acid (SLA) battery. The characteristics of a solar system re-
quire the battery to be of a certain type. There are two types of lead acid batteries:

» SLI batteries (Starting Lights Ignition) designed for quick bursts of energy, like starting engines

« Deep Cycle batteries - greater long-term energy delivery. This is the best choice for a solar battery.

Since a solar system charges and discharges daily, a deep cycle battery is the best choice. There are different versions of a
lead acid battery: wet cell (flooded), gel cell, and an absorbed glass mat (AGM).

Wet cell batteries are the original type of rechargeable battery and come in two styles, serviceable and maintenance free.
Wet cell batteries typically require special attention to ventilation as well as periodic maintenance but are the lowest cost. The
gel cell and AGM battery are sealed batteries that cost more but store very well and do not tend to sulfate or degrade as easi-
ly as a wet cell. Gel or AGM batteries are the safest lead acid batteries you can use.

Battery capacity is a function of the ambient temperature and the rate of discharge. Depending upon the specific battery, a
battery operating at —30 °C can have as much as 40 percent less capacity than a battery operating at 20 °C. Choose enough
battery capacity based on your geographical location.

Average voltage readings relative fo battery charge

State of Charge (%) Open Circuit Voltage
100 13.0 or higher
75 12.6
50 121
25 11.66
0 11.4 or less
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A larger capacity battery typically lasts longer for a given solar application because lead-acid batteries do not like deep cy-
cling (discharging a large percentage of its capacity). Depending upon the battery, a battery discharging only 30 percent of its
capacity before recharging will have approximately 1100 charge/discharge cycles. The same battery discharging 50 percent
of its capacity will have approximately 500 charge/discharge cycles. Discharging 100 percent leaves the battery with only 200
charge/discharge cycles.

Use this information as a guide to the approximate state of charge and in determining when to apply conservation measures.
Batteries degrade over time based on discharge/charge cycles and environmental conditions. Always monitor the battery sys-
tem to obtain the best performance of the solar powered system.

Solar Panel

Banner solar panels come in two common sizes for the DXM: 5-watt and 20-watt. Both panels are designed to work with the
DXM but provide different charging characteristics. Use the 5-watt panel for light-duty operation and use the 20-watt panel
when you require greater charging capabilities.

Solar Panel Voltage Current Typical DXM Configurations
5 Watt 17V 0.29A DXM Controller configured as a server, ISM radio, I/0O base board
20 Watt 21V 1A DXM Controller with ISM radio and Cellular modem

Photovoltaic panels are very sensitive to shading. Unlike solar thermal panels, PV solar panels cannot tolerate shading from
a branch of a leafless tree or small amounts of snow in the corners of the panel. Because all cells are connected in a series
string, the weakest cell will bring down the other cells' power level.

Good quality solar panels will not degrade much from year to year, typically less than 1 percent.

To capture the maximum amount of solar radiation throughout the year, mount a fixed solar panel to optimize the sun's ener-
gy. For the northern hemisphere, face the panel true south. For the southern hemisphere, face the panel true north. If you are
using a compass to orientate the panels, compensate for the difference between true north and magnetic north. Magnetic
declination varies across the globe.

A solar panel's average tilt from horizontal is at an angle equal to the latitude of the site location. For optimum performance,
adjust the tilt by plus 15 degrees in the winter or minus 15 degrees in the summer. For a fixed panel with a consistent power
requirement throughout the year, adjust the tilt angle to optimize for the winter months: latitude plus 15 degrees. Although in
the summer months, the angle may not be the most efficient, there are more hours of solar energy available.

For sites with snow in the winter months, the increased angle helps to shed snow. A solar panel covered in snow produces lit-
tle or no power.

Recommended Solar Configurations

These solar panel and battery combinations assume direct sunlight for at least two to three hours a day. Solar insolation
maps provide approximate sun energy for various locations. The depth of battery discharge is assumed to be 50 percent.

Solar panel and battery combinations for a DXM system

S°'a;u':*(’\'l‘\‘f)' Out-  Battery Capacity (Ahr) ~ D2Y® ‘r:: ;\“‘°”°' DX'}"mi‘; Lt DXM Model
5 10 10 25 DXM-8x models with an ISM radio and 1/O base board
20 14 10 30 DXM-Bx models with an ISM radio and no cellular modem
20 20 10 35 DXM-Bx models with an ISM radio and cellular modem

Battery capacity (amp hour) is a standard amp rating taken for 20 hours. Battery capacity should be monitored for reliable
system power and may need to be increased for cold weather locations.

Monitoring Solar Operation

The DXM solar controller provides Modbus registers that allow the user to monitor the state of the solar panel input voltage,
the battery voltage, the charging current, and the temperature in °C. The DXM can be configured to monitor the health of the
charging system as well as send an alert message when the battery is too low.
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The charts show a typical charging cycle, with each vertical grid representing about eight hours. The chart shows three days

of charging.

Solar Panel Voltage (mV) -- Cloudy First Day

Battery Voltage (mV) - Cloudy First Day
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Clear the Password on DXM100 and DXM150 Models Only

By default, the DXM Controllers does not require a password to load a configuration file. If a password is defined, the pass-
word must be entered before uploading a configuration file. To change the password, you must already know the current
password. If you do not know the current password, follow these steps to clear the password.

A WODN -

IMPORTANT: Clearing the password erases the current configuration and any program files, log files, or
history files.

IMPORTANT: DO NOT follow these instructions if you have a DXM700, DXM1000, or DXM1500 model. If
you attempt to clear the password of a DXM700, DXM21000, or DXM1500 with these instructions, the
firmware of your device will be erased and your controller will no longer function.

. Turn the power OFF to the DXM Controller.
. Set DIP switch 4 to the ON position.

. Press and hold the processor button.

. Turn the power ON to the DXM Controller.

The processor board's LED flashes to indicate the process is complete (about 10-20 seconds).

(o221

. Set DIP switch 4 to the OFF position.
. Cycle power to the DXM Controller.

7. Reload the configuration file before resuming normal operation.
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Chapter Contents

Chapter 10 DXM150 and DXM1500 Dimensions

All measurements are listed in millimeters [inches], unless noted otherwise.

Dimensions for the DXM150 and DXM1500 models

2

Q||pooolooooloooolooooloooolooooﬂ Q
Ed

35mm_,
156 mm [1.387]

[6.147]

59.5 mm
[2.347]

0

D :n

85 mm

[3.357]
94.6 mm
[3.727]
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Modbus Operation

Chapter 11 Troubleshooting

Restoring Factory Default Settings for the 10 Base Board

To reset the 1/0 base board to factory defaults, write to two Modbus registers in the base board. The default ID for the base
board is 200.

To reset the DXM /O base board parameters back to factory defaults:
1. Write a 1 to Modbus register 4152
2. Write a 10 to Modbus register 4151

To reboot (cycle power) the DXM I/O base board:
1. Write a 0 to Modbus register 4152
2. Write a 10 to Modbus register 4151

Restoring Factory Defaults for the I/O Base Board

Register Values Description

Reset/restore trigger. This timer is based in 100 millisecond units. Once written, the timer starts to count down to zero. After the
timer expires, the restore factory defaults are applied if register 4152 = 1. If register 4152 is zero, the /O board is reset.
4151 0-255 Default value: 0

1 =100 milliseconds, 10 = 1 second.
0 = Reboots (cycles power) to the 1/0 base board

4152 0-1
1 = Restores factory defaults for I/O parameters

Updating the DXM Processor Firmware

There are two different update procedures, depending on the DXM firmware version of your device.

Update Your DXM Processor Firmware (Prior to Version 2.0)
To update DXM Processor firmware prior to version 2.0, use the SAM-BA program from MicroChip/Atmel. Following these in-
structions to update the DXM100 or DXM150 processor firmware.
1. Download the SAM-BA software from http://www.microchip.com/developmenttools/productdetails.aspx?
partno=atmel+sam-ba+in-system+programmer.
2. Install the SAM-BA program.
3. Set the processor board jumper (jumper C, shown below in the "boot load off" position).
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Processor board
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a. Disconnect the DXM Controller from its power supply.

b. Open the hardware cover.

c. Using your fingers or tweezers, move the jumper to the "boot load on" position (jumper on the top two pins).
d. Connect the DXM back to its power supply.

e. The lower left LED on the I/0O base board is solid when power is turned on. After the LED begins flashing, re-

move power.

f. Move the jumper back to its original position.

g. Replace the hardware cover.

h. Connect the DXM back to its power supply.

4. Launch the SAM-BA program. Select the COM port and correct board. Click CONNECT.

Popup screen
Select the connection : 'W J-LinkInterface

~| | € swD

Select your board : |at91samdelb-ek 7] | ® TTAG

ILink TimeoutMultiplier : |0
[ Customize lowlevel

Connect Exit

The SAM-BA program attempts to auiomatically detect the COM port and the cérreot device.
5. On the SCRIPTS pull-down m] enu select ENABLE FLASH ACCESS. Click EXECUTE.
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SAM-BA popup window

[ SAM-3A 216 - atdisamdelf-ck.

File ScriptFile Help

at9lsamdel6-ck Memory Display

Start Address : [0:20000000 Refresh tipiey farnal Sepithare nn DG
Sie i byte(s): 0x100 © ascii  B-bit " 16-bit & 32-bit infos = ﬂj
oxt 1 ’ 0x00000001  0x008004DE |
10 3 0x008004CF 0x00800C3D "*‘

0x20000020 Ox00800CDF  0x0001C200  0x00080000 Ox000021A1
0x20000030 0x00070000 0x000D0000  0x00000000  0x40084000

7] w I '

Flesh | MandFlash | SRAM | SerialFlash AT25/AT26 |

Download / Upload File

Send File Name: | & Send File
Receive File Name: | g Receive File
Address:[0x400000  Size (For Receive File) : 01000 byte(s) Compare sent file with memery
Scripts !
[Enable Flash access & Execute
(SAFBa_Z.16] T 95 FLASFIION %

I Loading applet applet-flash-sam4e16.bin at address 0x20000800
I Memory Size : 0x100000 bytes

I Buffer address : 0x20002128 =
-I- Buffer size: 0x10000 bytes
-I- Applet initialization done
(sam-ba_2.16) 1 %

L
\USBseria\COM116| Board : at91sandel6-ek -

6. In the SCRIPTS pull-down menu, select BOOT FROM FLASH (GPNVM1). Click EXECUTE. Click EXECUTE again if
the message indicates it failed.

7. In the Flash tab, click on the folder icon for the Send File Name field. Select the boot load file (must be a *.bin file) and
click SEND FILE. The file is: DXM PROCESSOR FIRMWARE V2.02 or go to the software section of the Wireless
Reference Library on www.bannerengineering.com.

SAM-BA popup window
T s a216 - sotarteis o ol
File ScriptFile Help

at91samdel6-ek Memory Display

StartAddress s 20000000 Refresh | [ Display format Applet traces on DBGU

i | 4 & 32 f ~| Appk
Size in byte(s): [0xd00 " ascii  8-bit (" 16-bit & 32-bit B PPl

o 1 o 1 0xD08004DB =

0x20000010 0x00800503 0x008004C3  0x008004CF  0x00800C3D —!
0x20000020 0x00800CDF  0x0001C200 0x00080000 Ox000021A1
0x20000030 0x00070000 0x00000000 0x00000000 Ox40084000

< e i :

Flash | NandFlash | SRAM | SerialFlash AT25/AT26 |

Download / Upload File—

Send File Name : |E:/Drop! DXM - Eng/Fi - /Re 2.0/20061 (& Send File
Receive File Name:: | = Receive File
Address: [0:400000 Size (For Receive File) : [0x1000 byte(s) Compare sent filewith memory
Scripts
[Bot from Flash (GPNYML] - Execute
~FWETIOTy S1Z€ T UXIUUUT OYies 7

-I- Buffer address : 0x20002128

-I- Buffer size: 0x10000 bytes

-I- Applet initialization done

(sam-ba_2.16) 1 % FLASH::ScriptGPNMV 2 B
-I- GPNVML set |
(sam-ba_2.16) 1 %

|
\USBseriahCOM116] Board : atdlsamdel6-ek e

The load process takes a few seconds.

8. After the load is complete, the program asks if you want to lock the flash region. Click NO.
9. Close the SAM-BA bootloader program.

10. Cycle the power to the DXM.
The new code should now be running and the LEDs should be on.

Updating Your DXM Processor Firmware (Version 2 or Later)

DXMs with processor firmware version 2.0 or later have a built-in boot loader program to update the firmware. Use the con-
figuration software version 3 or later, the BannerCDS webserver, or manually write the files on the SD card to update the
firmware.

The new firmware file loads into the BOOT directory of the SD card on the DXM. The configuration software or
BannerCDS website handles the reprogramming process automatically. During the programming process, the internal LEDs
on the processor board indicate the status of the programming.
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Update process overview

Reprogramming Step Approximate time required Description
c;o:;l?:ifjltg; z?/f;:vargéz minutes over Ethernet Send the new firmware image to the DXM. After the new im-
Loading new firmware file (*.HEX) . . . age is on the device, the controller resets.
BannerCDS: 2 minutes over Ethernet or 5 minutes

LED3 is red during the loading process.

over Cellular
. When the DXM finds a file that should be installed, LED4
Verify the contents of the new . .
) 8 1 minute (amber) flashes at about a 1 second rate while the contents of
firmware file . .
the file are validated.

New firmware file is valid After validation successfully completes, LED4 is on (amber).

) _ . 2 minutes; do not remove power to the DXM dur- ~ LED3 (red) blinks approximately once per second. LED3 con-
New firmware file is being loaded . . . : . . .

ing the programming process. tinues to blink during the application programming process.

Finished After programming has completed, the DXM resets and be-

gins running the new firmware

The firmware file names follow an 8.3 filename convention. The first 5 characters are the firmware part number in hexadeci-
mal; the last 3 characters of the part number are the major/minor version number. For example, if 30FA9052 . hex is the

firmware programming file, 200617 decimal (30FA9 hex) is the firmware part number and 0.5.2 (0502) is the decoded version
number.

Update Your DXM Processor Firmware Using the DXM Configuration Software
To update your processor firmware using the DXM Configuration Software, follow these instructions.

1. Using the DXM Configuration Software version 3 or later, connect to the DXM via USB‘" or Ethernet.
File loads to the DXM will take about 15 minutes using USB or approximately 2 minutes using Ethernet.
2. On the configuration software, go to Settings » General » Device Information to verify the current firmware version.

You must load a different version with the same firmware number for the boot loader to operate. Download firmware
files from the Banner website.

Device Information

Device Information Firmware Version Check
S e e ‘ [X] Verify firmware compatibility before configuring DXM

Processor information

Serial number:

Model number:

Firmware number:

Version,

3. Under Settings » Reprogram, click Select upgrade file to select the firmware file to program.

After the file load is completed, the DXM restarts and loads the new firmware file. It takes about 2 minutes to complete the

programming process. The device reboots when finished. Verify the firmware has been updated, under Settings > Gener-
al > Device Information.

Update Your Processor Firmware Using the BannerCDS Website
To update your processor firmware (version 2.0 or later) using the DXM website, follow these instructions.

To use the website to update the firmware file, first configure the DXM to push data to the website.

Data collected from the DXM is displayed.

() While the file download is in process over a USB connection, do not use other applications on the PC. After the DXM reboots for a firmware update, the USB
port may be unresponsive. Clear the connection by disconnecting the USB cable and restarting the DXM Configuration Software.
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2. From the main Dashboard > Sites screen, click on Update.
A popup box appears.

3. Set the Communications Type to Push Reply, and set the Update Type to Firmware file.

4. Choose the appropriate Upload File (*.HEX) and click Queue. Click Close.
At the next scheduled push interval, the DXM retrieves the new firmware file. The new firmware file must be the same

part number of firmware that is currently in the DXM.

Update Your Processor Firmware Manually
To manually update your processor firmware (version 2.0 or later) using SD card, follow these instructions.

The firmware file can manually be put on the SD card in the BOOT directory (must have version 2.0 or later on the DXM).

1. Disconnect the DXM from its power supply.
2. Remove the micro SD card from the DXM.

a. Open the cover housing to the DXM.

b. Use your fingernail to slide the top metal portion of SD card holder.

c. The metal cover hinges upward, allowing access to remove the SD card.

d. Press down on the SD cover and slide back into position to close the SD card holder.
3. Insert the micro SD card into an SD card reader to access the data from a PC.
4. Load the new firmware file (*.hex) into the BOOT directory of the micro SD card.

5. Re-insert the micro SD card into the DXM by sliding the card into the holder.

6. Reconnect the DXM to its power supply.
The automatic boot process should begin. If the boot process does not begin, verify the firmware file is correct and it

is a different version than what is currently installed on the device.
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Troubleshooting Issues

Problem Solution
The LCD and the processor applications share the external Modbus connection. If the processor is configured to
constantly interact with Modbus, it may cause issues with the LCD attempting to use the functions of the ISM radio.
To alleviate the contention do one of these things:
Communication contention between + Load a DXM configuration file that slows down the read/write rules.
the LCD and process + Disable the DXM configuration file from loading into the processor by setting DIP switch 4 to ON (on the

processor board). Reboot the device. When the processor reboots, it will not load the configuration file
and remains idle.

If the incoming voltage drops below 11.2 V DC, the cellular modem does not turn on and will not turn on until the
voltage is above 11.8 V DC. A text file (CmVMon.txt) on the internal micro SD card saves the periodic sampling of

Cellular modem did not turn on
the incoming voltage. If cellular operation stops because of voltage, it is logged in this file.

Modbus Operation
All Modbus transactions are managed by a central Modbus engine. If there are Modbus messages intended for a Modbus
server that doesn't exist, the Modbus engine waits for a response until the timeout period is expired. This slows down the
Modbus polling loop for read and write operations.

For this reason, verify all Modbus read and write operations are intended for Modbus server devices that are in the network.
If a Modbus server is not in the network, either a wired or wireless device, the operation of the LCD menu system can be
compromised. Operations like Binding, Site Survey, or accessing the ISM menu may be slower. This is because all internal
devices (such as the ISM radio, LCD, etc) of the DXM are also Modbus servers.
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Chapter Contents

Chapter 12

Accessories

For a complete list of all the accessories for the Sure Cross wireless product line, please download the Accessories List (p/

nb_3147091).

Cordsets
MQDC1-506—5-pin M12, straight, single-ended, 6 ft
MQDC1-530—5-pin M12, straight, single-ended, 30 ft
MQDC1-506RA—5-pin M12, right-angle, single-ended, 6 ft
MQDC1-530RA—5-pin M12, right-angle, single-ended, 30 ft

Static and Surge Suppressor
BWC-PRC827-DC—Surge Suppressor, bulkhead, DC Blocking, N-Type
Female, N-Type Male

Short-Range Omni Antennas
BWA-202-D—Antenna, Dome, 2.4 GHz, 2 dBi, RP-SMA Box Mount
BWA-902-D—Antenna, Dome, 900 MHz, 2 dBi, RP-SMA Box Mount
BWA-902-RA—Antenna, Rubber Fixed Right Angle, 900 MHz, 2 dBi,
RP-SMA Male Connector

Medium-Range Omni Antennas
BWA-905-C—Antenna, Rubber Swivel, 900 MHz 5 dBi, RP-SMA Male
Connector
BWA-205-C—Antenna, Rubber Swivel, 2.4 GHz 5 dBi, RP-SMA Male
Connector

Enclosures and DIN Rail Kits
BWA-AH864—Enclosure, Polycarbonate, with Opaque Cover, 8 x 6 x 4
BWA-AH1084—Enclosure, Polycarbonate, with Opaque Cover, 10 x 8 x
4
BWA-AH12106—Enclosure, Polycarbonate, with Opaque Cover, 12 x
10 %6
BWA-AH8DR—DIN Rail Kit, 8", 2 trilobular/self-threading screws
BWA-AH10DR—DIN Rail Kit, 10", 2 trilobular/self-threading screws
BWA-AH12DR—DIN Rail Kit, 12", 2 trilobular/self-threading screws

June 05, 2023

Misc Accessories
BWA-CG.5-3X5.6-10—Cable Gland Pack: 1/2-inch NPT, Cordgrip for 3
holes of 2.8 to 5.6 mm diam, 10 pack
BWA-HW-052— Cable Gland and Vent Plug Pack: includes 1/2-inch
NPT gland, 1/2-inch NPT multi-cable gland, and 1/2-inch NPT vent plug,
one each

Antenna Cables
BWC-1MRSMN05—LMR200 RP-SMA to N-Type Male, 0.5 m
BWC-2MRSFRS6—LMR200, RP-SMA Male to RP-SMA Female Bulk-
head, 6 m
BWC-4MNFN6—LMR400 N-Type Male to N-Type Female, 6 m

Long-Range Omni Antennas
BWA-908-AS—Antenna, Fiberglass, 3/4 Wave, 900 MHz, 8 dBi, N-Type
Female Connector
BWA-208-A—Antenna, Fiberglass, 2.4 GHz, 8 dBi, N-Type Female
Connector

Long-Range Yagi Antennas
BWA-9Y10-A—Antenna, 900 MHz, 10 dBd, N-Type Female Connector

Cellular Antenna
BWA-CELLA-002—Cellular multiband, 2 dBi, RP-SMA male connection,
6.3 inch blade style. Datasheet: b_4475176

Power Supplies
PSD-24-4—DC Power Supply, Desktop style, 3.9 A, 24 V DC, Class 2,
4-pin M12 quick disconnect (QD)
PSDINP-24-13 —DC power supply, 1.3 Amps, 24 VV DC, with DIN Rail
Mount, Class | Division 2 (Groups A, B, C, D) Rated
PSDINP-24-25 — DC power supply, 2.5 Amps, 24 V DC, with DIN Rail
Mount, Class | Division 2 (Groups A, B, C, D) Rated
BWA-SOLAR PANEL 20W—Solar Panel, 12 V, 20 W, Multicrystalline,
573 x 357 x 30, "L" style mounting bracket included (does not include
controller)
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Chapter 13 Product Support and Maintenance

File System and Archive Process

The DXM file system consists of two physical components: the serial EEPROM that stores non-volatile configuration infor-
mation and a removable micro SD card that stores file backup data and user-created files.

EEPROM Files—The serial EEPROM stores basic data that is required to be non-volatile, including network configuration da-
ta, IP address, MAC address, network masks, firewall settings, and authentication information. The controller XML configura-
tion file created by the DXM Configuration Software is stored in EEPROM. The small section of non-volatile local registers is
also stored in EEPROM.

Micro SD Card Files—The micro SD card contains most files at the root level. The archive directory contains files kept by the
system for history backup. Archive files are stored in the directory _sxi and are only accessible by removing the SD card.

» Data Log Files

e HTTP Push Files

» User-created ScriptBasic file

» ScriptBasic program file

*  CmVMon file

* _sxi Archive directory

Data Log files User Created ScriptBasic Files
Users may create up to four data log files using the DXM Con- Users may use ScriptBasic to create files on the SD card by
figuration Software. The log files are stored in the root directo- using the FILEOUT function. The filenames are fixed and up
ry on the SD card. When the file size limit is reached, the file- to five files can be created in the root directory.
name is changed to include the date and time and the file is . . .
moved into the archive directory _sxi. Archived log files are ScriptBasic Program File
deleted based on the Clear Logs parameter. The main ScriptBasic program that runs at boot time is stored

. on the SD card in the root directory.
HTTP Push File
If the DXM is configured to send data to a webserver or host
system, the device creates an HTTP.LOG file on the SD card.
The HTTP log is created only if the Logging Interval is non-ze-
ro and the HTTP enable log is set. An entry is placed in the
HTTP log file at the Logging Interval specified by the user. At
the Push Interval time, the HTTP log file is sent to the web-
server or host system. If the transmission is successful, the
HTTP log file is time stamped and placed into the archive di-
rectory (_sxi). If the transmission fails, the file remains in the
root directory and subsequent Logging Intervals are appended
to the file and are sent at the next Push Interval. See " Ether-
net and Cellular Push Retries " on page 67.
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CmVMon File Continued from page 99
The CmVMon.txt file (Cellular milli-Volt Monitor) is created by cM | 2015-10-16 15:00-20 UMon  Power entered normal
the system and is used to track power events. Every power-up s range 24014
cycle is date/time stamped with the voltage read from the 1/0
board. The value 24487 is equal to 24.487 volts. If the voltage CM  2015-10-19 19:12:26 VMon  ower entered normal
drops below 11.2 V, another entry is put in the log file indicat- range 12845

ing the cellular modem will shut down.

CM

CM

_sxi Archive Directory

2015-09-22 18:52:43 VMon  Power entered normal Only two types of files are moved into the archive directory:
range 24487 data log files and HTTP log files. Data log files are date/time
Power entered normal s_ta_m_ped and placed into th_e archive dire_ctory when the size
2015-10-13 20:49:47 VMon range 24004 limit is reached. HTTP log files are date/time stamped then
placed into the archive directory when they are successfully
Continued on page 100 sent to the webserver or host system. If the HTTP log files

were not successfully sent after the retries have been ex-
hausted, the files are placed into a root directory called sav.

DXI\/I 150 Documentation

DXM Wireless Controller Sell Sheet, p/n 194063

DXM150-B1 Wireless Controller Datasheet, p/n 178136
DXM150-B2 Wireless Controller Datasheet, p/n 195952
DXM150-Bx Wireless Controller Instruction Manual, p/n 190038
DXM150-S1 Modbus Server Datasheet, p/n 160171

DXM150-S2 Modbus Server Datasheet, p/n 200634

DXM150-Sx Modbus Server Instruction Manual, p/n 195455

DXM ScriptBasic Instruction Manual, p/n 191745

DXM Controller API Protocol, p/n 186221

DXM Controller Configuration Quick Start, p/n 191247

DXM Configuration Software v4, p/n b_4496867

DXM Configuration Software v4 Instruction Manual, p/n 209933
DXM EDS Configuration file for Allen-Bradley PLCs, p/n b_4205242
EIP Configuration File for DXM 1xx-BxR1 and R3 models, p/n 194730
Activating a Cellular Modem, p/n b_4419353

Additional technical notes and videos

For more information about the DXM150 family of products, including technical notes, configuration examples, and ScriptBa-
sic programs, please visit www.bannerengineering.com/wireless.

DX

M1500 Documentation

DXM Wireless Controller Sell Sheet, p/n 194063

DXM1500-B1 Wireless Controller Datasheet, p/n 210854

DXM1500-B2 Wireless Controller Datasheet, p/n 210855

DXM150-Bx and 1500-Bx Wireless Controller Instruction Manual, p/n 190038
DXM ScriptBasic Instruction Manual, p/n 191745

DXM Controller Configuration Quick Start, p/n 191247

DXM Configuration Software (p/n b_4447978)

DXM Configuration Software Instruction Manual, p/n 158447

DXM EDS Configuration file for Allen-Bradley PLCs

EIP Configuration File for DXM 1xx-BxR1 and R3 models (p/n 194730)
Activating a Cellular Modem (p/n b_4419353)

Video tutorials: Search "DXM Tutorial" at youtube.com/bannerengineering.
Additional technical notes

For more information about the DXM1500 family of products, including technical notes, configuration examples, and Script-

Basic p

rograms, please visit www.bannerengineering.com.

DXM Support Policy

The DXM Wireless Controllers are industrial wireless controllers that facilitate Industrial Internet of Things (lloT) applications.
As a communications gateway, it interfaces local serial ports, local I/0 ports, and local ISM radio devices to the Internet using
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either a cellular connection or a wired Ethernet network connection. In a continuing effort to provide the best operation for
the DXM, stay connected with Banner Engineering Corp to hear about the latest updates through the Banner website. Create
a login today to stay informed of all Banner product releases.

Firmware Updates

The DXM has been designed to be a robust and secure |IOT device. To provide the most reliable and secure device possible,
periodic firmware updates are released to enhance and expand the capabilities of the DXM. Firmware updates and descrip-
tion details are found on the Banner website. Customers with critical update requirements will get access to pre-released
firmware from the factory.

Website Information
The Banner website is the main method of disseminating DXM information to customers. The data found on the website in-
clude:

¢ DXM instruction manuals

» Configuration manuals

* Firmware downloads

* Firmware release notes

» Errata data, any known issues with a release of firmware

* Possible work-around solutions for known issues

* DXM Solutions Guides

Feature Requests

Our customer is our most valuable resource to improve our DXM. If you have suggestions for improvements to the DXM or
configuration tools, please contact Banner Engineering Corp.

Potential DXM Issues

Potential issues with the DXM are collected from Banner's support engineers to provide solutions. Users can get help from
the website documentation or by calling Banner Engineering for support help. Solutions are as simple as configuration adjust-
ments, work-around configuration solutions, or potential new firmware updates.

DXM Security

The DXM was designed to collect local wireless sensor data, local sensor data, provide simple control, and send the data to
the cloud.

The DXM does not run a Linux or Windows based operating system but an embedded real-time operating system (RTOS)
environment. As a proprietary operating system, the security aspects are easier to manage and minimize.

Security updates are released through the Banner Engineering Corp website (www.bannerengineering.com) and New Prod-
uct Release Announcements (NPRA).

FCC and ISED Certification, 900 MHz, 1 Watt Radios

This equipment contains transmitter module RM1809 or SX7023EXT.

Radio Module RM1809 Radio Module SX7023EXT
FCC ID: UE3RM1809 FCC ID: UE3SX7023EXT
IC: 7044A-RM1809 IC: 7044A-SX7023EXT
HVIN: RM1809 HVIN: 223150

FCC Notices

IMPORTANT: The transmitter modules RM1809 and SX7023EXT have been certified by the FCC / ISED for use with other
products without any further certification (as per FCC section 2.1091). Changes or modifications not expressly approved by
the manufacturer could void the user’s authority to operate the equipment.
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IMPORTANT: The transmitter modules RM1809 and SX7023EXT have been certified for fixed base station and mobile appli-
cations. If modules will be used for portable applications, the device must undergo SAR testing.

IMPORTANT: If integrated into another product, the FCC ID label must be visible through a window on the final device or it
must be visible when an access panel, door, or cover is easily removed. If not, a second label must be placed on the outside
of the final device that contains the following text:

Transmitter Module [RM1809 or SX7023EXT]

Contains FCC ID: [UE3RM1809 or UE3SX7023EXT]

Contains IC: [7044A-RM1809 or 7044A-SX7023EXT]

HVIN: [RM1809 or 223150]

This device complies with Part 15 of the FCC Rules. This equipment generates, uses, and can radiate radio frequency ener-

gy and, if not installed and used in accordance with the instruction manual, may cause harmful interference to radio commu-

nications. Operation is subject to the following two conditions: 1) This device may not cause harmful interference; and 2) This
device must accept any interference received, including interference that may cause undesired operation.

Antenna WARNING: This device has been tested with Reverse Polarity SMA connectors with the antennas listed in "Certified
Antennas for 900 MHz 1 Watt" on page 102. When integrated into OEM products, fixed antennas require installation prevent-
ing end-users from replacing them with non-approved antennas. Antennas not listed in the tables must be tested to comply
with FCC Section 15.203 (unique antenna connectors), FCC Section 15.247 (emissions), and ISED RSS-Gen Section 6.8.

FCC and ISED Approved Antennas
WARNING: Antenna(s) used for this transmitter must be installed to provide a separation distance of at least 20 cm from all
persons.

AVERTISSEMENT : Les antennes utilisées pour cet émetteur doivent étre installées de maniéere a assurer une distance de
séparation d'au moins 20 cm de toutes les personnes.

NOTICE: This equipment is approved only for mobile and base station transmitting devices. The antenna(s) used for this
transmitter must not transmit simultaneously with any other antenna or transmitter, except in accordance with FCC multi-
transmitter product procedures.

The radio transmitter modules RM1809 and SX7023EXT have been approved by FCC and ISED Canada to operate with the
antenna types listed below, with the maximum permissible gain indicated. Antenna types not included in this list that have a
gain greater than the maximum gain indicated for any type listed are strictly prohibited for use with this device.

Certified Antennas for 900 MHz 1 Watt

Model Number Antenna Type 900 MquIT:dio LS Maximum Gain Impedance M;T;;g%r:nii?::fgsga-

- Integral Antenna RM1809 Unity gain 0

BWA-901-x Omni, 1/4 wave dipole RM1809 <2 dBi 50 Q 0

BWA-902-C Omni, 1/2 wave dipole, Swivel Z)l\(/lY:L(?ZO??E‘;(rT <2 dBi 50 Q 0

BWA-906-A Omni Wideband, Fiberglass RM1809 <8.2 dBi 50 Q 22dB

Radome

BWA-905-B Omni Base Whip RM1809 <7.2 dBi 50 Q 1.2dB

BWA-9Y10-A Yagi RM1809 <10 dBi 50 Q 4dB

BWA-905-C Coaxial sleeve SX7023EXT <5 dBi 50 Q 0

BWA-906-AS Omni SX7023EXT <6 dBi 50 Q 0
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FCC and ISED Certification, 2.4GHz

This equipment contains transmitter module DX80-2400 or SX243.

Radio Module DX80-2400 Radio Module SX243
FCC ID: UE300DX80-2400 FCC ID: UE3SX243
IC: 7044A-DX8024 IC: 7044A-SX243
HVIN: DX80G2 / DX80N2 HVIN: SX243

FCC Notices

IMPORTANT: The transmitter modules DX80-2400 and SX243 have been certified by the FCC / ISED for use with other prod-
ucts without any further certification (as per FCC section 2.1091). Changes or modifications not expressly approved by the
manufacturer could void the user’s authority to operate the equipment.

IMPORTANT: The transmitter modules DX80-2400 and SX243 have been certified for fixed base station and mobile applica-
tions. If modules will be used for portable applications, the device must undergo SAR testing.

IMPORTANT: If integrated into another product, the FCC ID/IC label must be visible through a window on the final device or it
must be visible when an access panel, door, or cover is easily removed. If not, a second label must be placed on the outside
of the final device that contains the following text:

Transmitter Module [DX80-2400 or SX243]

Contains FCC ID: [UE300DX80-2400 or UE3SX243]

Contains IC: [7044A-DX8024 or 7044A-SX243]

HVIN: [DX80G2, DX80N2 or SX243]

This device complies with Part 15 of the FCC Rules. This equipment generates, uses, and can radiate radio frequency ener-

gy and, if not installed and used in accordance with the instruction manual, may cause harmful interference to radio commu-

nications. Operation is subject to the following two conditions: 1) This device may not cause harmful interference; and 2) This
device must accept any interference received, including interference that may cause undesired operation.

Antenna Warning: This device has been tested with Reverse Polarity SMA connectors with the antennas listed in "Certified
Antennas for 2.4 GHz" on page 103. When integrated into OEM products, fixed antennas require installation preventing end-
users from replacing them with non-approved antennas. Antennas not listed in the tables must be tested to comply with FCC
Section 15.203 (unique antenna connectors), FCC Section 15.247 (emissions), and ISED RSS-Gen Section 6.8.

FCC and ISED Approved Antennas
WARNING: Antenna(s) used for this transmitter must be installed to provide a separation distance of at least 20 cm from all
persons.

AVERTISSEMENT : Les antennes utilisées pour cet émetteur doivent étre installées de maniére a assurer une distance de
séparation d'au moins 20 cm de toutes les personnes.

NOTICE: This equipment is approved only for mobile and base station transmitting devices. The antenna(s) used for this
transmitter must not transmit simultaneously with any other antenna or transmitter, except in accordance with FCC multi-
transmitter product procedures.

The radio transmitter modules DX80-2400 and SX243 have been approved by FCC and ISED Canada to operate with the
antenna types listed below, with the maximum permissible gain indicated. Antenna types not included in this list that have a
gain greater than the maximum gain indicated for any type listed are strictly prohibited for use with this device.

Certified Antennas for 2.4 GHz

Model Antenna Type 2.4 GHz Radio Module Maximum Gain Impedance

Integral antenna DX80-2400 or SX243 Unity gain
Continued on page 104
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Continued from page 103

Model Antenna Type 2.4 GHz Radio Module Maximum Gain Impedance
BWA-202-C Omni, 1/2 wave dipole, Swivel DX80-2400 or SX243 <2 dBi 50 Q
BWA-202-D Omni, Dome, Box Mount DX80-2400 or SX243 <2dBi 50 Q
BWA-202-E Omni, 1/4 wave dipole, Swivel DX80-2400 or SX243 <2dBi 50 Q
BWA-205-C Omni, Collinear, Swivel DX80-2400 <5dBi 50 Q
BWA-205-MA Omni, full-wave dipole, NMO DX80-2400 <4.5dBi 50 Q
BWA-206-A Omni, Dome, Box Mount DX80-2400 <6 dBi 50 Q
BWA-207-C Omni, Coaxial Sleeve, Swivel DX80-2400 <7dBi 50 Q

Notas Adicionales

Informacion México: La operacion de este equipo esta sujeta a las siguientes dos condiciones: 1) es posible que este equipo
o dispositivo no cause interferencia perjudicial y 2) este equipo debe aceptar cualquier interferencia, incluyendo la que pueda
causar su operacion no deseada.

Banner es una marca registrada de Banner Engineering Corp. y podran ser utilizadas de manera indistinta para referirse al
fabricante. "Este equipo ha sido disefiado para operar con las antenas tipo Omnidireccional para una ganancia maxima de
antena de 6 dBd y Yagi para una ganancia maxima de antena 10 dBd que en seguida se enlistan. También se incluyen aque-
llas con aprobacién ATEX tipo Omnidireccional siempre que no excedan una ganancia maxima de antena de 6dBd. El uso
con este equipo de antenas no incluidas en esta lista 0 que tengan una ganancia mayor que 6 dBd en tipo omnidireccional y
10 dBd en tipo Yagi, quedan prohibidas. La impedancia requerida de la antena es de 50 ohms."

Approved antennas
Antenas SMA Modelo Antenas Tipo-N Modelo
é:ctfr;fpgr'\r/l& '\Q/I(;iij MHz, 2 dBd, junta de cau- BWA-902-C G?ﬁ;ig;ggﬁ?ﬁﬂiﬂ\ggz 6 dBd, fibra de BWA-906-A
Antena, Omni 902-928 MHz, 5 dBd, junta de cau- gy g05.¢ Antena, Yagi, 900 MHz, 10 dBd, N Hembra BWA-9Y10-A

cho, RP-SMA Macho

Mexican Importer

Banner Engineering de México, S. de R.L. de C.V.
David Alfaro Siqueiros 103 Piso 2 Valle oriente
San Pedro Garza Garcia Nuevo Leon, C. P. 66269

81 8363.2714

ANATEL

Este equipamento ndo tem direito a protecdo contra interferéncia prejudicial e ndo pode causar interferéncia em sistemas
devidamente autorizados. Para maiores informagdes, consulte o site da ANATEL www.gov.br/anatel/pt-br/

9. ANATEL

Agéncia Nacional de Telecomunicagoes

Contact Us

Banner Engineering Corp. headquarters is located at: 9714 Tenth Avenue North | Minneapolis, MN 55441, USA | Phone: + 1
888 373 6767

For worldwide locations and local representatives, visit www.bannerengineering.com.

© Banner Engineering Corp. June 05, 2023
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Warnings
WARNING:
» Do not use this device for personnel protection
» Using this device for personnel protection could result in serious injury or death.
A » This device does not include the self-checking redundant circuitry necessary to allow its use in

personnel safety applications. A device failure or malfunction can cause either an energized (on)
or de-energized (off) output condition.

IMPORTANT: Please download the complete DXM Controller technical documentation, available in multi-
ple languages, from www.bannerengineering.com for details on the proper use, applications, Warnings,
and installation instructions of this device.

IMPORTANT: Por favor descargue desde www.bannerengineering.com toda la documentacion técnica de
los DXM Controller, disponibles en multiples idiomas, para detalles del uso adecuado, aplicaciones, ad-
vertencias, y las instrucciones de instalacién de estos dispositivos.

IMPORTANT: Veuillez télécharger la documentation technique compléte des DXM Controller sur notre site
www.bannerengineering.com pour les détails sur leur utilisation correcte, les applications, les notes de
sécurité et les instructions de montage.

Install and properly ground a qualified surge suppressor when installing a remote antenna system. Remote antenna configu-
rations installed without surge suppressors invalidate the manufacturer's warranty. Keep the ground wire as short as possible
and make all ground connections to a single-point ground system to ensure no ground loops are created. No surge suppres-
sor can absorb all lightning strikes; do not touch the Sure Cross® device or any equipment connected to the Sure Cross de-

vice during a thunderstorm.

Exporting Sure Cross® Radios. It is our intent to fully comply with all national and regional regulations regarding radio fre-
quency emissions. Customers who want to re-export this product to a country other than that to which it was sold must en-
sure the device is approved in the destination country. The Sure Cross wireless products were certified for use in these coun-
tries using the antenna that ships with the product. When using other antennas, verify you are not exceeding the transmit
power levels allowed by local governing agencies. This device has been designed to operate with the antennas listed on
Banner Engineering’s website and having a maximum gain of 9 dBm. Antennas not included in this list or having a gain
greater than 9 dBm are strictly prohibited for use with this device. The required antenna impedance is 50 ohms. To reduce
potential radio interference to other users, the antenna type and its gain should be so chosen such that the equivalent
isotropically radiated power (EIRP) is not more than that permitted for successful communication. Consult with Banner Engi-
neering Corp. if the destination country is not on this list.

IMPORTANT:
* Never operate a 1 Watt radio without connecting an antenna
» Operating 1 Watt radios without an antenna connected will damage the radio circuitry.
» To avoid damaging the radio circuitry, never apply power to a Sure Cross® Performance or Sure
Cross MultiHop (1 Watt) radio without an antenna connected.

IMPORTANT:
« Electrostatic discharge (ESD) sensitive device
» ESD can damage the device. Damage from inappropriate handling is not covered by warranty.
» Use proper handling procedures to prevent ESD damage. Proper handling procedures include
leaving devices in their anti-static packaging until ready for use; wearing anti-static wrist straps;
and assembling units on a grounded, static-dissipative surface.

June 05, 2023 © Banner Engineering Corp.
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Banner Engineering Corp Limited Warranty

Banner Engineering Corp. warrants its products to be free from defects in material and workmanship for one year following
the date of shipment. Banner Engineering Corp. will repair or replace, free of charge, any product of its manufacture which, at
the time it is returned to the factory, is found to have been defective during the warranty period. This warranty does not cover
damage or liability for misuse, abuse, or the improper application or installation of the Banner product.

THIS LIMITED WARRANTY IS EXCLUSIVE AND IN LIEU OF ALL OTHER WARRANTIES WHETHER EXPRESS OR IM-
PLIED (INCLUDING, WITHOUT LIMITATION, ANY WARRANTY OF MERCHANTABILITY OR FITNESS FOR A PARTICU-
LAR PURPOSE), AND WHETHER ARISING UNDER COURSE OF PERFORMANCE, COURSE OF DEALING OR TRADE
USAGE.

This Warranty is exclusive and limited to repair or, at the discretion of Banner Engineering Corp., replacement. IN NO
EVENT SHALL BANNER ENGINEERING CORP. BE LIABLE TO BUYER OR ANY OTHER PERSON OR ENTITY FOR ANY
EXTRA COSTS, EXPENSES, LOSSES, LOSS OF PROFITS, OR ANY INCIDENTAL, CONSEQUENTIAL OR SPECIAL
DAMAGES RESULTING FROM ANY PRODUCT DEFECT OR FROM THE USE OR INABILITY TO USE THE PRODUCT,
WHETHER ARISING IN CONTRACT OR WARRANTY, STATUTE, TORT, STRICT LIABILITY, NEGLIGENCE, OR OTHER-
WISE.

Banner Engineering Corp. reserves the right to change, modify or improve the design of the product without assuming any
obligations or liabilities relating to any product previously manufactured by Banner Engineering Corp. Any misuse, abuse, or
improper application or installation of this product or use of the product for personal protection applications when the product
is identified as not intended for such purposes will void the product warranty. Any modifications to this product without prior
express approval by Banner Engineering Corp will void the product warranties. All specifications published in this document
are subject to change; Banner reserves the right to modify product specifications or update documentation at any time. Spec-
ifications and product information in English supersede that which is provided in any other language. For the most recent ver-
sion of any documentation, refer to: www.bannerengineering.com.

For patent information, see www.bannerengineering.com/patents.

Document title: DXM150-Bx and DXM1500-Bx Wireless Controller Instruction Manual
Part number: 190038

Revision: L
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